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I Revision History

Version Revision Date

Copyright 2005, Roche Diagnostics GmbH. All rights reserved.

Il. Contact Addresses

Roche Instrument Center AG
Forrenstrasse

CH-6343 Rotkreuz
Switzerland

Distribution Roche Diagnostics GmbH
Sandhofer Stral3e 116
D-68305 Mannheim
Germany

Distribution in USA Roche Diagnostics
Corporation
9115 Hague Road
PO Box 50457
Indianapolis, IN 46250
USA

lll. Declaration of Conformity

The LightCycIer® 2.0 Instrument meets the requirements of the European Directive for
In vitro diagnostic medical devices 98/79/EC.
Compliance is demonstrated by the following mark:

Ce
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IV. Warranty

Information on warranty conditions are specified in the sales contract. Contact your
Roche representative for further information.

Any unauthorized modification of the instrument entails the invalidity of the guarantee
and service contract.

V. Trademarks

LIGHTCYCLER and MAGNA PURE are trademarks of Roche.

Vl. Intended Use

The LightCycler® 2.0 Instrument is intended for performing rapid PCR (Polymerase
Chain Reaction) with real-time detection and/or quantification of a target NA (nucleic
acid), as well as post-PCR analysis of the amplified NA by melting curve analysis.

Beside its universal application in fields like life science research, food analysis and foren-
sics, the instrument can - in countries where approved for this purpose - also be used in
specific diagnostic applications in combinations with LightCycler® reagent kits manufac-
tured by Roche and labeled for diagnostic purposes (according to the workflow described
in the package insert of the respective LightCycler® reagent kit).

Please note: The Roche LightCycler® reagent kits for in vitro diagnostic applications
requiring this instrument are not available in all countries. Any diagnostic use of the
LightCycler® 2.0 Instrument in combination with LightCycler® reagents (other than
those labeled for diagnostic purposes, manufactured by Roche and recommending the
LightCycler® 2.0 Instrument in their instructions of use) is in the sole responsibility of
the user and has to be validated by the user, taking into account all relevant national
legislation.

Customers using Roche in vitro diagnostic LightCycler® kits have to use “Manual A,
marked for in vitro diagnostic use” (not available in all countries; id. no. 04 624 491 001)
while “Manual B, marked for general laboratory use” (id. no. 04 624 505 001) has to be
used for all other laboratory applications.

The LightCycler® 2.0 Instrument must be used exclusively by laboratory professionals
trained in laboratory techniques and having studied the instructions for use of this
instrument.
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VIl. License Statements for the
LightCycler® 2.0 Instrument

The LightCycler® 2.0 Instrument is designed for in vitro diagnostic ("IVD") applications.
LightCycler® reagent kits manufactured by Roche and labeled for In Vitro Diagnostic Use
will provide the user with a license to perform PCR-based IVD testing. For IVD testing
performed without an IVD kit from Roche, a separate diagnostic service license is avail-
able. For information on acquiring a diagnostic service license, please contact either the
PCR Licensing Manager, Roche Molecular Systems, Inc., 1145 Atlantic Avenue, Alameda,
California 94501 USA; Tel: 510-814-2984; Fax: 510-814-2977, or PCR Licensing Manager,
Roche Diagnostics GmbH, Sandhofer Strasse 116, D-68305 Mannheim, Germany; Tel:
+49 (621) 759 28 36; Fax: +49 (621) 759 27 05.

The LightCycler® 2.0 Instrument can also be used in life science research, food analysis,
forensics and other laboratory disciplines, where PCR applications and melting curve
analysis is required. A license to perform PCR for life science research is obtained as
described below. For information on licenses to perform PCR for food analysis, foren-
sics, etc., please contact either the PCR Licensing Managers listed above, or the Director
of Licensing at Applied Biosystems, as listed below.

The LightCycler® 2.0 Instrument is an Authorized Thermal Cycler. Its purchase price
includes the up-front fee component of a license under the non-U.S. counterparts of
United States Patents Nos. 4,683,195, 4,683,202 and 4,965,188 owned by F. Hoffmann-La
Roche Ltd, covering the Polymerase Chain Reaction ("PCR") process, to practice the PCR
process for internal research and development using this instrument. The running roy-
alty component of that license may be purchased from Applied Biosystems or obtained
by purchasing Authorized Reagents. This instrument is also an Authorized Thermal
Cycler for use with applications licenses available from Applied Biosystems. Its use with
Authorized Reagents also provides a limited PCR license in accordance with the label
rights accompanying such reagents. Purchase of this product does not itself convey to the
purchaser a complete license or right to perform the PCR process. Further information
on purchasing licenses to practice the PCR process may be obtained by contacting the
Director of Licensing at Applied Biosystems, 850 Lincoln Centre Drive, Foster City, Cali-
fornia 94404, USA.

No rights are conveyed expressly, by implication or estoppel to any patents on real-time
methods, including but not limited to 5' nuclease assays, or to any patent claiming a

reagent or kit.

Applied Biosystems does not guarantee the performance of this instrument.
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VIIl. Software License Agreement

Read this Software License Agreement ("Agreement") before removing the program CD
(hereinafter referred to as program media) or product documentation from its protective
cover. Removing the program media or product documentation from the protective
cover will constitute acceptance of the terms and conditions of this Agreement. By
accepting the terms and conditions of this Agreement, the end-user ("Licensee") assumes
all responsibility and liability for the selection of this software program, hereinafter
referred to as "Software", to achieve the intended results, and for its installation and sub-
sequent use. If Licensee is not willing to be bound by the terms and conditions of this
Agreement, the unopened package must be promptly returned to Roche Diagnostics
GmBH (“RDG”) with a copy of the receipt. The license fee will be refunded upon receipt
by RDG of the unopened package.

Program License Agreement

You assume all responsibility and liability for the selection of this software program, here-
inafter referred to as Product, to achieve your intended results, and for its installation and
subsequent use.

Grant of Software License

RDG grants to Licensee a non-exclusive, single-use license to use the Software upon the
terms and conditions contained in this Agreement. Licensee may:

1. Use the Software on a single workstation owned, leased or otherwise controlled by
Licensee.

2. Make one (1) copy of the Software solely for backup purposes in support of Licensee’s
use of the Software on a single workstation.

3. Transfer the Software product and assign the rights under this Agreement to another
party, provided that the other party agrees in writing to accept the terms and condi-
tions of this Agreement. If the Software is transferred, and the rights under this Agree-
ment are so assigned, Licensee must, at the same time, either transfer Licensee’s copy,
if any, of the Software to the same party, or destroy any such copy not transferred. In
addition, Licensee must ensure that the copyright notice is maintained on the Software
transferred and on any copy concurrently transferred.

Licensee may not:
1. Use or copy the Software, in whole or in part, except as expressly provided in this
Agreement.

2. Use the Software on more than one workstation at a time.

3. Copy, sell, or otherwise transfer the Software or assign its rights under this Agreement,
in whole or in part, to another party, except as specifically set forth in this Agreement.

4. Rent, distribute, license or sublicense the Software.
5. Create derivative works based on Software.
6. Modify, adapt, translate, reverse engineer, decompile or disassemble the Software.

RDG reserves all rights not expressly granted herein, including, but not limited to, the
rights to market the Software either directly or through affiliates, distributors and/or
third parties.

For further information, please contact:

Roche Diagnostics GmbH
Roche Applied Science
Sandhoferstrale 116
D-68305 Mannheim
Germany
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Terms

The Agreement is effective until terminated. Licensee may terminate this Agreement at
any time by destroying the Software together with any copy previously made in compli-
ance with the terms of this Agreement and documentation relating to the Software in any
form. The Agreement will terminate automatically and without notice from RDG, if Lic-
ensee fails to comply with any term or condition of this Agreement. Licensee agrees to
destroy the Software and the copy, if any, of the Software upon termination of this Agree-
ment by RDG.

Limited Warranty

The Product is provided as is without warranty of any kind, either expressed or implied,
including, but not limited to the implied warranties of merchantability and fitness for a
particular purpose. The entire risk as to the quality and performance of the Product is
with you as Licensee, should the Product prove to be defective. You assume the entire
costs of all necessary servicing, repair, or correction. However, Roche Diagnostics GmbH
warrants that the program media on which the software is furnished is free from defects
in materials and workmanship under normal use for a period of ninety (90) days from
the date of delivery as evidenced by a copy of your receipt. ROCHE DIAGNOSTICS
GMBH MAKES NO FURTHER WARRANTIES OR GUARANTEES NOR EXPLICIT
NOR IMPLIED.

Warranty Disclaimers

THE WARRANTY SET FORTH IN THE PREVIOUS PARAGRAPH, IS IN LIEU OF ALL
OTHER WARRANTIES, EXPRESS OR IMPLIED, ARISING BY LAW, FROM A COURSE
OF PERFORMANCE, A COURSE OF DEALING, TRADE USAGE, OR OTHERWISE.
RDG AND ANY ENTITY CONTROLLING, CONTROLLED BY OR UNDER COM-
MON CONTROL WITH RDG ("RDG AFFILIATE") SPECIFICALLY DISCLAIM,
WITHOUT LIMITATION, ALL WARRANTIES OF ANY KIND, WHETHER EXPRESS
OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-
INFRINGEMENT. RDG AND RDG AFFILIATES MAKE NO REPRESENTATION OR
WARRANTY AS TO THE SOFTWARE OR AS TO THE RESULTS TO BE ATTAINED BY
LICENSEE COMPANY OR ANY THIRD PARTY FROM THE SOFTWARE. LICENSEE
ACKNOWLEDGES THAT IT HAS NOT RELIED UPON ANY REPRESENTATIONS OR
WARRANTIES MADE BY RDG OR AN RDG AFFILIATE EXCEPT FOR THOSE
EXPRESSLY AND SPECIFICALLY SET FORTH IN THIS AGREEMENT.
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Limitations of Remedies
RDG'’s sole liability and your sole remedy shall be:

1. the replacement of the program media not meeting RDG’s limited warranty and
which is returned to RDG with a copy of your receipt;

2. if RDG is unable to deliver replacement program media which is free of defects in
workmanship, you may terminate this Agreement by returning the Product and a copy
of your receipt to RDG, and your money will be refunded.

IN NO EVENT WILL RDG OR ANY RDG AFFILIATE (OR THEIR RESPECTIVE
OFFICERS, EMPLOYEES, CONSULTANTS, ATTORNEYS OR AGENTS), BE LIABLE
FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, LOST PROFITS, LOST DATA OR INFORMA-
TION, LOSS OF USE OF THE SOFTWARE, BUSINESS INTERRUPTION, LOSS OF
BUSINESS REPUTATION OR GOODWILL, OR DOWNTIME COSTS) WHICH THE
LICENSEE OR OTHERS MAY INCUR OR EXPERIENCE, DIRECTLY OR INDIRECTLY
ARISING OUT OF OR RELATING TO THE SOFTWARE, THIS AGREEMENT, OR THE
TERMINATION OF THIS AGREEMENT, EVEN IF RDG OR AN RDG AFFILIATE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND NOTWITH-
STANDING ANY FAILURE OF ESSENTIAL PURPOSE. THE AGGREGATE LIABILITY,
ON A COMBINED BASIS, OF RDG AND RDG AFFILIATES (AND THEIR RESPEC-
TIVE OFFICERS, EMPLOYEES CONSULTANTS, ATTORNEYS, AND AGENTS) FOR
DAMAGES FOR ANY CAUSE WHATSOEVER DIRECTLY OR INDIRECTLY RELAT-
ING TO OR ARISING OUT OF THIS AGREEMENT OR THE SOFTWARE, AND
REGARDLESS OF THE FORM OF ACTION, SHALL BE LIMITED TO, AT RDG’s
OPTION, REPLACEMENT OF THE SOFTWARE OR REFUND OF THE FEES
RECEIVED BY RDG OR AN RDG AFFILIATE FROM LICENSEE WITH RESPECT TO
THE SOFTWARE.

General Information

You may not sublicense, assign or transfer the license or the Product, in whole or in part,
except as expressly provided in this Agreement. Any attempt otherwise to sublicense,
assign or transfer any of the rights, duties or obligations hereunder is void.

» This Agreement will be governed by the laws of Germany.

» Should any part of this agreement be declared void or unenforceable by a court of
competent jurisdiction, the remaining terms shall remain in full force and effect.

» Failure of RDG to enforce any of its rights in this Agreement shall not be considered a
waiver of its rights, including but not limited to its rights to respond to subsequent
breaches.

By opening and using this software you acknowledge that you have read this Agreement,
understand it, and agree to be bound by its terms and conditions. You further agree that
this Agreement is the complete and exclusive statement of the Agreement between you
and RDG and supersedes any proposal or prior Agreement, oral or written, any other
communications between you and RDG relating to the subject matter of this Agreement.
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IX. Preamble

Before setting-up operation of the LightCycler® 2.0 Instrument it is important to read
this Operator's Manual thoroughly and completely. Non-observance of the instructions
contained in this manual may entail safety hazards.

X. Usage of the LightCycIer® 2.0 Instrument
Operator's Manual

This Operator's Manual assists with operating the LightCycler® 2.0 Instrument. It con-
tains the following chapters:

Chapter A Overview contains a short introduction in the operating mode of the
LightCycler® 2.0 Instrument and describes the system's specifications.

Chapter B System Description contains instructions on the installation of the
LightCycler® 2.0 Instrument and a description of the system's components and
consumables.

Chapter C Operation describes the operating procedures for the LightCycler® 2.0
Instrument.

Chapter D Software contains instructions for programming LightCycler® runs and data
analysis.

Chapter E Maintenance describes the maintenance procedures that are required for the
LightCycler® 2.0 Instrument.

Chapter F Troubleshooting lists all LightCycler® system messages, explains their mean-
ing and indicates appropriate measures.
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Xl. Conventions Used in this Manual

Text Conventions

To impart information consistent and memorable, the following text conventions are
used in this Operator's Manual:

Text Convention Usage

Symbols
In this Operator's Manual symbols are used as an optical signal to point out important
things.

Symbol | Heading | Description

WARNING This symbol is used to indicate that non-
compliance with instructions or procedures
may lead to physical injury or even death or
could cause damage to the instrument. Consult
the Operator's Manual.

HOT SURFACE This symbol is used to label potentially hot
i E instrument surfaces.

BIOHAZARD This symbol is used to indicate that certain
precautions must be taken when working with
potentially infectious material.

IMPORTANT NOTE Information critical to the success of the
procedure or use of the product.

’\ INFORMATION NOTE Additional information about the current topic
(.u.- ) or procedure.

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use
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The following symbols appear on the instrument

Manufacturer of device.
On the instrument type plate.

Warning
On the instrument type plate (see X// Handling Precautions).

Hot surface
On the margin of the thermal chamber (see X// Handling Precautions).

The CE mark on the instrument type plate expresses conformity with
essential requirements of the directive relevant for this instrument (see ///).

P> P> E

cUL mark
On the instrument type plate
(see Chapter Overview, 2.2 General specifications)

n‘
c
wn
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XIl. Warnings and Precautions

The LightCycler® 2.0 Instrument must only be used by trained and skillful personnel.

It is essential that the following safety precautions required for installation and operation
of the LightCycler® 2.0 Instrument are carefully read and observed. Please assure that
these safety precautions are accessible for every employee working with the LightCycler®
2.0 Instrument.

Handling Precautions

The LightCycIer® 2.0 Instrument is an electromechanical instrument. There is

a potential danger for the user of an electric shock or physical injury if the

instrument is not used according to the instructions given in this manual.

» Follow all safety instructions printed on, or attached to the analytical
instrument.

» Observe all general safety precautions which apply to electrical instruments.

» Never touch switches or power cord with wet hands.

» Do not open the housing of the LightCycIer® 2.0 Instrument.

» Never clean the instrument without turning the instrument power switch off
and disconnecting the power cord.

Only authorized service personnel should perform service or repairs
required for this unit.

» Do not open the thermal chamber during operation.

» When programming a run, always include a cooling step (e.g., 40°C for
30 sec) as last cycle program to make sure that the thermal chamber has
cooled down upon opening the lid.

» Although working with highly purified nucleic acids, please regard for your
own safety all biological material as potentially infectious. Handling and
disposal of such material should be performed according to local safety
guidelines.

» Always wear safety goggles and gloves when dealing with toxic, caustic or
infectious materials.

» Please refer to chapter Maintenance to find instructions for cleaning the
LightCycIer® 2.0 Instrument.

» The chamber lid and the sample carousel are hot while the instrument is
operating.

The corresponding symbol is attached to the upper margin of the
thermal chamber.

> BB P
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General Precautions

The LightCycIer® 2.0 Instrument must not be connected to a network,
although network hardware is present. The connection to networks contains
an inherent risk to be infected through viruses and worms as well as targeted
attacks through malicious attackers through the network. Roche is not
responsible for any damages caused by connection of the LightCycIer® 2.0
Instrument to a network by the customer.

Additional software must not be installed on the LightCycIer® 2.0 workstation.
Installation of additional software contains the risk to interfere with
LightCycIer® Software 4.05 and may affect result security.

One PC must not be used with 2 LightCycIer® Instruments simultaneously.

> > B

Do not manipulate the instrument.

Electrical Safety

>

The LightCycIer® 2.0 Instrument is designed in accordance with Protection
Class | (IEC). The chassis/housing of the instrument is connected to Protec-
tion Earth (PE) by means of a cord. For protection against electrical shock
hazards, the instrument must be directly connected to an approved power
source such as a 3-wire grounded receptacle for the 115V or 230V line.
Where an ungrounded receptacle is encountered, a qualified electrician must
replace it with a properly (PE) grounded receptacle in accordance with the
local electrical code. An extension must not be used. Any break in the elec-
trical ground path, whether inside or outside the instrument, may create a
hazardous condition. Under no circumstances should the user attempt to
modify or deliberately defeat the safety features of this instrument. If the
power cord becomes cracked, frayed, broken, or otherwise damaged, it must
be replaced immediately with the equivalent part from Roche Diagnostics.




LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Overview

Chapter A * Overview

contains a short introduction in the
operating mode of the LightCycIer® 2.0
Instrument and describes the system’s
. specifications.
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Specifications of the LightCycler® 2.0 Instrument

Overview

Overview

1. Introduction

The LightCycler® 2.0 Instrument enables you to perform rapid PCR. Results can be
quantified and analyzed simultaneously by monitoring fluorescence during amplifica-
tion. Melting curve analysis allows mutation detection and product characterization. For

more details on the Methodology and Data Analysis refer to Chapter Software.

2. Specifications of the LightCycIer® 2.0

Instrument

A summary of the LightCycler® 2.0 Instrument specifications is given below.

21 Technical Specifications

Dimensions

Power supply

Power consumption
Noise level

Heat emission

Protection Class

2.2 General Specifications

Temperatures allowed during
transportation/storage/packaging

Temperatures allowed during
operation

Relative Humidity

Altitude/Pressure

28 x 38.5 x 50.5 cm +/- 0.5 cm tolerance
WxHxD)

Approx. 22 kg

115/230 V; 8A; 50-60 Hz
Max. 800 VA

<65 dBA

2900 kJ/h (max.)
2100 kJ/h (average value during
operation)

-25°C to +60°C;
relative humidity: 10% to 95%
(no condensation)

+18°C to +30°C;
relative humidity: 20% to 80%
(no condensation)

10% to 95%, no condensation

0 to 2000 m above sea level
850 - 1050 hP

Complies with safety standards IEC 61010-1
and IEC 61010-2-101, level of pollution 2,
Overvoltage category I, CAN/CSA-C22.2
No. 1010.1-92 as well as UL 61010A-1.

The safety mark has been issued by
Underwriters Laboratories, Inc. (UL) for
Canada and the US.




Specifications of the LightCycler® 2.0 Instrument

23 Sample Capacity

Number of samples per run 32

Sample volume 20 pl, 100 pl

2.4 Shipping

The LightCycler® 2.0 Instrument is transported in a styrofoam container packed in a
cardboard box. The container should be carefully inspected for damage. Report any
damage to your local Roche Diagnostics office before accepting the unit.

For transportation or relocation of the LightCycler® 2.0 Instrument, only the
original packaging shall be used.

2.5 Data Station

A fully equipped data workstation (desktop or notebook version) is delivered by Roche
with the LightCycler® 2.0 Instrument.

The data station complies with the requirements of the following European Directives:

» Low Voltage Equipment 73/23/EEC
» Electromagnetic Compatibility 89/336/EEC

In addition (for customers in the USA) the data station is certified by Underwriters
Laboratories Inc., USA with respect to electrical and mechanical safety. Consequently the
data station is marked with a UL and a CE mark.

() By using special software it is possible to access the LightCycler® PC by remote
¥ control. Contact your Roche representative for more information.
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3.4 Acquisition Time




Temperature Kinetics for PCR

=)

.  Temperature Kinetics for PCR

.1 General

4

2

Excluding error of measurement equipment

4.2 Capillary Heating Rates

o~

.3 Capillary Cooling Rates

i

4 Temperature Tolerances, Short Term

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




contains instructions on the installation
of the LightCycler® 2.0 Instrument and
a description of the system‘s components
and consumables.




Overview

Unpacking and Installation

1.1 Components of the nghtCycIer 2.0 Instrument 29

2, Installation 32
2.1 Installation Requirements 32
2.2 Space and Power Requirements 32
23 Environmental Requirements 33
2.4 Storage Conditions 33
25 Installation of the LightCycIer® 2.0 Instrument 33

3. Start up the Data Station 35
3.1 Installation of the Computer 35
3.2 Using the CD-RW Drive 35

4, System Description 36
4.1 Description of the LightCycIer® 2.0 Instrument 36
4.2 Thermal Chamber 37
43 Photometer 38
4.3.1 Optics 38

432 Detection Channels 39

5. Mobile Components and Consumables 40
5.1 LightCycIer® 2.0 Sample Carousel 40
5.2 Ligh'[CycIer® Capillaries 41
5.3 LightCycIer® 2.0 Capillary Releaser 42
5.4 LightCycIer® Capping Tool 42
55 LightCycler® Sample Carousel O-Ring 43
5.6 How to Use the LightCycIer® Capillary Releaser 44
5.7 LC Carousel Centrifuge 2.0 46

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Unpacking and Installation

System Description

Components of the Light(;)/c/er® 2.0 Instrument

System Description

1. Unpacking and Installation

The table below lists all components delivered with the LightCycler” 2.0 Instrument. Use
this list to check the completeness of all components. Check for damages in transit after
opening. Report any visual damage to your local Roche Diagnostics representative.

@ Do not lift the instrument by the lid handle when unpacking, instead place your
hands under the base of the instrument.

1.1 Components of the LightCycler® 2.0 Instrument

Components Description

System component 1 | 2 LightCycIer® 2.0 Instrument (Cat.No.: 03 531 414 201)

» LightCycler® 2.0 Sample Carousel (20 pl)
(Cat.No.: 03 603 962 001) mounted in
LightCycIer® 2.0 Instrument




Unpacking and Installation

Components of the LightCycler® 2.0 Instrument

Components

System component 2

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0

Description

> 1 box LightCycIer® Capillaries (20 pl)
(1 box out of Cat.No.: 11 909 339 001)

| 2 LightCycIer® 2.0 Sample Carousel (100 pl)
(Cat.No.: 03 603 954 001)

> 1 box LightCycIer® Capillaries (100 pb
(1 box out of Cat.No.: 03 337 090 001)

» LightCycler® Centrifuge Adapters
(Cat.No.: 11909 312 001)

» 2x LightCycler® Capping Tool
(Cat.No.: 03 357 317 001)

» LightCycler® 2.0 Capillary Releaser
(Cat.No.: 03 603 920 001)
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Unpacking and Installation

System Description

Components of the Light(;)/c/er® 2.0 Instrument

Components Description

System component 2 > LightCycIer® 2.0 Operator's Manual
> LightCycIer® Software 4.05 (Cat.No.: 03 604 012 001)

> Serial Cable to connect LightCycIer® 2.0 Instrument
to the Computer

> Power cord (one with German plug and one with US
plug)

2

A fully equipped data workstation (desktop or notebook version) is delivered with
the LightCycler” 2.0 Instrument.

@ @ A printer and a barcode reader are provided locally upon request.

o

I
),




Installation

Installation Requirements

2. Installation

2.1 Installation Requirements

» Do not place the LightCycler” 2.0 Instrument next to instruments that cause vibration,
electromagnetic interference, or have high inductance (e.g., centrifuges or mixers).

b Peripheral instruments connected to the LightCycler® 2.0 Instrument must meet the
IEC 950 (UL 1950) standard.

» All plugs used with the LightCycler” 2.0 Instrument (PC, printer, monitor) should
have the same phasing in order to prevent switch-on peaks and electronic noise
generated by other instruments, or by the power supply itself.

b Use only the power lines and RS232 connector supplied.
> Do not place the instrument in direct sunlight or close to radiators or heating devices.

> Do not use the instrument in an atmosphere where an explosion could occur.

22 Space and Power Requirements

Place the LightCycler” 2.0 Instrument on a site that can support the following instrument
requirements:

Dimensions The LightCycler® 2.0 Instrument is 28 cm wide, 50.5 cm long and
38.5 cm high.

Weight The LightCycler® 2.0 Instrument has a weight of approximately
22 kg.

Voltage The LightCycler® 2.0 Instrument operates at

requirements 115V (60 H2)
230V (50 Hz)

If the voltage in your country does not meet the voltage
requirements, please contact your local Roche
representative.

The LightCycler® 2.0 Instrument adjusts automatically to
the available voltage when the instrument is plugged in.
The user does not have to set the instrument to the correct

voltage manually.
ﬁ Do not open the LightCycIer® 2.0 Instrument housing.

Power consumption L LightCycIer® 2.0 Instrument uses 800 VA maximum. PC and
printer consume approximately an additional 500 VA.
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System Description

Environmental Requirements

23 Environmental Requirements

The LightCycler” 2.0 Instrument has been designed to safely operate within specifications
according to CE and UL certified technical standards at ambient room temperatures
between 18°C and 30°C, relative humidity between 20% and 80% (no condensation) and
at an altitude less than 2000 meters above sea level (850-1050 hP). Atmospheric condi-
tions should conform to pollution degree II.

Environmental conditions that exceed these specifications may result in instrument fail-
ure or may cause incorrect test results.

2.4 Storage Conditions

Keep the device in a dry place. Moisture could cause malfunction.

25 Installation of the LightCycIer® 2.0 Instrument

The LightCycler® 2.0 Instrument should be unpacked and installed by your Roche Diag-
nostics representative. Should this not be possible, follow these steps to install the instru-
ment successfully:

» Unpack the instrument by following the instructions outlined in Unpacking and
Installation.

b Position the instrument on the workbench in the upright position with the
instrument's backside towards the wall. Allow 10 cm space to the left, right and behind
the instrument to ensure sufficient cooling of the electronic components. Ensure that
there is absolutely nothing placed below the base of the LightCycler® 2.0 Instrument
(e.g., paper, plastic film etc.).

Failure to provide this ventilation space may cause damage to the instrument due
to overheating.

> Establish the following electrical connections:
a) Connect the LightCycler® 2.0 Instrument to the PC using the RS232 cable (serial
interface) provided with the system.
b) It is recommended to connect the LightCycler® 2.0 Instrument, PC, monitor, and
printer to the same multiple-outlet distributor plug.

Serial Interface

Power Supply

ON/OFF switch
Safety Lock

Rear connections of the LightCycIer® 2.0 Instrument

ﬁ Ensure that PC, monitor, and printer have been set to the correct voltage.




Installation
Installation of the LightCyc/er® 2.0 Instrument

(\:/\ To prevent unwanted removal of the LightCycler” 2.0 Instrument, the instrument
. canbe fixed to an unremovable device like e.g., a lab bench. For this purpose, a key
o lock for commercially available safety locks is provided on the back of the

LightCycler® 2.0 Instrument (see picture). The safety lock is not provided with the
system.
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Starting up the data station

System Description

Installation of the Computer

3. Starting up the Data Station

3.1 Installation of the Computer

To install the data station, follow the instructions outlined below:
> Connect mouse, keyboard, and monitor to the computer.

> Connect the LightCycler® 2.0 Instrument to the computer with the RS$232 cable
(serial interface) provided with the system.

> Connect the computer, monitor, and LightCycler® 2.0 Instrument to the same
multiple-outlet distributor plug.

The computer is now ready for operation.

3.2 Using the CD-RW Drive

The data station is equipped with a CD-RW drive and a preinstalled software package
that allows easy read/write access to standard re-writable CDs. The software package used
is Roxio Easy CD Creator and Direct CD. The CD-RW drive is a combined CD-ROM/
CD-writer which allows you to easily transfer LightCycler” data to another PC. To do this
a special re-writable CD (CD-RW) is needed. This CD-RW has to be formatted first by
performing the following steps:

Insert the CD-RW disc.

Start the Direct CD software.

Follow the guidelines given by the software for formatting a CD-RW.

You may enter an identifier for the CD-RW.

Choose option for complete formatting.

Start the formatting process.

0000000

Once the formating process is finished, the CD-RW is ready for use in the
LightCycIer® Workstation's CD-RW drive.

For more details check the Help function implemented in the Direct CD software.

Once these Steps have been followed, the CD-RW is formatted in a way, that allows easy
copying of data, using standard drag and drop and cut and paste functions of Windows
Explorer.

Do not run the CD burning software in parallel to a LightCycler” run.

.
iy,




System Description

Description of the LightCyc/er® 2.0 Instrument

Air heating and
cooling for rapid

temperature ramping

4. System Description

4.1 Description of the LightCycIer® 2.0 Instrument

Rapid thermal cycling with the LightCycler® 2.0 Instrument is made possible by the
unique design of the instrument. Compared to conventional cyclers the LightCycler” 2.0
Instrument uses air for heating and cooling instead of thermal blocks for the high-speed
thermal cycling. Ambient air is drawn into the machine and heated up by a heating coil,
which is located in the upper part of the instrument. The lower unit contains the thermal
chamber, photometer and drive units.

A fan located within the thermal chamber ensures efficient air circulation and tempera-
ture homogeneity during cycling. Varying the voltage supplied to the heating coil regu-
lates the temperature in the thermal chamber. During the heating phase the fan in the
thermal chamber operates at low speeds to ensure homogenous distribution of the tem-
perature. During the cooling phase the fan operates at higher speeds so that the capillar-
ies and the heating coil can be cooled efficiently.

During measurements a stepper motor rotates the sample carousel within the thermal
chamber to position the capillary tip precisely at the focal point of the photometer optics.
The stepper motor of the sample carousel works with the horizontal photometer stepper
motor to achieve optimal positioning of the capillaries into the focus of the photometer.

Sealed 20ul or 100l
] capillary with superior
surface-to-volume ratio

Heating coil

Stepper motor to
position samples
over optics

Carousel with
capacity for
32 samples

) [0
)] 05
| O § k
Photohybrids
Thermal O O O /
chamber
) =0
Fan O O j
Fan motor Six-channel photometer
LED lightsource Stepper motor to
position photometer
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System Description
Thermal Chamber

4.2 Thermal Chamber

Temperatures within the thermal chamber are controlled by an integrated measuring sys-
tem equipped with a temperature sensor, which is installed near the sample capillaries in
the carousel. A blower supplies the thermal chamber with either ambient air or hot air,
which has been heated up by the heating coil beforehand. A high-velocity fan, located at
the base of the thermal chamber, evenly distributes the incoming air throughout the ther-
mal chamber. Surplus air is exhausted through an air vent.
(. The use of air as a heat-transfer medium contributes to the high-speed cycling
¥ capabilities of the LightCycler” 2.0 Instrument. Thus, heating and cooling in the
LightCycler” 2.0 Instrument occurs about ten times faster than in a normal
thermal cycler. A typical amplification cycle requires only 50 seconds with 20 pl
capillaries and 95 seconds with 100 pl capillaries, which means that an amplifica-
tion reaction with 40 cycles is usually completed within 35 to 65 minutes.

—— Optics

Fan

Temperature sensor

View into the thermal chamber of the LightCycIer® 2.0 Instrument

')



System Description

Photometer

4.3 Photometer
4.3.1 Optics

The photometer, as schematically illustrated below, is composed of two units connected
with a light conductor. The excitation unit is equipped with a blue LED light source with
a maximum emission of 470 nm. The blue LED serves as the energy source for sample
excitation. Light emitted by the blue LED is focussed on the tip of the capillary and hence
excites the fluorescent dyes therein. The emitted fluorescent light is reflected back in the
photometer with the aid of a dichroitic mirror.

The light conductor divides the fluorescent light into six channels independently from
wavelength.

In the detection unit the fluorescent light is collimated with aspherical lenses and a spe-
cial optical filter system is accountable for the wavelength specific measurements at 530
nm, 555 nm, 610 nm, 640 nm, 670 nm and 705 nm. A second aspheric lens transmits the
signal of each detection channel to a photohybrid for final evaluation. The signals of the
photohybrids are sent to the LightCycler” 2.0 Instrument via a serial interface.

Detection Unit

530 nm

555 nm

610 nm

640 nm

670 nm

705 nm

Filter Detector

Schematic of the Photometer Unit
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Fluorophore

Fluorescein
SYBR Green |
HEX/VIC

LC Red 610"
LC Red 6402
LC Red 670°
LC Red 705*

System Description

Photometer

4.3.2 Detection Channels

The six detection channels within the LightCycler® photometer unit permit analyses at
certain emission wavelengths, which allow exact measurement of emissions from the flu-
orophores shown in the table below:

470 nm 1 2 3 4 5 6
530 nm 555 nm 610 nm 640 nm 670 nm 705 nm

494 nm 520 nm
494 nm 520 nm
560
610
640
670
705

TLC Red 610 = LightCycler” Red-610-N-hydroxysuccinimide ester
(Cat:No.: 03 561 488 001)

2 LC Red 640 = LightCycler” Red-640-N-hydroxysuccinimide ester
(Cat:No.: 12 015 161 001)

3 LCRed 670 = LightCycler® Red 670-N-hydroxysuccinimide ester
4 LC Red 705 = LightCycler® Red-705-Phosphoramidite

LC Red 610, LC Red 640, LC Red 670, and LC Red 705, are not excited by the blue LED, but
are FRET partners of fluorescein.

HEX/VIC are directly excited by the blue LED, but emission is suppressed by a quencher.
Upon removal of the quencher, emission of HEX/VIC can be measured in channel 2.
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Mobile Components and Consumables
LightCycler® 2.0 Sample Carousel

5. Mobile Components and Consumables

In this section you will learn more about the mobile components, consumables and
products that are additionally available for use with the LightCycler” 2.0 Instrument.

5.1 LightCycIer® 2.0 Sample Carousel

The rotor-like sample carousel is the central element within the thermal chamber. It is
available for 20 pl (marked with a brown tag) and 100 pl (marked with a purple tag) glass
capillaries. Both have the capacity to hold up to 32 samples. The sample carousel can be
taken out of the instrument to be loaded on the workbench. This also allows easy clean-
ing and decontamination of the rotor and the thermal chamber (for cleaning instructions
refer to chapter E Maintenance). Furthermore, the use of an additional carousel provides
the possibility of preparing new samples while a run is in progress.

The LightCycler® 2.0 Sample Carousel (20 pl) as well as the LightCycler® 2.0 Sample
Carousel (100 pl) have an integrated barcode label for easy identification.

The LightCycler® 2.0 Sample Carousel can only be centrifuged in a LightCycler®
Carousel Centrifuge 2.0 described later in this chapter.
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System Description

LightCycler® Capillaries

5.2 LightCycler® Capillaries

The LightCycler” Capillaries (20 pl) just as the LightCycler” Capillaries (100 pl) consist of
the glass capillary itself, a plastic reservoir at the top, and a plastic stopper to seal the
capillary.

Each LightCycler” Capillary (20 ul) is 45 mm long (without plastic stopper) and has an
outer diameter of 1.55 mm.

Each LightCycler” Capillary (100 pl) is 51 mm long (without plastic stopper) and has an
outer diameter of 3.175 mm.

Samples are pipetted into the capillary reservoir and then forced into the glass capillary
by centrifugation.

( V?J High-speed thermal cycling in the LightCycler” 2.0 Instrument is made possible,
in part, by the unique design of the capillaries. Their superior surface-to-volume
ratio guarantees extremely rapid thermal transfer within the reaction mixture.
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Mobile Components and Consumables
LightCyc/er® 2.0 Capillary Releaser

5.3 LightCycIer® 2.0 Capillary Releaser

The LightCycler” 2.0 Capillary Releaser is a tool designed to allow easy release of all
capillaries placed into a LightCycler® 2.0 Sample Carousel (for 20 ul or 100 pl capillaries)
in one simple step. It can be used independently of the number of capillaries loaded.
Refer to section How to use the Capillary Releaser for a description of the functionality.

lig
h@qer Capillary Releaser

5.4 LightCycIer® Capping Tool

The LightCycler® Capping Tool is a tool designed to allow easy sealing of the sample cap-
illaries with their plastic stoppers.
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LightCycler® Sample Carousel O-Ring

5.5 LightCycler® Sample Carousel O-Ring

The LightCycler” Sample Carousel O-Ring is designed to firmly hold the capillaries. The
procedure for changing the O-Ring is described in chapter Maintenance.

System Description
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Mobile Components and Consumables
How to Use the LightCyc/er® Capillary Releaser

5.6 How to Use the LightCy(:Ier® Capillary Releaser

The LightCycler” Capillary Releaser is a plastic part, slightly smaller in diameter than the

sample carousel. You can use it to easily unload capillaries from the LightCycler” 2.0
Sample Carousel.

Place the loaded carousel on the LightCycler® Capillary Releaser, then push the carousel
down with the flat of your hand. The capillaries will be released from the rubber O-ring

and held at a slightly elevated position. The capillaries can now be easily removed from
the sample carousel.
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Mobile Components and Consumables
How to Use the LightCyc/er® Capillary Releaser

If the capillaries are simply to be discarded, put the loaded sample carousel onto the table
upside down. Then insert the LightCycler’ Capillary Releaser into the bottom of the
carousel and press down to release the capillaries.

When the sample carousel is lifted, the LightCycler® Capillary Releaser will slide down
into the carousel, fully releasing the capillaries from the sample carousel.



Mobile Components and Consumables
LC Carousel Centrifuge 2.0

5.7 LC Carousel Centrifuge 2.0

The LC Carousel Centrifuge 2.0 (Cat. No.: 03 709 582 001 for 230 Volt machine, Cat. No.:
03 709 507 001 for 115 Volt machine) is a specially designed table top centrifuge which
allows a convenient spin-down procedure for capillaries which have been loaded directly
into the sample carousel after pipetting. The whole carousel is centrifuged and
transferred to the LightCycler” 2.0 Instrument. The LC Carousel Centrifuge 2.0 may
additionally be required to work with the LightCycler” 2.0 Instrument instead of using
LightCycler” Centrifuge Adapters. For details refer to chapter C Operation.
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Operation

Operation

1. Introduction

Prior to starting operation, review chapter A Overview and chapter D Software to verify
the identification and location of the LightCycler® 2.0 Instrument components and to
become familiar with the software handling.

2. Start-Up

Close the LightCycIer® 2.0 Instrument lid.

Put the LightCycIer® ON/OFF switch on the back of the instrument in the ON
position. To locate the ON/OFF switch refer to chapter A Overview

Switch on the PC and printer.

Start-up Windows.

Start the LightCycIer® Software. Details on working with the LightCycler
Software 4.05 are described in chapter D Software.




Start-Up
Status LED

2.1 Status LED

Three diodes are located at the front of the LightCycler” 2.0 Instrument. All diodes come
on when the instrument is switched on. In this way, the instrument tests for proper func-
tioning of the diodes. During instrument operation, the diodes function as described in
the table below.

Position of | Color of Label
diode diode
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Operation

Lid Lock

22 Lid Lock

The lid is locked automatically when a run starts. It can also be locked by activating the
Real Time Fluorimeter. The lid is unlocked after completion of a run or after exiting a
run.

Lid Lock

Make sure you keep your hands out of the way when the lid is closing to avoid
physical injury that might be caused by the upper metal part of the lid lock.

Button for opening the Lid Lock manually’

@ The lid lock is regulated electronically. For manual opening (e.g., if no electricity is
available), the lid can be unlocked manually by pressing the hidden button under
the front left side of the instrument as indicated in the picture.

If the instrument is unlocked manually during a run, the run will be aborted and
all data will be lost.




Preparing a LightCycler® Run

3. Preparing a LightCycIer® Run

o Program the experiment protocol and define the sample numbers, names, etc. Refer
to chapter D Software for detailed instructions.

Prepare a master mix and omit the DNA/RNA. Details on preparing the master mix
are described in the corresponding pack inserts.

e Mix by gentle vortexing

o Place the capillaries into the LightCycIer® Centrifuge Adapters that have been
precooled in the cooling block.
Pipette the reagent mix into the plastic reservoir at the top of the capillary.
Add the DNA/RNA template to the capillary.
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Operation

Seal each capillary with a plastic stopper using the LightCycIer® Capping Tool. Ensure
that each LightCycIer® capillary is closed tightly by checking it visually: The lower
part of the plastic stopper must be completely inserted into the glass capillary.

Place the capillaries in the LightCycIer® 2.0 Sample Carousel, keeping the capillaries
in an upright position. Make sure that all capillaries are fixed in the optimal position
where the O-ring of the LightCycIer® 2.0 Sample Carousel covers the lower part of
the plastic chamber. Proper positioning can be ensured by lightly pressing the cap
until a final "click" is heard as the capillary reaches its final position.

\ W,

When pressing the capillaries into the LightCyc/er® 2.0 Sample Carousel, do not
press too hard. Do not use Light(,j/c/er® capillaries that show slight cracks or
cracked slightly when inserted into the LightCyc/er® 2.0 Sample Carousel.

Do not use LightCycler® capillaries that have been dropped. LightCycler®
capillaries with slight cracks, possibly invisible, might rupture during a
LightCycler® run.




Preparing a LightCycler® Run

o Put the loaded LightCycIer® 2.0 Sample Carousel into the rotor cup and place it in

the LC Carousel Centrifuge 2.0. Refer to the LC Carousel Centrifuge 2.0 Operator's
Manual for operating instructions.

¢ ) Alternatively, with the help of the LightCycIer® Centrifuge Adapters, you can
¥ spin down the reaction mix inside the capillaries in a standard benchtop
centrifuge, like the Biofuge 19 from Heraeus Instruments. Centrifuge briefly, at

not more than 735 x g. Take care to use only rotors that are designed to hold
2.0 ml reaction tubes.
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Preparing a LightCycler® Run

0 Place the LightCycIer® 2.0 Sample Carousel in the LightCycIer® 2.0 Instrument.
Ensure that the notch below sample position 1 on the LightCycIer® 2.0 Sample
Carousel locks into position against the pin on the thermal chamber as indicated in
the upper picture. Check visually if the carousel is inserted correctly and fits perfectly
in the thermal chamber as indicated in the lower picture.

Instrument ensure that the thermal chamber is clean and free of any items
which could interfere with the capillaries during the run. Cleaning instructions
are specified in chapter E Maintenance.

Before the LightCycIer® 2.0 Sample Carousel is placed in the LightCycIer® 2.0

o Close the lid. You are now ready to start the run.
Refer to chapter E Maintenance for details on subsequent measures if
capillary breakage occurs.

Operation



Abort a Run

4. Abort a Run

Refer to chapter D Software for instructions on how to abort a run.

5. Shut-Down

To shut down the LightCycler” 2.0 Instrument proceed as follows:

o Exit the LightCycIer® software and shut-down the computer.

9 Put the LightCycIer® ONV/OFF switch on the back of the instrument in the OFF
position. To locate the ON/OFF switch refer to chapter A Overview.

e Switch off PC and printer.

To ensure that the lid is unlocked, complete or exit a run before shutting-down the
LightCycler® 2.0 Instrument.
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Software

How to use the Software Part

The following sections summarize which portions of the software chapter you will find
most helpful, depending on your responsibilities and the role assigned to your user
account. If you are installing the LightCycler” Software 4.05, you must use an account
that has the Local Administrator role. If you are using LightCycler” Software 4.05 after it
has been installed, see your System Administrator to learn which role is associated with
your account.

All users

Refer to the following chapters for general information and for instructions for tasks any
user can perform:

Chapter 1 “Overview of LightCycIer® Software 4.05”
Chapter 3 “Overview of Experiment Analysis”
Chapter 9 “Working with Preferences”

If your user role is Local Administrator

Refer to the following chapters for information about tasks that require the Local
Administrator role:

Chapter 8 “Using Reports, Charts, Queries and Instrument Tools”
> “Using diagnostic tools”

Chapter 11 “Managing User Access”
Chapter 12 “Installation of Light(:ycler® Software 4.05”

If your user account has the Local Administrator role, you have access to all features and
functions of LightCycler” Software 4.05. Refer to the rest of the software chapter for
information about all the tasks you can perform.

If your role is Expert User

Refer to the following chapters for information about tasks that require at least the Expert
User role (Local Administrators can also perform these tasks):

Chapter 2 “Creating and Running an Experiment”

Chapter 4 “Performing Quantification Analyses”

Chapter 5 “Performing Qualitative Detection Analysis”

Chapter 6 “Performing Melting Curve Analyses”

Chapter 7 "Performing Other Analyses"

Chapter 8 “Using Reports, Charts, Queries, and Instrument Tools”

Chapter 10 “Using Templates and Macros”

Chapter 12 “Installation of LightCycIer® Software 4.05”
b “Adding a new instrument to the database”




How to use the Software Part

If your role is Standard User

Refer to the following chapters for information about tasks that require the Standard
User role (Expert Users and Local Administrators can also perform these tasks):

Chapter 2 “Creating and Running an Experiment””

As a Standard User, you cannot create experiment protocols, but you may be able to
modify a protocol or a sample list as you run an experiment macro. Read this chapter to
learn how to use the LightCycler” Software 4.05 Run module to create or modify experi-
ment protocols and sample lists.

Chapter 10 “Using Templates and Macros”
> “Executing an experiment kit macro”
> “Adding and deleting macro buttons on the Front window”

These sections explain how to run predefined macros and how to add or delete macros
from the LightCycler® Software 4.05 Front window.

Subchapter summary
The chapters in the software part of this manual cover the following topics:

Chapter 1, “Overview of LightCycler® Software 4.05”— introduces the buttons, menus,
and panes of the LightCycler® Software 4.05 window and explains how to use the
window.

Chapter 2, “Creating and Running an Experiment”- explains how to define and run
experiment protocols.

Chapter 3, “Overview of Experiment Analysis”— describes the analysis modules available
in LightCycler® Software 4.05, explains the general procedure for performing any analy-
sis, and explains how to use the analysis window.

Chapter 4, “Performing Quantification Analyses”— explains how to perform each of the
quantification analyses.

Chapter 5, “Performing Qualitative Detection Analysis”— explains how to perform a
Qualitative Detection analysis, which determines the presence or absence of a target DNA
sequence.

Chapter 6, “Performing Melting Curve Analyses”— explains how to perform each of the
melting curve analyses.

Chapter 7, “Performing other Analyses”— explains how to perform nucleic acid quantifi-
cation and how to use color compensation to compensate for multicolor experiments.

Chapter 8, “Using Reports, Charts, Queries, and Instrument Tools”— explains how to
use LightCycler® Software 4.05 tools to create reports, customize charts, retrieve items
from the database, and monitor the LightCycler® Instrument.

Chapter 9, “Working with Preferences”— explains how to set preferences that determine
the format of charts, samples, and windows and how to set default directory paths.

Chapter 10, “Using Templates and Macros”— explains how to create and apply templates
to reuse experiment protocols and other items, and how to create and execute macros to
automate LightCycler® Software 4.05 procedures.

Chapter 11, “Managing User Access”— describes the different types of user accounts
available in LightCycler” Software 4.05 and explains how to set up user accounts and how
to change your password.

Chapter 12, “Installation of LightCycler” Software 4.05”— explains how to install
LightCycler® Software 4.05, set up initial user accounts, and add a LightCycler® Instru-
ment to a LightCycler® Software 4.05 database.
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Starting the LightCyc/er® Software 4.05

Software

1. Overview of LightCycIer® Software 4.05

This chapter provides a general introduction to LightCycler” Software 4.05. It includes
the following topics:

® Starting the LightCycler® Software 4.05

©® Understanding the LightCycler® Software 4.05 window

® Opening, creating, and saving objects

® Renaming and deleting objects

©® Importing and exporting objects

©® Changing your password

1.1 Starting the LightCycler® Software 4.05

Follow the procedure below to start the software and open a demo experiment. The demo
experiment illustrates the features and components of the LightCycler” Software 4.05
described in the rest of this chapter.

To start LightCycIer® Software 4.05 and view a demo experiment

0 Double-click the &7 LightCycIer® Software 4.05 icon on the desktop.

e In the Login dialog box, type your user name and password. (The initial password for
the admin user is LightCycler01. You will be prompted to change the initial password
upon your first login. For more information see Changing your Password.)

e To connect to the database on the local computer, select LocalExor3 in the Log on to
box.

° Click Login.

The application displays the LightCycler” Software 4.05 window containing the Naviga-
tor on the left and a picture of a LightCycler® Instrument on the right. The activity of the
buttons you see on the window depends on the role associated with your user account. If
your account has the Standard User role, you can choose an experiment button from the
Macro list visible on this window to execute predefined experiment protocols. If your
account has the Expert User or Local Administrator role, you can also choose the buttons
New Experiment and Analysis.




Overview of LightCycler® Software 4.05
Starting the LightCyc/er® Software 4.05

# LightCycler Software 4.05 - [Front screen] ) =18]x]
po Fle Edt View Tools Window Help 1= x|

“j £ Mo w0 Aun yircvsic. | £30pen. @ sae @amot | gTenclts. SaRunaco
x

PR

<] Foot
5] Adriristration
] Instruments

Version 4.05

| Experiments
_| Preferences
| Special Data
| Templates and Macros

Delete

[Type | Date | Time [Message x|

47 Front screen

Logged on to LocalExord as System Admin Reszarch

The headings in the picture are buttons used to perform various tasks. Which buttons are
active depends on the role associated with your user account.

New Experiment launches the Run module. For more information about using the Run
module to create experiments see chapter Creating and Running an Experiment.

Analysis lets you select an existing experiment to analyze. For more information about
analyzing experiments see chapter Overview of Experiment Analysis. (Not all user
accounts have rights to analyze an experiment. See chapter Managing User Access for
information about privileges associated with user accounts.)

Roche Macro lets you select a previously installed Roche Macro. For more information
about installing and executing Roche Macros see chapter Using Roche Macros described in
the LightCycler® 2.0 Operator's Manual, Manual A: for in vitro diagnostic use.

Macro displays the protocol window, which contains custom buttons used to execute
predefined experiments. For information about creating macros for predefined
experiments and linking them to buttons on the front window see chapter Using
Templates and Macros.
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To open a demo experiment, in the Navigator, click the plus sign (+) next to each item
in the path Roche\Experiments\Demo Experiments\.

Navigator X

P

=] Raoot

£ 2] Administration

2] Intruments

El-_ | Roche

El-_ | Experiments

E-_] Demo Experiments

H-__| Special Experiments
{E Demo Abs Quant with 6l
{E Demo Absolute Quantific:
{E Demno Genotyping

{E Demno Genotyping with &
{E Demo Mucleic Acid Quar
{E Demo Qualitative Detect
{E Demo Relative Quantific.
{E Demo Relative Quantific.
{E Dema T Calling

{E tulticolar Demo Set Tm
H-__| Preferences

H-__| Special Data

#-__| Templates and Macros

(| Roche Service
|'_—'|_| Adrin
i | Experiments

| Preferences
| Special Data
#-__| Templates and Macros

< | i

Double-click any of the experiment names to open the experiment in the
LightCycIer® Software 4.05 window. The summary information for the experiment is
displayed in the main window.

Select the Raw Data tab. The tab contains a list of samples and charts of experiment
data.

To learn more about the LightCycIer® Software 4.05 window, refer to the next section.

To close an experiment select Close from the File menu or click the X in the upper
right corner of the work pane.

© 600 0 O

To exit the software, select Exit from the File menu or click the X in the upper right
corner of the main window.
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1.2 Understanding the LightCycIer® Software 4.05 Window

The figure below illustrates a LightCycler” Software 4.05 window containing information
from a demo experiment.

Navigator Module bar Work pane Close program

Close work pane

with Internal Contral]

Menu bar
Global Toolbar

Temperature History

é;—L'AM}F.#J,WMﬂMJJHMFHJMUM&’M%

|
N

0 440 1251 2205 3118 w3 4248
Time (hemm:ss)
. e

Flucrescence History

5N 21 ) 3808 4307

18] e—] 2
Fe [ Date | Tee Message xl__ ——Messages
g iy — r—Taskbar

{990 onto Localrd & System Ak Research ——Status bar

The LightCycIer‘fB) Software 4.05 window contains the following areas:

® The Navigator organizes and displays information about users, instruments, and data.
® The Menu Bar and Global Toolbar contain menus and buttons for common tasks.

® The Module Bar provides access to experiment modules, including protocols, sample
information, and analysis modules. The module bar is visible only when the work
pane displays experiment information.

® The Work Pane is used to perform the specialized operations of the software, such as
programming the experiment, viewing experiment data, or analyzing results. After
Login the Front window is displayed in this area.

® A Messages window displays messages generated from the software during an
experiment run as e.g., €rror messages.

® A Taskbar and a Statusbar are located at the bottom of the window. The taskbar dis-
plays icons for all open windows, including ones “hidden” behind the current window.
The status bar displays the name of the current user and computer, as well as any
status messages generated as you use the software.

The Global Toolbar, Taskbar, Statusbar, Messages, Navigator and the Front window can be
independently closed or reopened by deselecting or selecting the area from View Menu in
the Menu Bar. The following sections describe the main areas of the LightCycler”
Software 4.05 window in more detail.
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1.2.1 The Navigator

The Navigator on the left side of the LightCycler® Software 4.05 window provides access
to items stored in the LightCycler® Software 4.05 database. Items include experiments,
user accounts, instruments, macros, and so on. In the Navigator, items are organized in
folders in a tree structure.

The Navigator always includes the following default folders and objects:

® User folders (including the System Admin folder and folders for each user account).
Each user folder contains default subfolders, such as a folder for experiments.

® A Roche folder that contains experiments, templates, and macros from Roche that can
be used by anyone with access to LightCycler” Software 4.05. (To modify a Roche
object, you must first copy it to your own user folder.)

® An Instruments folder that contains an object for each LightCycler” Instrument, when
the instruments are added to the software.

® An Administration folder that contains objects for user groups, user roles, user
accounts, and security policies. The Administration folder is visible only to users with
Local Administrator privileges.

@ The Navigator is similar, but not identical to the Windows Explorer of your computer.
The Navigator displays data that are stored in a data base not on your windows file
system.

A typical Navigator is shown below.

Navigator ||

IR

] Root

[ ] Administration

----- ] Instruments

=-__| Roche

2] Experiments

El-_ | Demo Experiments

-] Special Experiments
{E Demo Abs Quant with [nl
{E Lemo Abgolute Guantific
{E Demo Genotyping

{E Demo Genotyping with e
{E Lemo Mucleic Acid Quar
{E Demo Qualitative Detect
{E Demo FRelative Quantific.
{E Demo FRelative Quantific.
@ Dermao T Calling

@ Multicolor Dema Set Trm
| Preferences

| Special Data

| Templates and Macroz

#-__| Roche Service

EI_' i Admin
| Experiments
«__| Preferences
-] Special Data

_| Templates and Macros

> To show or hide items under a folder, double-click the folder name or click the plus
(+) or minus (-) sign next to the folder.

> To close the Navigator, deselect Navigator from the View menu or click the X in the
upper right corner of the Navigator pane. Closing the Navigator causes the work pane
to extend the full width of the window.

> To reopen the Navigator from the View menu, select Navigator.

Software
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1.2.2 The Menu Bar and Global Toolbar

Use the menu bar and global toolbar (along with the Navigator) to create and manage
LightCycler® objects. The buttons provide quick access to many commands that are
available in the menus.

Using menus

File menu

® Create (New), open, save, and close objects

® Log out of the current session

® Import or export files

® Print an experiment report or print the current window
® Exit the software

Edit menu

® Cut, copy, and paste data in the work pane

® Select all items

View menu

® Display or hide the following parts of the LightCycler” Software 4.05 window: the
Global Toolbar, Taskbar, Statusbar, Messages and Navigator

® Display the Front window (the window you see when you start LightCycler” Software
4.05) in the work pane

Tools menu
® Change your password

® Open the user management tool (used to create, delete, and edit users, groups, and
roles)

® Create, apply and run macros and templates based on an object currently open in the
LightCycler” Software 4.05 window

©® Manage instrument information
® View database status (for local administrators only)

® Obligate users to enter a Carousel ID in the Policy Editor (for local administrators
only)

® Install a Roche Macro
Window menu

® Close, minimize, and arrange windows when multiple windows are open in the work
pane

® Select an open window to make it the active window (The bottom of the Window
menu displays a list of all currently open windows. The active window is checked.)

Help menu
® Display an online version of the LightCycler” 2.0 Instrument Operator's Manual

® View version and other information about the software, e.g. copyright.
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Understanding the LightC)/c/er® Software 4.05 Window

Using toolbar buttons

Use toolbar buttons to perform key LightCycler® Software 4.05 tasks, such as creating a
new experiment, opening an existing experiment, saving data, and so on. If a button is
inactive (dimmed) it may be because you do not have the necessary permission to
perform the task or because the task isn't allowed in the current state. For more
information about permissions see chapter Managing User Access.

The global toolbar contains the following buttons:

Click New to create a new object. A dialog box displays icons for all the objects you can
create. Select the type of object you want.

Click Run to open the Run module so you can create a new experiment.

Click Analysis to add a new analysis module to an existing experiment. A dialog box dis-
plays a list of available analyses. The button is enabled only when an experiment is active
in the work pane.

Click Open to open any object. A navigator opens so you can select the object. (You can
also double-click an object in the main Navigator to open it.)

Click Save to save any changes you make to an object. The button is enabled only when
the object in the active window has been modified.

Click Report to open an experiment report window. Choose the information you want to
include in the experiment report.

Click Template to apply a predefined template to the currently active object. A navigator

* opens so you can select the template to apply.

Click Run Macro to run a predefined macro. A navigator opens so you can select the
macro to run.
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1.2.3 The Work Pane

The LightCycler® Software Work Pane contains information specific to the operation you
are performing. For example, when you run an experiment, the work pane displays a run
window that includes a tab for the experiment protocol, a tab that displays the current
data being generated, and a tab for experiment notes.

The work pane is designed to allow multiple open windows. A label for each open win-
dow is visible in the taskbar at the bottom of the window. The work pane illustrated
below displays two windows: the Front window and a window for an experiment.

& LightCycler Software 4.05 =1=21x|
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N i
[Tyme | Date | Tims |Mesosas [xl]
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Logged on to LocalExord as System Admin Research

To view and size windows in the work pane

b Use the mouse pointer to drag a window’s edge or corner to resize the window.

» Use the buttons —|&#|x| in the upper right corner of each window to maximize,
minimize, restore, or close the window.

» Use the Window menu to close, minimize, or arrange the windows.

b Click a label in the taskbar to restore a minimized window or to bring a hidden
window to the front.

To size individual sections of Windows

> Drag the horizontal borders between sections to size them.

» Click the handle on the border of a section = i =1 to hide or show/
expand the section.
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1.2.4 The Module Bar

The module bar contains icons for experiment components. The menu is visible only
when an experiment is open. The module bar displays the following icons:

Summary icon opens the Summary module of the experiment, which contains informa-
tion about the experiment (such as name, date, and owner) and charts of data generated
by the experiment.

Run icon opens the Run module, which includes the details of the experiment protocol,
charts of experiment data, and notes entered by the person running the experiment.

Samples icon opens the Sample Editor, which contains sample information needed for
the experiment and the analyses.

Analysis icons open the associated analysis module. When an analysis is added to an
experiment, an analysis icon is added to the module bar. This example shows an icon for
an Absolute Quantification analysis.

To use the module bar

> Click an icon to open the related experiment module or use the keyboard shortcut for
the icon, Ctrl-Shift-n, where n is the number of the icon counting from the top. For
example, the Samples icon is always third in the list of icons, so to open the Sample
Editor module, press Ctrl-Shift-3. (Hold the mouse pointer over an icon to see the
name of the related module and the keyboard shortcut for opening the module.)

> Click Analysis of the toolbar or right-click the module bar and select New Analysis to
add an analysis module to an experiment.

> Right-click an analysis icon to display a menu that lets you
Remove the current analysis from the experiment.
Rename the current analysis. Renaming is helpful if you have more than one
analysis of the same type, such as two absolute quantification analyses.
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1.3 Opening, Creating, and Saving Objects

You can use the Navigator and the toolbar menus and buttons to open, create, or save
LightCycler” objects. (The objects you are allowed to create depend on your user status.)

To open an existing object

Double-click the object name in the Navigator or click [£20een.. on the toolbar or select
Open from the File menu. A small navigator opens in a dialog box. Select the object
name, then click OK. The information for the object is displayed in the work pane.

To create and save a new object

» Click ' {3Me=w..| on the toolbar, or from the File menu select New. A dialog box opens
containing icons for LightCycler® objects. Select the icon for the object you want, then
click OK.

Tip: To create a new experiment, you can also click #wFun. on the toolbar or New
Experiment on the Front window.
> Enter information in the work pane to define the object.

» Click &égave  on the toolbar, or from the File menu, select Save.

1.4 Copying ltems

You can copy an item from another user’s folder into your own folder or subfolder.
(However, your user role may limit which other users’ folders are visible to you.)

Once the item is in your own folder, it becomes your item and you can modify it as
necessary (subject to the limitations of your user role). For example, you might want to
copy a macro template from the Roche folder into your own Templates folder and then
modify it.

To copy items from another user’s folder

> Right-click the item you want to copy in the Navigator, then select Copy. A small
navigator dialog opens.

P Select a target folder enter a new name for the item if desired, then click OK.
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1.5 Renaming and Deleting Objects

Your user role determines which objects you can rename or delete. For more information
about user roles see chapter Managing User Access.

To rename an object

Right-click the object in the Navigator, then select Rename or select the object in the
Navigator, then press F2. The object name becomes an editable text box. Type in the new
name of the object.

To delete an object

Right-click the object in the Navigator, then select Delete. Or select the object, then press
the keyboard Delete key. Click OK to confirm the deletion.
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1.6 Exporting and Importing Files and Objects

To view experiment information in LightCycler” Software 4.05, the experiment file must
be stored in a LightCycler” Software 4.05 database. Therefore, if experiment files are
currently stored on a hard drive, or a diskette, you must import the files into the database.
Importing a file does not remove it from the original location; it copies the file into the
database so you can view the information in LightCycler” Software 4.05.

For example, you need to import files in these cases:
® If you want to view experiment files from previous versions of LightCycler” software.

® If you want to move a LightCycler” Software 4.05 experiment file from one
LightCycler” Software 4.05 database to another; in this case you must first export the
file from the database to a location such as your hard drive, then import the file into
the other database.

Using the Import command on the File menu, you can import the following:

® ATF (experiment file from LightCycler” software V3.5.3); you can import all the FLO
files from an entire directory at one time using the LightCycler” Software 4.05 batch
import tool, described below. (Importing FLO files automatically imports the
corresponding ABT and TEM files.)

® COF (coefficient files from LightCycler® Relative Quantification Software V1.01)
® IXO (experiment file from LightCycler” Software 4.05)
Read the sections below to learn how to import and export LightCycler” Software 4.05

files individually or by directory.

You can import a MPLC or a LCDA 3.5.3 sample (SAM) file into a new experiment,
using the Import SAM button in the LightCycler” Software 4.05 Sample Editor. For
more information see chapter Creating and Running an experiment.

1.6.1  Exporting Individual LightCycler® Software 4.05 Objects

To store LightCycler® Software 4.05 experiment objects or templates outside the
LightCycler” Software 4.05 database or to transfer LightCycler” Software 4.05 objects
between databases, you must export the LightCycler® Software 4.05 files. Exporting a file
does not remove the object from the database, but copies the file into XML and stores it
at the location you designate. The exported file has an .ixo file extension.

To export a LightCycler® Software 4.05 object:

In LightCycIer® Software 4.05 open the experiment or template you want to export.
The object must be open in the Work Pane before you can export it.

o From the File menu, select Export.

e Navigate to a location to save the exported file, select Object .ixo Files (IXO) as the file
type, enter a new file name (or keep the existing name), then click Save. The file is
saved with an .ixo extension.
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1.6.2  Exporting Multiple Experiment Files simultaneously
LightCycler® Software 4.05 includes a batch export tool that lets you export all

experiment files in a directory at one time. Follow the instructions below to export a
directory of experiment files.

To export a directory of experiment files:

From the LightCycIer® Software 4.05 File menu, select Batch export. The Batch export
dialog box is displayed.
=T

Select source folder | Select target diectary | Dptions | Start expart| Export status | Export dane |

Select a folder to scan for objects:

[ Foot

1 Expert User
1 Local Administiater
] Rloche

] Roche Service
1 Standard User
-] System Admin

I EE periments:
) Preferences
1 Special Data
1 Templates and Macros
¥ Scan Sublalders

Select the folder containing the experiment files. Check the Scan Sub-folders box if
you want to include the subdirectories of the directory. Click Next.

In the Select target directory tab select the folder in which to store the exported files.
You can either enter a directory manually (check the Directory doesn’t exist box to
create a new directory), or use the Browse function to search for an existing directory.

In the Options tab select the types of objects to export.

Click Next in the Start export tab to start the batch export.

As the files are exported the Export status tab displays status messages. If a file
cannot be exported successfully, the word FAILED appears in front of the file path
name, and the status message indicates the cause of the failure.

o 0006 o0 0

When all the files have been exported view the results on the Export done tab.

#¥Batch export N - 1ol %]
Select source folder | Select target divectory | Dptions | Start export | Export status  Export done |
Export done.
Directories searched: 1
Files exported: 14
Files failed: 0
Files found: 14
<< Previous

e If any of the files could not be exported, repeat the export process as follows: Change
the export options and parameters on any of the tabs as necessary, then click Reset
on the Start export tab. Press Next to repeat the export process.

e When finished, click Done on the Export done tab to close the dialog box.

Software
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1.6.3

Importing Individual Files

You can import individual LightCycler® Software 4.05 object (IXO) files, as well as FLO
(experiment), and COF (coefficient files) files from previous versions of LightCycler®
Software. You can also import all the experiment files from an entire directory at one
time. After you import a file, you can save it as an object in your LightCycler® Software
4.05 database.

To import an individual file:

From the LightCycIer® Software 4.05 File menu, select /mport, then select the type of
file you want, as follows:

For FLO, ABT, TEM files, select ATF Files.

For COF files, select COF Std. Curve Files.

For LightCycIer® Software 4.05 object files, select Object .ixo Files.

Find and select the file you want, then click Open. The file is imported and is opened
in the work pane.
( Z\ To select multiple files, press Ctrl while clicking the file names.
®
If you import an experiment that includes color compensation, the color
compensation data is displayed in the work pane. To see the experiment, click
the experiment name in the taskbar.

To save the imported file as an object in the current LightCycIer® Software 4.05
database, click Save.

Navigate to a location in LightCycIer® Software 4.05 to save the object and enter
a new object name, then click OK. If an imported experiment includes color
compensation data, the color compensation data is automatically opened with the
imported experiment and should be saved by the user in the CCC subfolder of his
Special Data folder
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1.6.4

Exporting and Importing Files and Objects

Importing Multiple Experiment Files simultaneously

LightCycler® Software 4.05 includes a batch import tool that lets you import all
experiment files in a directory at one time. For batch import of FLO files, the directory
must contain the corresponding ABT and TEM file for each FLO file or the FLO file
cannot be imported.

Follow the instructions below to import a directory of experiment files and to repeat an
import if necessary.

To import a directory of experiment files:

From the LightCycIer® Software 4.05 File menu, select Batch import. The Batch Import
dialog box is displayed.

& Batch import [FLO) [ (O]

Select directories | Select target foider | Stat import | Import status | mport done |

Select one or more directaries to scan for files to import:

Directories [Include sub-directaries]  Remave

Hewt >

Click Add in the Select directories tab to find and select the directory containing the
experiment files, then click OK. The directory path is added to the window.

Check Include Subdirectories if you want to include the subdirectories of the directory.

Repeat Steps 2 and 3 to add additional directories as needed. Press the Remove
button to erase a selected directory. When finished adding directories, click Next.

In the Select target folder tab, select the folder in which to store the imported files,
then click Next.

© 0 00 O

In the upper part of the Start import tab select the types of files to import:

b ATF files: ABT, TEM, FLO files from LightCycIer® Software 3.5.3

» COF Std. Curve Files: coefficient files from LightCycler® Relative Quantification
Software V1.01

> Object .ixo files: experiment files from LightCycIer® Software 4.0 or 4.05

In the lower part of the Start import tab select the action to take if an imported file has

the same name as an existing file, as follows:

> Don'’t do anything. The new file is not imported if there is an existing file of the
same name. The word “Failed” appears next to the file name in the status
messages on the Status import tab.

> Replace the existing one with the new one.

P Change the name of the new one. A number is appended to the end of the file
name of the imported file.

> Don't save but leave open when done. The imported file is opened in LightCycIer®
Software 4.05, but is not saved in the LightCycIer® Software 4.05 database. You can
view and then manually save the file, if desired.

Click Next. As the files are imported, the /mport status tab displays status messages.
If a file cannot be imported successfully, the word FAILED appears in front of the file
path name, and the status message indicates the cause of the failure.
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e When all the files have been imported, view results on the /mport done tab.

# Batch import (FLD) S [=l E3

Seloot diectorios | Select target folder | Start import | Import status — Impart donel

Impart done.

Directories searched: 14
Files imported: 63

Files failed: 2

Files found: 65

<4 Previous |

e If any of the files could not be imported, repeat the import process as follows:
Change the import parameters on any of the tabs as necessary, then click Reset.
Select the Start import tab, then click Next to repeat the import process.

@ When finished, click Done on the /Import done tab to close the dialog box.

To repeat an import:

If any of the files in a directory failed to be imported successfully, you may need to repeat
the import after correcting any errors. For example, a FLO file cannot be imported if its
corresponding ABT or TEM file is missing. Or you may want to reimport a set of files
using different import options.

You can quickly repeat an import as follows:

o After performing the initial import, click Previous twice to return to the Start Import
tab.

Click Reset.

Clicking Reset prepares the software for a new import.

(Optional) If desired, select a different import option on the Start Import tab.

Click Next to start the new import.
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2. Creating and Running an Experiment

LightCycler” Software version 4.05 controls the LightCycler” 2.0 Instrument using
information provided in an experiment protocol. During an experiment run, the
protocol controls the instrument’s temperatures and hold times, the number of cycles
being executed, and so on. As the experiment progresses, LightCycler” Software 4.05
gathers temperature and fluorescence data from the instrument and displays it on the
LightCycler” Software 4.05 window. After the experiment is finished, you can save the
experiment data and use LightCycler” Software 4.05 analysis modules to analyze results.

This chapter explains how to do the following:

® Create and run an experiment protocol

® Enter sample information

For information about analyzing experiment data see chapter Overview of Experiment

Analysis.

For you to create an experiment protocol, your user account must have the Expert User
or Local Administrator role. If your user account has the Standard User role, you can run
macros for predefined protocols. For information about running macros see chapter
Using Templates and Macros.

2.1 Creating a Protocol and Running the Experiment

Follow the general steps below to create a new experiment protocol and run the
experiment. Detailed information for each step follows the general procedure.

To create a protocol and run the experiment:

o Turn on the computer and the LightCycIer® 2.0 Instrument. Start the LightCycIer®
Software and log in.

Ensure that the instrument is running before you start the software.

e Click New Experiment in the work pane or Run in the global toolbar. The Programs tab
of the Run module is displayed.

e In the Setup section of the Programs tab, specify general instrument settings.
(For more information see Entering Setup Information below.)

Programs | Orline Data Qispla_l,ll R
rSetup
Default Channel: | 640

-

Seek Temperature: | 30

tax. Seek Pos. a0

s sl [0

Instrurnent Type: |6 Ch -

X

Capillary Size: 200pl -
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° In the Programs section of the Programs tab, define one or more experiment pro-
grams. For each program, define temperature targets. (For more information see
Defining Programs and Temperature Targets below.)

Programs
AI Program Marne Cycles Enalysis Mode

Pre-incubation 1 “iMone -
il ¥ Amplification 45 ={Ouantificatian -
;I Cooling 1 “{Mone -
v

Amplfication Tempsiature Targets
AI Target Hold | Slope[(T/)| Sec | Step | StepDelay|  Acquisiion Mode
(0 | thhmmess] Target | Size [T [epeles)
1] 85 <{00:00:10 220 S S L ] =|None =
;I BlEE  S{00:00:10 F{eo =0 Fo Fo lSingle -
Ll 72 <{00:00:05 Zen =0 =0 Zo =|None =
O

(Optional:) Add any additional information in the Run Notes tab.

00

Select the charts you want to view as the experiment runs in the Online Data Display
tab. (For more information see Customizing the Online Data Display below.)

Start Run || End Progian | 10 Gyoles: | Eolor Barmp (0 < [ =] options -
Progiams  Drline Diata Display | Fun Motes |

) [ |
Not started

7] J_cnat_- 520 560 o0 [540 [670 [705_Acqustonno [ =]

Current Fluorescence

Fluorescence

12 4 E 8 11 14 17T W 2} B 28
Samples

7 Chan - s - Charmel(60) ~ Frogams 3| Chat -
Fluorescence History Temperature History

100 100
20 a0
= a0 i o0
g 70 g o
g 0 g &
§ 50 i 50
g a0 40
§ w0 i £
£ 5 S
10 10
o 0

0 0
Time (himm:ss) Time (himm:ss)

(Optional:) Perform an instrument self test.

Prepare a LightCycIer® run as described in chapter Operation.

Load capillaries into the LightCycIer® 2.0 Instrument.

0000

Enter sample information. (For more information see Entering Sample Information
below.)

(. You can also enter sample information during or after the run.

®

©

Click Start Run to run the experiment, then monitor data as it is gathered from the
instrument. (For more information see Running the Experiment below.)
Assure that the Windows screensaver function is turned off before starting a
LightC:vcler® run. Startup of the screensaver during a LightCycler® run may
lead to a loss of data.

@ When the experiment is finished, click Save to save the experiment data.

Read the following sections for more information about the key steps described above.
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2.1.1 Entering Setup Information

The Setup section of the Run module is shown below.

Programs | Orline Data Qisplayl R
—Setup

Default Chaninel: g4

e

Seek Temperature: |30 =

Max Seek Pos. a0

o

Instrument Type: |6 Ch -

Capillary Size: 20pl -

W

> In the Default Channel field, select the default fluorimeter channel used to gather
fluorescence data. Data is gathered from all channels, but the selected channel
becomes the default channel for which information is displayed during the experiment
and in the analysis modules.

> In the Seek Temperature field, enter the temperature the instrument reaches for the
seek process.
() In most cases the default temperature of 30°C need not to be changed. For some
&  applications as e.g., a reverse transcription (RT) PCR it might be a good idea to
seek at the same temperature that is used for the RT-step.

The instrument is not able to cool below room temperature. If you program a lower
temperature, which cannot be reached by the instrument, the seek process will be
performed at the lowest possible temperature.

> In the Max. Seek Pos. field, enter the highest position number in the sample carousel
holding a capillary. After the run begins, the instrument carousel rotates to detect
(seek) the number of samples you specify.

» In the Instrument Type field, choose the 6 Ch. Instrument type for your LightCycler”
2.0 Instrument (selected by default). For LightCycler” 1.1 and 1.2 select the 3 Ch.
Instrument type.

> For the 6 Ch. Instrument type a Capillary Size field is displayed. Select the capillary
size for the experiment.
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2.1.2 Defining Programs and Temperature Targets

Each experiment protocol has one or more Programs. Each program can be executed for
multiple cycles. A program consists of one or more Temperature Targets. A temperature
target specifies a temperature for the LightCycler® 2.0 Instrument, a hold time for the
temperature, the speed with which the temperature is reached, and so on. You define
programs and their temperature targets in the Programs tab of the Run module.

In the example below, there are four programs: Denature, PCR 3-Step, Melt and Cooling.
When the PCR 3-Step program is selected (45 cycles) the temperatures appear in the
table below, automatically. However temperatures should be selected, as required by the
user.

RoQ._____________
Start Run | Erd Program | + 10 Cycles |E0|0r Camp [ v| I j Options v|

Programs | Online D ata Display I Fun Maotes I

—Setup

Programs
Default Channel | 540 ﬂ Al Program Marme Cycles Analysis Mode
= Denature 1 “Mone -
Seek T ture: |30 = - —

Sex L SRS :I il » | PCR 3-Step 4k | CQuantification b
Max. Seek Pos. |30 = ;l helt 1 = elting Curves -
Instrument Type: |B Ch. j l| Cooling 1 =MNone A
Capillary Size; 20p j

|

PCR 3-5tep Temperature T argets
Al Target Hold Slope ["Cle]| Sec Step | Step Delay Acquisition Mode

[*C] [hbrarn: 22) Target | Size [C]| [cwcles]

il 85 =|00:00:10 S 20 S U L L =iMNone -
;l »EE  FH{oooo0 FH{20 =0 FHo Fo =|Single -
_| 72 2 00:00:08 320 i L [ L =|Mone M
v
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To define programs and temperature targets:

o In the Programs section of the Programs tab, click (+) to add a new program.
A default program named “Program” is added, containing one default temperature
target.

e Edit the default values for the following program parameters, clicking the tab button
on your keyboard to move from one column to the next. (If you make a mistake, click
() to delete the program, then start over.)

Parameter Description/Instructions Valid Values

Program The name for the program. Any alphanumeric string
Name Click in the Program Name
box, then enter a new name.

Cycle The number of times the 1-99 cycles
program should be repeated.
Enter a value or select it by

clicking on the up and down

arrows.
Analysis The type of analysis expected | None: No analysis is expected. However, if
Mode for this program (if any). The you add an analysis module after the run,

program will be selected auto- | the software will automatically select the

matically when you add the appropriate program for the analysis.

designated type of analysis Melting Curves: A melting curve analysis

module after the experiment is expected.

has finished running. Quantification: A quantification analysis is

Select an analysis mode from | expected.

the pull-down list. Color Compensation: A color

compensation analysis is expected.

Software
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In the Temperature Targets section, edit the default values for the following tempera-
ture parameters for the first temperature target.

Parameter Description/Instructions Valid Values
Target The target temperature. 37°C-98°C
Enter a temperature.
Hold The length of time to hold the | 00:00:00-12:00:00
target temperature in
hours:minutes:seconds.
Enter a hold time.
Slope The rate at which the program | 0.05°C-20°C per second
will reach the target tempera-
ture, specified as degrees per
second.
Enter a slope.
Sec. Target | A second target temperature to| 37°C-98°C
be reached by the last cycle of
the program. Use this feature to
change the target temperature
of a segment during the amplifi-
cation reaction. (This is useful
for performing touchdown
PCR)
Enter a temperature.
Step Size The number of degrees the 0°C-20°C
temperature will increase after
each cycle, in order to reach
the secondary target.
Enter a step size.
Step Delay The cycle number at which the | 0-99 cycles
temperature step up or step
down begins.
Enter a cycle number.
Acquisition | The frequency with which None: No fluorescence data is acquired.
Mode fluorescence data is acquired. | Single: Acquires fluorescence data once at
Select an acquisition mode from| the end of this temperature segment in
the pull-down list. each cycle.
This is the typical setting for quantification.
Continuous: Acquires fluorescence data
continuously. The rate depends on the
number of samples in the reaction and is
fastest for one sample.
This is the recommended setting for a melt.
The valid range for the Ramp Rate is
0.05°C/s to 0.2°C/s. If you select a value
outside this range a default value of
0.05°C/s will be set.
Step: Acquires fluorescence data at each
temperature transition. For example, if
0.5°C/sec is the Slope, fluorescence data is
acquired every 0.5°C.
This setting can be useful in melts. The
valid range for the Ramp Rate is 0.3°C/s to
1.0°C/s. If you select a value outside this
range a default value of 0.3°C/s will be set.

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0

Manual B: for general laboratory use




Creating and Running an Experiment

Software

Creating a Protocol and Running the Experiment

Click (+) to add another temperature target to the current program, then enter
parameter values. Repeat to define as many temperature targets as you need for
the current program.

Repeat steps 1-4 to create additional programs and their temperature targets.

¢ W\‘ To reorder the programs or temperature targets, select the item you want,
o then click the up [A| or down [ ¥| arrow to move the item up or down in
the list.

To delete an item, select the item, then click (-).

Look at the Overview section to see a graphical representation of all the programs
you have defined.

Overview

2 md
£
§ oad

won 10108 1713 2417 a2 3836 540 5248
Time (hemm:ss)

Click Save in the global toolbar to save the protocol. Navigate to a location to save
the protocol, enter a protocol name, then click OK.
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2.1.3  Customizing the Online Data Display

When the experiment runs, the data being collected are displayed in charts on the Online
Data Display tab of the Run module. Three chart types are available:

Current Fluorescence: For selected samples, displays fluorescence in each channel at
each fluorescence acquisition point

Fluorescence History: For selected samples, displays fluorescence in a user-designated
channel over time

Temperature History: Temperature and data acquisition points during the experiment
run

You can change the type of chart displayed and modify display options for the two
fluorescence charts.

If you prefer, you can customize the online data display while the experiment is

running.

To customize the online data display

In the Run module, select the Online Data Display tab, then click above the
chart you want to change. The chart’s options toolbar containing a Chart menu, is
dlsplayed. Fluorescence charts contain additional options.

To change the chart type, from the Chart menu, select the new chart type.

]J Chart Iv Aziz + Channel [640) ~  Programs

® Fluorescence History
Temperature Histon History
LCurrent Fluorescence

To modify display options for the fluorescence charts:

» For a Current Fluorescence chart select the channels to include in the chart. To see the
data from a previous acquisition, enter or select an acquisition number in the Acquisi-
tion no. field.

Iﬁ Iﬁ Iﬁ Iﬁ Iﬁ Iﬁ Acquigition no. |1 jl

> For a Fluorescence History chart select the Axis type (the type of data represented by the
X axis), the Channel, and the Program containing the data you want to see.

Az I' Channel [640) = Programsz

Eluorescence over Cycles
® Fluorezcence over Time

Fluorescence aver Temperature
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2.1.4  Performing an Instrument Self-Test

Before you load capillaries into the LightCycler® 2.0 Instrument, you can perform an
instrument test that checks all instrument functions, such as heating to the correct
temperature and rotating the carousel.

@ We recommend that you perform an instrument self-test once a day before starting
LightCycler® experiments. Always insert an empty carousel when performing an
instrument self-test.

To perform the instrument self-test:

> In the Run module, click Options next to the instrument selection box.

> Select Run Self-Test. The instrument performs the test and displays a message that the
test passed or failed. Click OK to clear the message.

> If the test failed, refer to chapter F Troubleshooting for further instructions or contact
your local Roche representative, otherwise, run the experiment.
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2.15

Running the Experiment

After you have defined setup parameters, programs and temperature targets, and the
online data charts, you are ready to run the LightCycler® experiment.

To start an experiment run:

Prepare a LightCycIer® run as described in chapter C Operation.

Insert the capillaries into the LightCycIer® carousel.

In the Run module, select an instrument from the instrument selection box.
(If only one instrument is connected to the computer, it is selected by default.)

Start Run button Instrument selection box
hiss | £ Piogen | =05 [Ea o o | =] ot~ |
Brograms | rkne Data Display | Run Notes |
DelakChernet (640 | | A | |ProgamMane Anelysis
: 411D Mone
! 30 ~ =
£ et E .il)PCRB-Smp Quantiication
Mo SeskPos. |30 a =|| [Melt Melting Curves
Instument Type: [6Ch =] | "o 1| | Caaling None

Caoilat Size: F T

Click Start Run. The Online Data Display tab displays a status message that indicates

the software is connecting to the instrument.

If for any reason the software cannot find the instrument, see chapter
Instrument Cannot be Detected.

You are prompted to save the experiment. Enter a name and a folder where you want
to save the experiment.

Status messages indicate the progress as the instrument performs the following
preparatory steps:
b Sets the seek temperature specified in the program
P> Waits while the LED warms up
b Seeks the sample positions. The instrument displays a message similar to the
following as it locates each sample:
Position 2 of 32: found “Neg Control”
> Begins the experiment run. Messages indicate which program, cycle, and segment
(temperature target) is being executed, for example:
Program 2 of 4 (Amplification), cycle 5 of 45, segment 1 of 3.
As the experiment progresses, the data is displayed in the charts on the Online Data
Display tab.

To view data for specific samples, select one or more samples in the sample list.
If needed, you can modify chart settings during the experiment run. For more
information see Customizing the Online Data Display above.
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Creating a Protocol and Running the Experiment

(Optional) To adjust or stop the program during the run:

> Click End Program to stop the current run program and skip to the next program
in the experiment protocol.

> Click +70 Cycles to add 10 cycles to the current program.

G \Z,\ The End Program and the +10 Cycles buttons are inactive during execution of

&  Pprograms with acquisition modes "None", "Continuous" and "Step".

b Click Abort Run to stop the run. (The Abort Run button replaces the Start Run
button during run.)

@ This will lead to a loss of data of the aborted experiment.
An aborted run cannot be restarted.

If you abort a run, the instrument may be hot. Before you open the lid,
wait until the instrument has cooled down.

0 When the experiment is finished, a status message displays “Run complete”
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@ Click Samples in the module bar to open the Sample Editor, and complete sample
information if necessary.
For more information see Entering Sample Information below.
You can enter or modify the sample information at any time before, during, or
after the experiment. We recommend that you enter the sample information
before running the experiment.

2.1.6 Instrument Cannot be Detected

If for any reason the instrument cannot be detected when you start the experiment, a
message prompts you to search for the instrument. Follow these steps:

> First determine whether the instrument is running, and turn it on if necessary. The
software cannot detect an instrument that has not been turned on.

» Check all connections.

> Click Yes in the message box to search for the instrument, then follow the remaining
prompts to find and select the instrument.

If the instrument is still not detected, call your local Roche service.




Creating and Running an Experiment

Entering Sample Information

2.2

Entering Sample Information

Use the LightCycler” Software 4.05 Sample Editor to record information about the
samples in the experiment. You can enter sample information before, during, or after an
experiment. However, you cannot change the number of samples after the experiment
run has begun.

You can also import a SAM file from a MagNA Pure LC purification or an older version
of LightCycler” software, if you want to use your usual experiment sample settings.

If you have Standard User privileges you can enter or change sample names, sample
notes, and the number of samples (before the run begins). If you have Expert User or
Local Administrator privileges, you can use all the features of the Sample Editor
described in the steps below.

To enter sample information:

Click Samples in the module bar to open the Sample Editor.

The Capillary View tab is displayed. The Sample Count field defaults to the value you
specified in the Max Seek Pos field in the Run module. (You cannot change this value
after the run has begun.) You can also add Analysis Tabs. For more information about
these tabs refer to the appropriate analysis chapters.

J Analysis Type ~ ‘ Reset Samples. Import SAM. . Auto Copy.. ‘ Selected Channels  [530 SEU|ETU|EAU|ETU|TUS| Print Samples
{Cepiay Ve |

Sample Count |26 =] LC Caroussl ID MPLE Batch ID
Assay Cat. No Assap Lot No Color Comp D

Poz| Sample Mame Sample MNate
B 1 |Sample1
Sample 2
Sample 3
Sample 4
Sample &
Sample &
Sample 7
Sample 8
Sample 3
10 |Sample 10
11 |Sample 11
12 |Sample 12
13 |Sample 13
14 |Sampls 14
15 |Gample 15
16 |Sample 16
17 |Sample 17
18 |Sample 18
19 |Sample 19
20 |Sample 20
21 |Sampls 21
22 [Sample 22
23 |Sample 23
24 |Sample 24
25 |Sample 25
26 |Sample 26
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In the Selected Channels area, click the channels to be used in the experiment. For
your LightCycIer® 2.0 Instrument, six channel buttons are displayed. If you are using a
LightCycIer® 1.1 or 1.2 Instrument, three channel buttons are displayed.

(Optional) Type values in the following boxes to identify the run.

> LC Carousel ID: A name or other identifier for the carousel used in this experiment
» MPLC Batch ID: A MagnaPure LC Batch ID

b Assay Cat. No.: A catalog number for a Roche kit (if using this kit)

P Assay Lot No.: A chemical manufacturing lot number of a Roche kit

P Color Comp ID: A color compensation ID used for this experiment
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Enter the following information for each sample:

Parameter Description Valid Values

Sample Name | The name of the sample Alphanumeric characters;
spaces are allowed (the length
of sample names is limited to
25 characters)

Repl. Of The position number of another | The number of another sample
sample this sample is a replicate| that is not already a replicate
of (you cannot create a replicate

of a replicate)

Sample Note Any additional information about| Alphanumeric characters
the sample

o

If you need to start over, click Reset Samples. You are prompted to confirm resetting
the values. Click OK. Resetting the samples leaves the same number of samples, but
resets the sample names and sample notes to the default values (including the
sample names and sample notes of the analysis-specific sample editor tabs).

When finished, click Save in the global toolbar to save the sample information with
the experiment. (Note that this is not possible during run.)

o

To print out your sample loading list, click Print Samples.
The print-out contains the following information:
b Assay Cat. No.
b Assay Lot No.
> For each sample:
position
sample name
replicate information
sample note

To import a SAM file:

To import a MagNA Pure LC or LightCycIer® SAM file containing the sample
information from a MagNA Pure nucleic acid isolation or an older version of
LightCycIer® software, open the sample editor as described above. Click /mport SAM
in the toolbar of the work pane, find and select the SAM file, then click Open or use a
barcode reader to scan the barcode of your SAM file generated by a MagNA Pure
instrument.

Importing a SAM file is only possible before a run has started.

LightCycler® Software 4.05 checks if the information, imported with the SAM
file (e.g., sample data, LC carousel ID, MagNA Pure Batch ID) matches with the
information entered in the experiment. If this check fails, an error message
appears. Follow the instructions displayed.

If you need to start over, click Reset Samples. You are prompted to confirm resetting
the values. Click OK. Resetting the samples leaves the same number of samples, but
resets the sample names and sample notes to the default values (including the
sample names and sample notes from the analysis-specific sample editor tabs).

When finished, click Save in the global toolbar to save the sample information with
the experiment.

Software
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3. Overview of Experiment Analysis

LightCycler” Software 4.05 includes analysis modules that can be used to analyze
experiment results in various ways. To analyze an experiment, you must add one or more
of the analysis modules to the experiment, after the run has finished.

To add an analysis module, you must have either Expert User or Local Administrator
privileges. If you have Standard User privileges you can view analyses that have already
been added to an experiment, but you cannot add the modules yourself. You can run
predefined experiment macros, which may add analysis modules automatically.

The following analysis modules are available:

Absolute Quantification:
Calculates the concentration of target DNA in unknown samples, based on the
concentration of standard samples.

Qualitative Detection:
Determines whether a target sequence is present in unknown samples.

Relative Quantification (Monocolor and Dual Color):
Compares the ratio of two sequences in unknown samples to the ratio of the same two
sequences in known samples.

Genotyping:
Defines genotype groups based on melting temperature profiles of the unknown samples
or based on imported standard profiles.

Tm Calling:
Calculates the melting temperatures and melting peaks of target DNA.

Color Compensation:
Generates color-compensation data that can be applied to a multicolor experiment or to
an analysis to compensate for overlap between fluorescence channels.

Nucleic Acid Quantification:

Calculates the concentration of DNA in unknown samples without amplification by
comparing the samples’ fluorescence to the fluorescence of known samples using
fluorescent dyes such as Pico Green.

This chapter explains the general steps required to perform any analysis and presents tips
on how to use an analysis window. Subsequent chapters explain in detail how to perform
each type of analysis.
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Overview of Analysis Steps

The general steps required to add an analysis module and perform an analysis are
described below. The steps are the same for any analysis type. For specific information
about setting parameters for each type of analysis, see the specific analysis sections.

To perform an analysis:

Open the experiment you want to analyze in the LightCycIer® Software 4.05 work
pane.

Click Analysis on the LightCycIer® Software 4.05 toolbar, or right-click the module bar
then select
New Analysis. The Create New Analysis dialog box opens.

Create Mew Analysis [ ]

Chooze the Analysiz Type to Create:
Amplification Analysis

" ahsolute Quantification

¢ Qualitative Detection

" Relative Quantification - Dual Colar

" Relative Quantification - Monocalor

Melting Curve Analpsis
= Genotyping
i Tm Calling

Other Methods
" Color Compensation
 Nucleic Acid Quantificati

Ok

Select the analysis type you want, then click OK If you create an analysis that has not
existed before, the software prompts you to enter the sample settings before creating
the analysis. If you answer with Yes, you are taken to the analysis specific sample
editor tab to enter the sample settings. No analysis is created in this case. To create
an analysis repeat step 2. If you answer with No the analysis module is added to the
experiment and an icon for the analysis is displayed in the module bar. An analysis-
specific tab is added automatically to the Sample Editor to allow for entering analysis-
specific information.

If desired, you can manually add an analysis-specific tab to the Sample Editor
before you add the analysis module to the experiment. You might want to do
this if you prefer to add all sample information to the experiment at one time, for
example before you run the experiment. For more information see Manually
adding an analysis-specific tab to the Sample Editor, below.

In the module bar, click Samples. If you have not already entered general sample
information, select the Capillary View tab, then select the channels used in the
experiment and enter information to identify the samples.
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Overview of Analysis Steps

e Select the analysis-specific tab in the Sample Editor, then enter sample information
for the analysis.
In the analysis-specific tab, each sample position includes a row for each channel.
That is, if you selected three channels, there are three rows for each sample position
on the analysis-specific tab. You can enter sample information in each channel row.
The figure below illustrates the Absolute Quantification tab in the Sample Editor. The
tab contains fields for sample types and control information specific to an Absolute
Quantification analysis.

| Analysis Type + | Resel Samples. ImponSéb.  AuoCopy. | SelectedChannels 530]560]610]640 670705 it Samples
Capillary Yiew Abs Quant |
antrols  Unit | copiess
Pas| Sample Name Charel | Target Name SampleType | Cancentiation | Cp Low | Cp High| Conc Low | Conc High
1 [notemplate contiol | B40 | Terget 4 Urknown 0 0
3 705 | Tawel6 Urkroem = =
2 [standard 1 B40 | Target 4 Standard 77065 0 0
05| Tewet 6 Urknown 0 0
3 [Standard 2 B0 | Taget 4 Standard B50E4 0 0
05| Tewet 6 Urknown 0 0
1 [Standad 3 B4D | Tormel 4 Standard 70063 0 5
705 | Tagel6 Urkraem 0 0
5 [Standard 4 B0 | Torget 4 Stendard B70E2 0 0
05 | Tawel6 Urkriaem 0 0
6 [Standard 5 B0 | Torget 4 Stendard E 0 0
05| Tewet 6 Urknown 0 0
7 [Negative Contral B0 | Tagetd Urkriaem 0 0
05| Tewet 6 Urknown 0 0
5 [Sample 1 B0 | Taget 4 Urkriawn 0 0
05 | Tawel6 Urkriaen 0 0
3 [Sample 2 B0 | Torget 4 Urknown 0 0
705 | Tawel6 Urkriaem 0 0
10 [Sampie 3 B0 | Torget 4 Urknown 0 0
05 | Tewet6 Urknown 0 0
T [Sample d B0 | Tagetd Urkriaen 0 0
05| Tewet 6 Urknown 0 0
12 [Sample 5 B0 | Taget 4 Urkriaen 0 0
705 | Tawel6 Urkriaem 0 0

The kind of information you can enter in each analysis-specific tab depends on the
type of analysis.

e Click the analysis icon in the module bar to open the analysis window; perform the
analysis by entering or adjusting analysis parameters. For more information, see the
individual analysis sections.

If you change information in the Sample Editor (except sample name, sample

note or target name) after performing the analysis, the analysis results are
recalculated using the updated values from the Sample Editor.

o Repeat steps 2-6 to add additional analysis modules. You can add more than one
analysis to an experiment, including multiple instances of the same analysis type.

e Click Save to save the analysis results as part of the experiment. See the next section
for general information about using the analysis window.
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3.2 Tips for Using Analysis-specific Sample Editors

When you add an analysis to a completed experiment, and the analysis is a type you have
not yet performed, an analysis-specific tab is automatically added to the Sample Editor.

However, you can manually add an analysis-specific tab to the Sample Editor, if desired.
For example, you might want to add an analysis-specific tab before running the
experiment and then enter both the general sample information and the analysis-specific
information while the experiment is running.

You can only add one analysis tab for any individual analysis type, per experiment.

3.2.1 Manually Adding an Analysis-specific Tab to the Sample Editor

To manually add an analysis-specific tab to the Sample Editor:

o Open the experiment you want to analyze.

e In the module bar, click Samples.

e In the Sample Editor toolbar, click Analysis Type, then select the analysis type from the
menu. Check marks indicate analysis tabs that have already been added to the
Sample Editor. The analysis-specific tab you selected is added to the Sample Editor
window.

Sample data

J Analysiz TypeF| Fieset & amples... ImE

[ v/ Abeolute [ uantification
LColor Compengation
Genotyping

MNucleic Acid Buartification |
Qualitative Detection

Rielative Quantification - Dual Calor

Relative Quantification - Manocalor

Im Calling

| I ] I ram

() Todelete an analysis-specific tab, clear the check mark next to the analysis type.
You cannot delete an analysis-specific tab if an analysis module of the same
type already exists.
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3.2.2 Copying Information in the Sample Editor

You can use the Auto Copy button to quickly copy sample information in an analysis-
specific Sample Editor. For example, if the same internal control is used for each sample
in a multicolor experiment, you can enter the information once, then use Auto Copy to
copy the information to the appropriate channel for each sample.

Auto Copy button

Sample data

|| Analysis Type = | Fieset Samoies . Imoon SAML
Capilary View Abs Quant | Tm Caling |
[ Enable Contiols Uit copiess |

Keep in mind the following restrictions when using Auto Copy:
® The Auto Copy button is available only for the analysis-specific Sample Editor tabs.

® You can copy only the information in the white cells of the sample editor; other cells
contain read-only information.

® You can copy information from multiple cells at one time, but the cells must be in the
same row; you cannot copy cells from multiple rows.
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To use Auto Copy:

o Open the analysis-specific tab of the Sample Editor.

Hold down the Shift key, then click and drag to select the cells you want to copy.
(Cells must be in the same row.) After you select cells, the Auto Copy button becomes
active.

e Click Auto Copy. The information from the selected cells is displayed at the top of the
Auto Copy dialog box.

Foz | Sample Mame | Charnel | Target Name
| 1 | Sample1 | 530 | Target1 |

Copy above cellz to each of the following

Channet:  [530 580 610 64| 670] 705

Samples [1-30) |29
Format: 1, 3, 5-9, 2532

ak I Cahicel

Select the channels you want to copy the information to.

Enter the sample positions to copy the information to, using any of the following for-
mats:

An individual sample number or multiple numbers separated by commas (1,3,5)

A sample number range, separated by a dash (1-5)

A sample number range from the beginning of the list to a particular number (-5)

A sample number range from a particular number to the end of the list (5-)

Any combination of the formats above

e Click OK.

You are warned that copying cell data may cause existing analysis modules to be
recalculated.

Click Yes to continue. (If you do not want to see the warning again, select Don’t ask
this question again.)

o The information is copied to the designated channels in the designated sample
positions.

Software
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3.3 Tips for Using the Analysis Window

The following figure illustrates a typical analysis window, in this case for an Absolute
Quantification analysis. A toolbar for the analysis is at the top, the list of experiment
samples is on the left, and the areas of the window containing analysis charts and notes
are on the right.

() Closing the Navigator expands the Work Pane.

Absolute Quantification
J Channel (640/530) = Calor Compensation = Frogam (2] 7

J tethod [auta) ~ Standard curve [In Aun) =

Samples Results =

Include | Color| Pos | Name CP | Conc(copies) | Standard Amplification Curves

05

045

= 04

2 035

2 0

-t

8 na2sq

5 0.2

£ 045

2 o1d
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0,05

o

2 4 B 810121416 18 20 22 24 26 25 30 32 34 36 35 40 42 44

Cycles

v

Standard Curve

™ E:E
4 3 E’ 244 \

= = B
2]
Statisics | Enor: 0,00314 Fom \
Samples | MeanCp | SWdCp | Meancone | Sideonc | i e T g 25

1,23 5 5] \
1,58 IEEE 051 2,25€0 2,21E0
7,89 ET) 043 8,310 3,090 & i 3 3 d
10,1112 372 0,08 1.06E2 5,87E0 Log Concentration
13,14,15 2836 017 546E2 1,012
16,17.18 2474 0.0z 5,533 12562 . L= =
19, 20,21 3183 02 5,921 1,35E1 Analysis Notes
22,23.24 #32 073 2,091 9,26E0
25, 26,27 034 021 1.76E2 247ET
28,29.30 2637 009 3.44E3 20462
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3.3.1 Selecting Channel, Color Compensation and Program

To perform an analysis you must specify the channel you want to analyze, apply color
compensation (if appropriate), and select the experiment program you want to analyze
(such as a melting curve).

Use the buttons on the analysis module toolbar, shown below, to make the necessary
selections. (The Nucleic Acid Quantification module and the Color Compensation
module have slightly different options. For more information, see the sections related to
these modules.)

|J Channel (640) ~ Color Compenzation = Program [2] -

If your user account has the Standard User role, this toolbar is not visible in the analysis
window because the selections have already been made for the analyses that you can view.

Use the buttons as follows:

Channel: Use Channel to select the fluorescence channel you want to
analyze.

Color Compensation: Use Color Compensation to select a color compensation object to
apply to the current analysis. For more information, see chapter
Using Color Compensation.

Program: Use Program to select the portion of the experiment (the
experiment program) to analyze.

Additional buttons may be displayed, depending on the analysis type.

3.3.2 Resizing Window Sections

To hide or display a section:

Click the handle [ = on the border. Click the handle again to redisplay
the section.

To resize an area:

Place the cursor over the section border until the cursor changes to a double-pointed
arrow.

Click and drag the border to the location you want.
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3.3.3  Working with Samples in the Analysis

An analysis module always displays a list of samples on the left. After analysis calculations
are complete, results for the samples are displayed in columns to the right of the sample
names. The analysis module also displays charts of sample data.

Selecting samples to include in result calculations

Select the check box next to a sample name to generate analysis results for the sample. By
default, all samples are checked at the beginning of an analysis. Double-click a sample’s
check box to deselect or reselect it. To check/uncheck a group of samples at one time,
highlight the range of samples, then press the spacebar. This toggles the check marks on
or off in all the selected sample boxes.

Selecting samples to view in charts

Samples are color-coded. To find a sample in a chart, note the color of the sample in the
sample list, then look for the same color on the chart. Or hold the mouse pointer over a
line on a chart to display a small box containing the name of the sample represented by
the line.

When you select a sample name (not the check box) in the sample list, data from the
selected sample is displayed in the analysis charts. By default, all samples are selected
when you first open the analysis window.

To select samples:

> To select one sample, click the sample name (not the check box) in the sample list.
> To select multiple samples, press Ctrl while clicking the sample names.

> To select a contiguous set of samples, click the first sample name, then press Shift while
clicking the last sample name in the set.

> To select all samples, press Ctrl A.

The analysis graphs are redrawn using the selected samples.

Copying sample information

After an analysis is complete, you can copy sample names and results from the analysis
window and paste the text into other software programs.

To copy sample names and results:

P> Select one or more sample rows to copy , then press Ctrl-C.

> Open the program into which you want to paste the copied text, then press Ctrl-V.
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3.3.4 Working with Charts
To zoom in on an analysis chart, place the cursor above and to the left of the area you
want to enlarge. Click and drag the mouse pointer down and to the right. The mouse

pointer draws a rectangle. The area within the rectangle is enlarged to fill the window.

To restore the chart to its original size, click and drag the mouse pointer up and to the
left. (Do this only once to restore the chart.)

3.3.5 Adding Analysis Notes

Many analysis modules include a small Analysis Notes section.

o If the Analysis Notes section is not visible, click the handle above
the Analysis Notes section heading to display the section.

o Type in the Analysis Notes section.

e Click Save on the LightCycIer® Software 4.05 toolbar to save the notes with the expe-
riment.

3.3.6 Removing or Renaming an Analysis

You can remove or rename analyses stored in your own user folder, if your user account
has the Expert User or Local Administrator role. You may also be able to remove or
rename analyses in other folders, depending on the access privileges associated with your
user account. For more information about access privileges see chapter Managing User
Access.

To remove an analysis module from an experiment:

° Right-click the analysis module icon in the module bar, then select Remove Analysis.
You are prompted to confirm your choice.

e Click Yesto remove the module.

e Click Save to save the experiment without the analysis.

You can rename the analysis icons associated with an experiment. Renaming is helpful if
you have more than one analysis of the same type associated with the experiment.

To rename an analysis icon:

o Right-click the icon in the module bar, then select Name.

e Enter a new name, then click OK.
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4. Performing Quantification Analyses

A quantification analysis can be performed on any experiment with an amplification
program. A quantification analysis uses sample “crossing points” to determine the
presence, the concentration, or the relative concentration of target DNA in unknown
samples after amplification. For information about crossing points see the next section.

For analysis of quantification data, a quantification module considers only fluorescence
values measured in the exponentially growing phase of the PCR amplification process.
This phase is termed the “log-linear” phase because the points making up this exponen-
tial curve are converted to a linear curve upon logarithmic plotting.

There are three types of quantification analysis:

Absolute Quantification:
Calculates the concentration of target DNA in unknown samples, based on the
concentration of standard samples.

Qualitative Detection:
Determines whether a target sequence is present in unknown samples.

Relative Quantification (Monocolor and Dual Color):
Compares the ratio of two DNA sequences in unknown samples to the ratio of the same
two sequences in a calibrator.

LightCycler” Software 4.05 also provides a Nucleic Acid Quantification analysis, which is
not based on PCR amplification and does not use sample crossing points to determine
concentration values, but represents a simple fluorimetric method to quantitate nucleic
acids e.g., in eluates after nucleic acid purification. For more information about Nucleic
Acid Quantification see chapter Performing a Nucleic Acid Quantification Analysis.

4.1 Understanding Sample Crossing Points

In an amplification reaction, the cycle at which the fluorescence of a sample rises above
the background fluorescence is called the “crossing point” of the sample. The crossing
point of a sample appears as a sharp upward curve on the experiment’s fluorescence
chart. The crossing point is the point at which amplified product is first visible in the
data.

A sample’s crossing point depends on the initial concentration of DNA in the sample. A
sample with a lower initial concentration of target DNA requires more amplification
cycles to reach the crossing point. A sample with a higher concentration requires fewer
cycles. How crossing point values are used in a quantification analysis depends on the
type of analysis.
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4.2 Understanding the Role of Standard Curves

In an Absolute Quantification or a Relative Quantification analysis, a standard curve is
used to determine the concentration or the relative concentration of unknown samples.
In a standard curve, the concentrations of standard samples are plotted against the
crossing points of the samples. The X axis of the standard curve represents the log of the
initial DNA concentration, and the Y axis represents crossing point in cycles. In general,
the higher the crossing point, the lower the initial concentration of DNA.

The following figure illustrates a standard curve generated by an Absolute Quantification
analysis. In this example, a sample with an initial DNA concentration of 10° units has a
crossing point of 30 amplification cycles. This means it requires 30 cycles for the initial
amount of DNA to be amplified to the point that it is visible above the background
fluorescence of the sample.

Standard Curve

ERE lIINES i”' T\\\
i gm- 5; Standard 10E3] \\\

The slope of the standard curve indicates how quickly DNA concentration can be
expected to increase with the amplification cycles. The slope of a standard curve is also
referred to as the efficiency of the curve. A perfect amplification reaction would produce a
standard curve with an efficiency of “2”, because the amount of target DNA would double
with each amplification cycle. In reality, reactions often have a lower efficiency. The curve
above has an efficiency of 1.897.

By determining where an unknown sample’s crossing point falls on the standard curve
the software can determine the initial concentration of target DNA in the sample.
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4.2.1 Providing the Standard Curve or Efficiency Value

To provide the standard curve for an Absolute Quantification analysis, you can:
P Include standards in the experiment

P Use a previously saved standard curve (called an external standard curve)

To provide the standard curve for a Relative Quantification analysis you can:

P Include standards in the experiment

P Use a previously saved standard curve (called an external standard curve)

> Specify an efficiency value of “2”

If you use an external standard curve the used data or value must be generated using
the same channel settings, analysis method (for Absolute Quantification),
concentration units, and color compensation data (if any), as the experiment you
want to analyze. For more information, see the specific analysis sections in the rest of
this chapter. For information about saving standard curves for use in other
experiments see the following section.

4.2.2  Saving a Standard Curve

This section explains how to generate and save a standard curve as an extra object so the
curve can be used for other Absolute Quantification analyses.

To save a standard curve:

o Perform an amplification experiment containing the standards you want or use an
existing experiment that includes standards you want to use.

The experiment containing the standards must use the same parameters and
conditions as the experiment to which the curve will be applied, including: the
same fluorescence channels, concentration units, analysis mode, and color
compensation data (for multicolor experiments).

(. You can generate several standard curve files from one experiment by choosing
o different signal channels or analysis modes each time you save the standard
curve.

Add an Absolute Quantification analysis module to the experiment.

In the Abs Quant tab of the Sample Editor, select Standard as the sample type for each
standard sample and specify the sample concentration.

° In the analysis module perform either a Fit Points or an Automated analysis. Select the
check boxes of the standard samples you want to use in the standard curve. See the
next section for detailed information about performing an Absolute Quantification
analysis.

e From the Standard Curve menu, select Save as external...

e Navigate to a location to save the curve, enter a file name, then click OK.

You can use the standard curve in other quantification analyses for experiments that have
the same experiment parameters such as this standard curve.
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4.3 Performing Absolute Quantification Analysis

An Absolute Quantification analysis determines the concentration of target DNA in
unknown samples.

There are two Absolute Quantification analysis methods: Automated (the default) and Fit
Points. The algorithm for the Fit Point method is identical to the corresponding
algorithm in LightCycler” Software Version 3.5, the algorithm for the Automated method
is improved. Both methods use standard curves to calculate unknown sample
concentrations, but each method determines a sample’s crossing point a different way.

4.3.1 Understanding the Automated Method

The Automated method identifies the crossing point of a sample as the point where the
sample’s fluorescence curve turns sharply upward. This turning point corresponds to the
first maximum of the second derivative of the curve.

The Automated method requires little user input. You must determine how to provide
the standard curve for the experiment; the software handles all other analysis
calculations.

To handle complex fluorescence data curves, the software copes with effects and artifacts
such as spikes in the log-linear phase of the curve, noisy plateaus, or curves where the
plateau phase has not yet been reached. Additionally, no crossing point values are
displayed for curves with a slowly increasing, decreasing, or noisy background, unless the
curves reach considerable values of fluorescence.

If desired, you can include internal controls in the analysis to help ensure that samples
have not been contaminated and that the reaction is performing as it should. For more
information see Using the Automated Method with Controls, below.
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4.3.2 Fit Points Method

The Fit Points method converts a sample’s exponential curve to a straight line (a linear
curve). The beginning of the line is extended downward until it intersects a horizontal
line called the crossing line. The intersection of these two lines is defined as the sample’s
crossing point. The software uses the calculated crossing points of the standard samples
to generate the standard curve of crossing point versus sample concentration.

Crossing line

o

Crossing point

The Fit Points method requires you to perform most of the analysis steps manually. You
must adjust all sample curves so that each sample starts with the same baseline
fluorescence, then you must eliminate background fluorescence from the data. You
choose the number of data points used to generate the linear curves for the samples and
adjust the crossing line.

You cannot use internal controls with the Fit Points method.
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4.3.3 Comparison of the Two Methods

The following table describes the features and benefits of each Absolute Quantification
method.

Features

Software
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4.3.4

Using the Automated Method

To perform the analysis using the automated method:

Using LightCycIer® Software 4.05, create and run a quantification experiment or open
an existing experiment.

Click Analysis on the main toolbar.

Select Absolute Quantification, then click OK.

In the Sample Editor, enter general sample information on the Capillary View tab, and
select the channels used in the experiment.

On the Abs Quant tab of the Sample Editor, enter sample information as follows:

Column Name  Valid Values Description

Target Name Any name Name of the target for this channel

Sample Type Unknown Type of sample in this capillary
Standard

Concentration Any concentration value | Concentration of a standard sample.

Click Abs Quant in the module bar to open the analysis module.

If this is a multiplexed experiment, from the Channel menu select the channel for the
targets you want to analyze.

From the Program menu, select a quantification program in the experiment
(typically there is only one quantification program, which is selected by default).

o 0 00

If you included standards in the experiment, select the check box next to each
standard you want to include in the standard curve. (Double-click the box to select or
clear it) If you did not include standards in the experiment, from the Standard curve
menu, select Use external. Find and select the standard curve you want to use, then
click OK.
@ The external curve must be from an experiment that has the same channel,
mode, and color compensation settings as the current experiment.
If you want to use an external standard, you must include one of the standard
concentrations in the new experiment as a reference.
The software calculates the concentration for each sample in the sample list,
based on where each sample’s crossing point correlates to the standard curve.

By default all samples are included in result calculations; to remove a sample from
result calculations, double-click the checkbox next to the sample name to clear the
checkbox or press the space key.

To view amplification curves for one ore more samples, highlight the sample names in
the sample list.
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@ To view analysis results, click and drag the left border of the chart section to the right
to display all the result data. Results include the following:

Result Description

CP The crossing point of the sample.

The calculated concentration of the sample, based on where its
crossing point lies on a standard curve of crossing points vs.
concentration.

Conc (copies)

Standard The concentration of a standard sample; this value is specified
in the Abs Quant tab of the Sample Editor.

@ Appended to the sample list view the following group results and statistics are given:

Samples The sample numbers in the replicate group.

Mean Cp The mean of the crossing points for the samples in the group.
STD Cp Standard deviation of the crossing points.

Mean conc The mean of the concentrations for the samples in the group.
STD conc Standard deviation of the concentrations.

An Absolute Quantification analysis is shown below. Results are calculated for the eight
samples that are checked in the sample list. Sample curves are displayed for the 15
samples that are highlighted in dark blue. The standard curve is generated from the
samples that are checked and that are labeled Standards in the Sample Editor.

& LightCycler Software 4.05 - [Demo Absolute Quantification] =18] x|

=18 x]|

7 File Edit View Tocks MWindow Help
17 13 hew Z3Run. {ZAnalysis.. | £30pen. & save @bt | Template.. % RunMacio

_ Absolute Quantification
| Channel (540/530) = Color Compensation = Progrem (2] ~ |J Method [buto) ~ Standard curve (In Run) ~

Samples [ Results [4]
Incl...| Color | Pos | Name CF | Conccopies) | Standard
[19.41]  [355EH]

Amplification Curves

EEEREEERER

Fluorescence (640/530)
o
n
B

i 2 4 6 8 10121416 18 20 22 24 26 28 30 32 34 36 35 40 42 44
Standand 5 e

Repl. of Standard & ST
18 Repl of Standard § 1.00E4
19 Sample 1 3208 2031 H S (o
B A S o
Statistics | =
| MeanCp | STDCp | Meanconc | STDeconc | S 34
Enor, 0,00203 B
335 0.02 1.00E0 3692 Eliceci i g
.21 022 10ET 1.56E0 53
N oot 985E1 .78E1 8
826 00 101E3 231 i 7 T T
I 022 954ET 13260 e C ot i
.32 073 1.96E1 881E0
094 021 17262 24561
2637 0,03 353E3 2142 Analysis Motes




Performing Quantification Analyses
Performing Absolute Quantification Analysis

Using the automated method with controls

If you use the Automated method, you can include negative, positive, and internal
controls in the quantification experiment to help ensure that samples have not been
contaminated and that the reaction is performing as it should.

How a negative control is used

A negative control does not contain the target DNA sequence. It is an external control
because it is located in a separate capillary from the unknown samples. The negative
control must show no amplification.

How a positive control is used

A positive control contains a known concentration of the target DNA sequence. It is an
external control because it is located in a separate capillary from the unknown samples.
The positive control should show amplification characteristic of the target DNA
sequence.

You can specify the concentration range expected for the positive control. In this case, the
unknown samples can be called positive or negative only if the positive control’s
calculated concentration falls within its expected range.

The concentration range helps to ensure that the correct standard curve has been applied
to the experiment. If the experiment results show that the positive control’s calculated
concentration is outside its expected range, then the wrong standard curve may have
been applied to the experiment or the standards are not behaving as expected.

If you do not specify a concentration range for the positive control, the control only
needs to be positive for a valid run.

How an internal control is used

An internal control is a positive control located in the same capillary as the unknown to
which it applies. An internal control is a known DNA sequence, different from the target
DNA, that you expect to amplify in a predictable way.

You can specify an expected crossing point range for the internal control. In this case, the
associated unknown sample can be called negative only if the internal control is within its
expected range. If the internal control performs as expected, it indicates that the reaction
in the capillary proceeded correctly.

If you do not specify a crossing point range for the internal control, and the unknown

sample is negative, the run will be considered valid if the internal control has any positive
crossing point value.
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To perform an analysis using controls:

o Follow steps 1-4 in the procedure for an Automated analysis, above.

e Select Enable Controls on the Abs Quant tab of the Sample Editor.

e Enter sample information as described in step 5 in the procedure for an Automated
analysis, above, then enter the Cp Low and Cp High information for standards and
internal controls or Conc Low and Conc High information for positive controls as

follows:

Valid Values

Column Name Description

Cp Low

The low end of the range in
which this sample’s crossing
point is expected to occur. (For
standards or internal controls.)

A crossing point expressed in
number of cycles.

Cp High

The high end of the range in
which this sample’s crossing
point is expected to occur. (For
standards or internal controls.)

A crossing point expressed in
number of cycles.

Conc Low

The low end of the range in
which this sample’s concentra-
tion is expected to occur. (For
positive controls only.)

A concentration expressed e.g.,
in the number of copies.

Conc High

The high end of the range in
which this sample’s concentra-
tion is expected to occur. (For
positive controls only.)

A concentration expressed e.g.,
in the number of copies.

o Follow steps 6-11 in the procedure for an Automated analysis, above. In the analysis
module, be sure to select the channel for the unknown target you want to analyze.
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e To view analysis results, click and drag the left border of the chart section to the right
to display all the result data. For an explanation of results, see step 12 in the
procedure for an Automated analysis, above.

In addition to the results for a standard Automated analysis, a Calls section is added
to the results. The Calls section includes the following:

Combined The sample’s result, based on both the sample’s own call and the
control calls.

Possible results for unknown samples:

Positive: The sample’s call is positive and all relevant controls
behaved as expected.

Negative: The sample’s call is negative and all relevant controls
behaved as expected.

Uncertain: The sample's amplification cannot be determined,
perhaps because the amplification curve is not
consistent or typical. All relevant controls behaved
as expected.

Invalid: At least one relevant control did not behave as expected.

Possible results for control samples:
Success: All relevant controls behaved as expected.
Failure: At least one relevant control did not behave as expected.

The result for the sample alone. The Call is based on whether
amplification is detected for the sample.

Positive:  The sample shows amplification.

Negative: The sample does not show amplification.

Uncertain: The sample’s amplification cannot be determined,
perhaps because the amplification curve is not
consistent or typical.

The success or failure of a control sample.

Success: All controls related to this sample behaved as
expected.

Failure:  One or more controls related to this sample behaved
not as expected.
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Using the Fit Points Method

The Fit Points method requires you to manually perform most of the analysis steps. For
information about key steps, see the sections that follow the procedure.

To perform the analysis using the Fit Points method:

Add an Absolute Quantification analysis. Specify analysis-specific sample information

and define or import standards as described under Using the Automated method,

above.

@ You cannot use internal controls with the Fit Points method. To use Fit Points
make sure, that the Enable control checkbox in the Abs Quant tab of the
Sample Editor is deselected.

If this is a multiplexed experiment, from the Channel menu in the analysis module,
select the channel you want to analyze.

From the Program menu, select a quantification program in the experiment
(if there is only one quantification program, it is selected by default).

From the Method menu, select Fit Points.

J Method [F.P.] F Standard curve [In Run] -
Step 1: Backy Automated [F* max] i Step 3 Analysiz

— ® Fit Points
J Fit Points [=r—rmrmmeeemor—rrm==hald: |-1,58EU

aranm [£] *

Click the sample names to highlight the samples you want to analyze.

Select the Step 1: Background tab to view the amplification curves for the selected
samples. By default, the curves are corrected so that the initial, or background,
fluorescence is the same for all the samples.

(Optional) To remove the background correction from the curves, from the Back-
ground menu, select None. For more information see Specifying a background
adjustment, below.

Select the Step 2: Noise Band tab. The jagged lines at the beginning of the curves
represent noise.

0 06 © 00

To eliminate the noise from the samples, adjust the noise band any of these ways:

> Drag the red horizontal noise band up or down to exclude the noise.

P Enter a location in the Noiseband: box (above the chart) to place the noise band.

> Click Automatic from the Noiseband method pull down menu to let LightCycIer®
Software 4.05 adjust the noise band.

> For more information see Setting the noise band, below.

o

Select the Step 3: Analysis tab.
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Q Select the check boxes for the standard samples you want to include in the
standard curve and for all the unknown samples for which you want to calculate
concentrations. (Double-click a check box to either select or deselect it.)

@ From the Fit Points menu, select the number of data points (the “fit points™) used to
generate the log-linear curves for the samples. To view the fit points, from the Fit
Points menu, select Show.
For more information see Selecting the fit points, below.

@ To determine the crossing threshold for the samples, adjust the crossing line any
of these ways:
»Drag the red horizontal crossing line up or down.
»Enter a location in the Threshold box (above the chart) to place the crossing line.
»-Click Minimize Error to let LightCycIer® Software 4.05 adjust the crossing line.
»For more information see Adjusting the Crossing Line, below.
The software generates results for the checked samples.

@ Click and drag the left border of the chart section to the right to display all the
analysis results. Read the calculated concentrations of the unknown samples from
the appropriate column in the sample list. For more information see Viewing results,
below.

Specifying a background adjustment

Background fluorescence may vary from sample to sample for several reasons, including
differences in sample preparation, differences in DNA content from capillary to capillary,
or pipetting errors.

The Fit Points method automatically adjusts the background fluorescence for all the
samples to a comparable level using the arithmetic method. With this method, the mean
value of the 2nd to 6th measured data point for each sample is calculated, then subtracted
from each data point.

If you want to view the samples without background adjustment, select None from the
Background menu on the Step 1: Background tab.
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Setting the noise band

The Step 2 Noise Band tab displays two graphs. The upper graph shows Fluorescence vs.
Cycle Number. The graph contains a red horizontal line (the noise band) to delineate the
background noise. The lower graph shows the same curves with the background noise
eliminated.

Move the noise band to a position, as low as possible, but as high as necessary, where it
clearly crosses all sample curves in the lower part of the log-linear phase, as shown in the
screen below.

Only data points above the Noise Band are considered for analysis. Data that fall below
the noise band are excluded from analysis.
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Selecting the fit points

The software converts the slope of each curve into a log-linear curve (a straight line).

In the Fit points box, specify the number of data points used to calculate the line. Select a
limited number of points so that all the points are located on the linear portion of the
curve. Begin by selecting 3 or 4 points and then increase the number. More points are
better, as long as none of the points are located outside the linear portion of the curve.
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Adjusting the crossing line

When the software calculates the log-linear lines for each standard sample, it extends the
lines so they intersect with a horizontal line called the crossing line. The intersection of
each log-linear line with the crossing line represents the crossing point for the sample.

In many cases, the default position of the crossing line is sufficient for quantification. In
some cases, you can slightly improve the standard curve error value by manually moving
the crossing line up or down. To have the software automatically adjust the crossing line,
click Minimize Error.

Viewing results

The software generates a standard curve using all the samples that are labeled as Standard
in the Sample Editor and that are also checked in the sample list of the analysis module.

Based on the standard curve, the software determines the concentrations of unknown
samples. Calculated sample concentrations and crossing points are displayed in the result
columns in the analysis module. Only samples with check marks in the sample list are
included in the analysis results.
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4.4 Performing Relative Quantification Analysis

A Relative Quantification analysis compares two ratios: 1) the ratio of a target DNA
sequence to a reference DNA sequence in an unknown sample, and 2) the ratio of the
same two sequences in a standard sample called a “calibrator”. The calibrator contains a
"typical” ratio of the target and reference sequences, against which the target-to-reference
ratio in the unknown sample can be compared. The result is expressed as a normalized
ratio, i.e. ratio (1) divided by ratio (2).

A Relative Quantification analysis can be performed on an experiment that has an ampli-
fication program and that has the appropriate sample types. You can perform a relative
quantification analysis on a single channel experiment (Relative Quantification-Mono-
color) or on a multichannel experiment (Relative Quantification-Dual Color). If you
perform a dual-color experiment, each pair of target and reference samples must be in
the same capillary.

A Relative Quantification analysis is based on the assumption that the concentration of
DNA at a sample’s crossing point is the same for every sample containing the same target
DNA. This is the DNA concentration necessary for the LightCycler” fluorimeter to detect
a signal above the background noise.

Each sample may require a different number of cycles to reach the crossing point,
depending on the initial concentration of DNA in the sample. At the end of the experi-
ment, each sample’s DNA concentration may vary, depending on how many cycles were
completed by that sample after the crossing point was reached.

The analysis uses the sample’s crossing point (expressed as a cycle number), the efficiency
of the reaction, the number of cycles completed, and other values to determine how
much the DNA concentration must have increased for each sample by the end of the
amplification. The analysis uses these calculations to compare the samples and generate
the ratios. The analysis does not determine the actual concentration of DNA in the
samples.

When you perform the analysis, you provide an efficiency value for the reaction by
importing a standard curve, including standards in the experiment to determine the
efficiency value, or simply specifying an efficiency value.

You can specify crossing point ranges for calibrators. If a calibrator sample’s crossing
point is outside the specified range, then a message is displayed that the control failed.
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The screen for a Monocolor Relative Quantification analysis is shown below.
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The window displays two main tabs:
Groupl Contains four subtabs (Target, Reference, Pairing, Results), used to define the

analysis sets and view results. You can add additional Group tabs, if needed.
Each Group tab functions as a separate analysis. The results from each group
tab can be viewed together on the Summary tab.

Summary Contains two subtabs that summarize results. One subtab lists a summary of
all results sets in each group, the other subtab organizes the result sets across
groups (if you used more than one Group tab). For more information see
Viewing results, below.

You perform all the Relative Quantification analysis work in a Group tab, using the four
subtabs as follows:

Target Use the Target subtab to select target samples to include in the analysis and to
determine the efficiency value for the target samples.

Reference  Use the Reference subtab to select reference samples to include in the analysis
and to determine the efficiency value for the reference samples. You can
import reference information from another experiment, if desired.

Pairing Use the Pairing subtab to select an unknown target/reference pair and a
calibrator target/reference pair. The four samples together form a result set.

Results Use the results subtab to view results for each result set. For each set, the
software compares the ratio of the unknown target/reference pair to the ratio
of the calibrator target/reference pair.

Software
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4.41

Performing a Relative Quantification-Monocolor Analysis

Before you perform a Relative Quantification-Monocolor analysis, you must decide the
following:

P Whether to include the reference samples in the experiment or to run a separate
experiment to amplify the references

> How to provide the efficiency value for the targets and for the references:

By including standards in the current experiment to generate a standard curve

By importing a standard curve (or COF standard curve file when using a
corresponding Roche kit)

By specifying an efficiency value of 2 (the only efficiency value that can be specified
directly)

To perform a Monocolor Relative Quantification analysis, follow the general steps below.
Key steps are described in detail in the sections that follow the procedure.

If reference samples are to be amplified in a separate experiment, perform the
reference experiment.

Perform the relative quantification experiment containing the target samples.

Enter sample information. (This experiment must also contain the reference samples
if you did not perform a separate reference experiment.) For more information see
Performing the relative quantification experiment, below.

Add the Relative Quantification-Monocolor analysis module to the target experiment.
If reference samples are defined in a separate experiment, select the reference
experiment when prompted.

On the Target tab of the analysis module, specify the target efficiency and select
the target samples (both unknowns and calibrators) you want to analyze. For more
information see Setting target efficiency and selecting targets, below.

On the Reference tab, specify the reference efficiency and select the reference
samples you want to analyze. For more information see Setting reference efficiency
and selecting references, below.

On the Pairing tab, select the sets of samples to be compared. For each set, select one
unknown target and reference pair and one calibrator target and reference pair.
For more information see Pairing the samples, below.

On the Results tab, view the results for each result set. For more information see
Viewing results, below.

© 0 o 0 o6 o

To perform an additional analysis, from the Group menu, select Add Group. Perform
the analysis as described in the previous steps. View combined results for all groups
on the Summary tab. For more information see Viewing results, below.
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Performing a reference experiment

Perform an amplification experiment to amplify the reference samples. Include
unknown and calibrator samples in the experiment.

You can also include reference negatives and standards, if desired. (Or you can
choose to specify standard curve or efficiency for the reference when you perform
the relative quantification experiment.)

Select the Samples module, and enter general sample information in the Capillary
View tab.

From the Analysis Types menu, select Relative Quantification - Monocolor.

In the Rel Quant Mono tab of the Samples module:

Enter a target name for each sample, if desired.

Specify the sample type for each sample: reference unknown, reference calibrator,
reference negative, or reference standard.

Specify the concentration value for each reference standard.

00 0060 O

Click Save, navigate to a location to save the experiment, enter an experiment name,
then click Save.
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Performing the relative quantification experiment

The relative quantification experiment is an amplification experiment containing the
target unknowns, calibrators, negatives, and standards (if any). If you did not perform a
separate reference experiment, then the relative quantification experiment must also
include the reference samples. Follow the steps below to define the samples for the
experiment and to add the Relative Quantification — Monocolor analysis module to the
experiment.

To perform a relative quantification experiment:

Perform an amplification experiment to amplify the target samples. If there is no
separate reference experiment, include the reference samples in the experiment.

Click Samples in the module bar, then from the Analysis Types menu, select Relative
Quantification - Monocolor.

e Enter sample types and concentrations, as follows:

Column Name Description Valid Values

Sample Type Type of sample Target Unknown
Target Calibrator
Target Standard
Target Negative

Reference Unknown
Reference Calibrator
Reference Standard
Reference Negative

Conc. Concentration of a standard sample. | Concentration value
This field is active only when the
sample type is Standard.

Specify the reference sample types only if you did not perform a separate reference
experiment.

° Click Analysis on the main LightCycIer® Software 4.05 toolbar.

In the Create New Analysis dialog box, select Relative Quantification-Monocolor,
then click OK.

If you did not specify reference samples in the Samples module, a message prompts
you to select a reference experiment. Click OK to clear the message.

Select the reference experiment, then click OK The imported reference samples are
added to the Reference tab of the analysis module.
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Setting target efficiency and selecting targets

If you specified target standards in the Samples module, the standards are used to
generate a standard curve, displayed in the lower chart of the Target tab. You can use this
standard curve, import an external standard curve, or specify an efficiency value of 2.

If you did not specify target standards, then the target standards area is gray and displays
the message “No Standard Data” In this case, you must import a standard curve or
specify an efficiency value.

An example of a standard curve is shown below.

s LightCycler Software 4.05 - [Demo Rel Quant Standards (monocolor)] 1= x|
[@Fle Edt View Tools Window Help -8 x|

1H 23 New % Run {gAnaysis . | £30pen & 3ave @Fepot | [ Template . 54 RunMacra

Relative Quantification - Monocolor

Group 1 | Surnmany |

{TaEel | Reference | Paiing | Resuls |

| Channel (640/530) = Color Compensation = Frogiam (1)~ Standerd (in fur) - | Group - |

Samples | B )
Ins | Color | Pos | Name | Type | Standard | Cp VeSS LTl Bros
¥ B 1 NICTaget Negativ i
0 M 2 Std7Taget Standar  1.00ED 'm-
] B 3 ReplofSd1Tagst  Standar 1,00E0 '
] B % ReplofSidlTaget  Standar 1.00E0 PO
B 5 SH2Tage Standar 100E-1 2475 E 0,08
¥ B 6 ReplofStd2Tagst  Standar 100E- 2484 § 007
| B 7 FeploiSW2Taget  Standsr 100E4 2487 2 06
¥ B 8 Sd3Teget Stendar 1.00E-2 28,02 g oos]
M 9 ReplofSW3Taget  Standar 100E2 2776 § ool
B 10 ReplofSd3Tamget  Standar 1.00E2 2810 3 e
B 11 SiddTaget Stendar 1.00E-3 3183 Y 2 ulu2—
B 12 ReplolSd4Taget  Standar 100E3 3145 !
¥ B 13 ReplofSd4Tamet  Standar T00E3 3152 oo
[¥] B 14 S5 Taget Standar 1.00E-4 3450 o
] 15 ReplofS5Taget  Standar 100E4 3429 P (i I
E B 16 Repl of S5 Target Standar 1.00E-4 3349 |4 2 4 6 B 1012 14 16 16 20 22 24 26 28 30 32 34 36 36 40 42 44
Cycles

Standard Curve

E 35]
5
<
Enor: 0,0431 230
Efficiency: 1,375 i
& 25]

4 k] E Ei
. 5] Log Concentration
Type | Date | Time |Message
& Front sereen /& Demo Rel Quant St...
|Logged on ko LocalExors as System Admin Research
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To set target efficiency and select targets:

o On the Target tab click Channel, then select the channel to be analyzed.

e Drag the border on the right side of the samples list to the right, to display the type
column.

e If you included target standards in the experiment, select the check box next to each
standard you want to include in the standard curve. Double-click the check boxes to
select or deselect them. If you do not want to use standards from the experiment,
click Standard in the menu bar.

Standard [In Fun) F | Group -
| Set efficiency = 2
Uze inrun
|Jze extemnal. .
Save az external ..

From the standard menu, select one of the following:

Set Efficiency =2  Select this option to use an efficiency value of 2 in analysis
calculations. No standard curve is needed.

Use in run Use this option to use the standard curve generated from
standards in the current experiment.
Use external ... Use this option to import a previously saved standard curve or

COF standard curve file.

The curve must have been created from an experiment that
has the same channel settings and color compensation data
(if any) as the current experiment.

(Select Save as external... if you would like to save the current standard curve for use
with other experiments.)

0 In the Samples list, select the check boxes of the target samples you want to make
available for result sets. Double-click the check boxes to select or deselect them.
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Setting reference efficiency and selecting references

If you specified reference standards in the Samples module or in an imported reference
experiment, the standards are used to generate a standard curve, displayed in the lower
chart of the Reference tab. You can use this standard curve, import an external standard
curve, or specify an efficiency value of 2.

If you did not specify reference standards, then the target standards area is gray and
displays the message “No Standard Data”. In this case, you must import a standard curve
or specify an efficiency value.

To set reference efficiency and select references:

On the Reference tab click Channel, then select the channel to be analyzed.

Drag the border on the right side of the samples list to the right, to display the type
column.

If you included reference standards in the experiment, select the check box next to
each standard you want to include in the standard curve. Double-click the check
boxes to select or deselect them or if you do not want to use standards from the
experiment, click Standard in the menu bar.

Standard [In Run) F Samples - |
] Set efficiency = 2
Uze in wn
Jse external...
Save az external...

From the standard menu, select one of the following:

Set Efficiency =2 Select this option to use an efficiency value of 2 in analysis
calculations. No standard curve is needed.

Use in run Use this option to use the standard curve generated from
standards in the current experiment.
Use external ...  Use this option to import a previously saved standard curve or

COF standard curve file.

The curve must have been created from an experiment that has
the same channel settings and color compensation data (if any) as
the current experiment.

(Select Save as external... if you would like to save the current standard curve for use
with other experiments.)

In the Samples list, select the check boxes of the reference samples you want to make
available for result sets. Double-click the check boxes to select or deselect them.
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Saving and selecting COF standard curve files

When using a Roche kit designed for Relative Quantification you need to import the cor-
responding COF (coefficient) standard curve file for performing a Relative Quantifica-
tion analysis. The COF file includes the lot-specific target and reference standard curve as
well as the Correction and Multiplication factors.

To save and select COF standard curve files:

° Download the COF file and save it locally. Information about where you go to
download the COF file is provided in the documents that accompany the kit.

In the File menu select Import and then COF Std. Curve Files.

Find and select the file you want, and then click Open. The file is imported and ope-
ned in the work pane.

To save the imported COF file as an object in the current LightCycIer® 4.05 database
click Save.

Navigate to a location in LightCycIer® Software 4.05 to save the object, enter a new
object name (or keep the existing name), then click OK.

© 0 6 00

To use the COF file in the current experiment, from the Standard menu select Use
external..., then select the object you want to use.

& celect Object ' =18 x|
Name | Creation Date | Last Modified |
Std Object [Reference] for Demo Rel Quant [maonocolor) 08.08.2003 05.1E.2004

Std Object [T arget] for Dema Fiel Quant [monocolor] 08.08.2003

05.16.2004
[12.03. 2005

tCOF Std. Curve File [02.03. 2005

ak. I Cancel

You cannot enter the Fit Coefficients manually
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Pairing the samples

Use the Pairing tab to form result sets consisting of an unknown target and reference and
a calibrator target and reference. The Pairing tab is shown below with three result sets.

Relative Quantification - Menocolor

Group 1 | Summany |
Taiget| Reference Paiing |F\esulls|
|J Add Set Delete Set Clear Sets  Comection Factar  Multiplication Factor  Wiew Chart | Group ~ ‘
Result Sets Samples
5 Targets References
Fiesult Set 2 Position | Mame: Cp Position | Name Cp
Result Set 3 17.18 [Brain T arget 40ng 2482 19,20 [brain HK 40ng 2023
21,22 |brain,Target 8ng 26,48 23,24 |brain HK 8ng 3252
26,26 |brain, Target 1.6ng 2710 27,28 |brainHK 1.6ng 449
o
[
o
S|
Calibrator Targets Calibrator References
Pasilion | Mame | Ep || Posiion [MName | Co
1,2 | Calibrator, Target | 533 3,4 |Calibrator Houskeeping [EEE

To create result sets:

o Select the Pairing tab. The unknown targets and references are listed in the upper
panes, the calibrator targets and references are listed in the lower panes.

In the upper panes, select the unknown target and unknown reference that form a
pair. In the lower panes, select the calibrator target and calibrator reference that form
a pair.

In the menu bar, click Add Set. The set is added to the list of Result Sets on the left.

To apply a correction factor to the result sets, press the button Correction Factor in
the upper line of the tab, then type the new value. The correction factor is entered
automatically after import of a COF standard curve file. The correction factor adjusts
results for any lot-to-lot variations in kit chemistry.

To apply a multiplication factor to the result, press the button Multiplication Factor in
the upper line of the tab, then type the new value. The multiplicaton factor is entered
automatically after import of a COF standard curve file.The normalized ratio is
multiplied by this value before the result is displayed on the Results tab.

Create other results sets, as needed.

00

To view graphs for the samples in a result set, select the result set, then click View
Chart.

Software
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Viewing results

You can view results for each group on the group’s Results tab. You can view results for all
groups on the Summary tabs.

To view results on the Results tab:

0 Select the Resulis tab to view detailed results for each result set in the group.

e The Results tab is shown below.

Relative Quantification - Monocolor

Group 1 | Summany |

Target| Reference | Paiing Restits |

| Growp -

Set | Sampe Type | Pos_|Sample Name | Cp Median | Concentration Ratio | _Nomalized Ratio_| Multploation/Con
Tarae Calbrator T3 Calbrator, Target EEE TiEs T
Fleference Calbrator 3,4 Caibrator Houskesping 072

Rlesult et 1 Target Unknown 17,18 Brain.T arget dling 2482 12281 [4.78] 1"
Reference Unknown 19,20 biainHK. 40ng 029

FesulSet?  Terget Unknown 21,22 brain Terget ng %648 103 150 "
Reference Unknown 23,24 brain HK Bng 252

Resul Set3  Target inkrown 2528 basin Taiget 1 6ng 2710 157 229 "
Reference Unknown 27,28 brainHK. 1.6ng 3449

For each set, the tab displays sample types, positions, names, the crossing points for each
sample, the ratios of targets to references, and the normalized ratio of the unknown pair
with the calibrator pair.

If one or more controls fail, the tab lists the failed controls, as shown below. For each
failed control, the tab displays the sample number, name, and the sample result (positive,
negative, or indeterminate).

Relative Quantification - Monocolor

Group 1 | Summar_l,ll

Targetl FIeferenc:eI Pairing | Hesult |

J Group -

Megative Contral Failed

Target Megatives
5 Meg Control Target Positive
E Fepl. of Meg Contral Target  Positive
Reference Megatives
Meg Control Reference Positive
g Fepl. of Neg Control Reference Poszitive
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To view results on the Summary tab:

o Select the Summary tab.

e Select the Separate subtab (shown below) to see result sets listed by group.

Relative Quantification - Monocolor

Group 1| Group 2 Summary |

{Bepareie ] Combined |

For each result set, the tab displays

® Sample
® Calibrator
® Normalized

Group 1 Ratios Group 2 Ralios

I Samplal Eallhramrl Nnrmahzedl | Samplal Eallhralnrl Nnrmahzedl
Fiesult Set 1 [31.38] [1.591 [15.75] Fiesult Set 1 [1.97E2] [1.391 [38.77]
Fiesult Set 2 [1.85] [1.591 [0.53] Fiesult Set 2 [9.38] [1.591 [4.71]
Fiesult Set 3 [1.65] [1.591 [0.831

The ratio of the target/reference pairs
The ratio of the calibrator target/reference pairs
The normalized ratio of the two pairs

e Select the Combined subtab to see the results for all groups together. The Combined
tab allows you to compare results for result sets across groups. The results for Result
Set 1 (from all groups) are displayed on the first line, the results for Result Set 2
(for all groups) on the second line, and so on, as shown below.

Relative Quantification - Monocolor

Group 1 | Group 2 Summary I

Separate | Combined |

| Group 1 Ratios Group 2 Ratios |

| Sample] Cafibrstor] Momalized| Sample] Calibrstor] Momalized|
Result Set 1 3138 118 (1578 [LA7E2l (.83 [98.77]
Result Set 2 res 1.9 10.33] kel I | 14711
ResultSet 3 [es s 10,631
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4.4.2  Performing a Relative Quantification—Dual Color Analysis

Relative Quantification-Dual Color requires a multicolor reaction in which each target/
reference pair are in the same capillary. The targets and references are measured by
different fluorescence channels.

Before performing a Relative Quantification-Dual Color analysis, read the previous
sections to understand how to perform a Relative Quantification-Monocolor analysis.
The processes are similar. Follow the same general steps as for a Monocolor analysis, but
with these differences:

In the Rel Quant Dual tab of the Sample Editor, specify a sample type for each sample
in each channel. Target and reference samples must be in the same capillary.

Perform the quantification experiment as a multiplexed experiment, with target/
reference pairs in the same capillaries.

When you add the analysis module, select Relative Quantification—Dual Color. When
you open the analysis module, note that the target and reference information is
combined on one tab, the Target/Reference tab.

On the Target/Reference tab of the analysis module:
In the menu bar, click Target Channel, then select the channel with target data.
Click Reference Channel, then select the channel with reference data.
Click Chart, then select which data to display in the charts on that tab (targets,
references, or both).
Specify the efficiency by using standards from within the experiment, importing a
standard curve, or specifying an efficiency of 2. The efficiency applies to both the
target and the reference samples.

The Target/Reference tab is shown below.

Group 1 | Summry |

Target/Reference | Paiiing | Results |

J Target Channel [E40/Back 530) ~ Reference Channel [705/Back 530) ~ Color Compensation [On] ~ Frogam (1] ~ Standad [ENF 2] = Chart '| Group =

Senpls
I | Calor | Pos | Name | Standard | Target Cp| Reference Cp

Amplification Gurves

Fluorescence (6408 ack 530, 705/Back 530)

2 4 6 010121415 18 20 22 24 26 29 30 32 34 36 30 40 42 44
Cycles

Efficiency: 2.0

(h el f<fefeffafef<fehafcfaf<fafefafcfcf<hedaf<f<f<fefa]<]

<
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» On the Pairing tab, select two samples for each result set (an unknown sample and a
calibrator sample); each sample contains both a target and a reference. The Pairing tab
is shown below.

Relative Quantification - Dual Color

Result Set 2
Flesult Set 3
Fesult Set 4
Result Set &
Result Set 6
Fesult Set 7
Result Set 8
Result Set 3
Flesult Set 10
Result Set 11
Result Set 12
Flesult Set 13
Result Set 14
Result Set 16

Software
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P View results on the Results tab and the Summary tab. Note that each sample row
includes a column for the target crossing point and a column for the reference crossing
point. The Results tab is shown below.

Relative Quantification - Dual Color
Giroup 1 |5ummary|

Target.‘Helelencel Paiing  Results |

| Group -
Set |Sample Tyne | Pos | Sample Mame | Target Cp Median | Fief Cp Median | Concentration Ratio | Nomalized Fiatio | Mulipication/Co
Ealibrator TS Caibrator ik iy 15 T

Resul Set1 Samples 3.4 200 263 2338 63 138 A
Resul Set2 Samples 56 28 27 2343 172 140 14
ResulSet3 Samples 7.8 26 012 1506 048 02 14
Fresul Set 4 Samples 910 222 3219 3264 137 11 14
FesulSet5 Samples 11,12 223 2355 2431 169 137 1A
FesulSet6  Samples 13,14 227 254 742 075 i3] 1A
FesutSet7 Samples 15,16 231 333 22 184 149 1A
Resul et Samples 17,18 239 2304 2380 163 137 14
Resul et Samples 19,20 243 2322 2165 03 027 14
Fresult Set 10 Sarples 222 27 27 2255 nge 070 14
ResultSet 11 Samples 23,24 253 2290 274 045 036 14
FresultSet 12 Samples 5.2 257 2350 2415 158 128 14
FresultSet 13 Samples 27,28 259 2206 277 163 132 1A
FresultSet 14 Samples 29,30 282 276 2355 172 141 1A
Result Set 15 Sarples 31,32 27 2250 2313 155 128 14
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5. Performing Qualitative Detection Analysis

The Qualitative Detection module analyzes unknown samples to detect the presence of a
particular target, based on whether the data shows target amplification. The analysis does
not quantify the amount of target DNA. A Qualitative Detection analysis can be
performed on any experiment containing an amplification program.

A simple qualitative detection experiment contains unknown samples, but no controls. A
more complex Qualitative Detection experiment uses positive, negative, internal, or any

combination of controls.

The following sections describe how to perform the analysis with or without controls.

5.1 Performing a Qualitative Detection Analysis
without Controls

A simple qualitative detection experiment contains unknown samples, but no controls.

To perform the analysis:

Open the experiment you want to analyze.

Click Analysis on the main toolbar.

Select Qualitative Detection, then click OK.

In the Sample Editor, enter sample information in the Capillary View tab.

If this is a multicolor experiment, in the Sample Editor toolbar, select the channels
used in the experiment.

In the Qual Detect tab of the Sample Editor, enter target names for each sample in
each channel.

Select Qual Detect in the module bar to open the analysis module.

00 0 00000

If this is a multicolor experiment:

From the Channel menu, select the channel for the targets you want to analyze.
To apply color compensation, click Color Compensation, then select Select Color
Compensation. Find and select the color compensation object for the current
instrument.

From the Program menu, select a quantification program in the experiment
(if there is only one quantification program, it is selected by default).

o
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@ View the detection calls for each sample in the Target column, as follows.

Column Name Description Possible Values

Target The sample call, based on Positive: The sample shows
whether amplification is amplification.
detected for the sample. Negative: The sample does

not show amplification.
Uncertain: The sample’s
amplification cannot be
determined, perhaps because
the amplification curve is
inconsistent.

(Optional) Click Advanced to display a Results section that includes the following

columns:

Column Name Description Possible Values

CP Crossing point of the sample,| A positive number with up to two
in cycles decimal places

Score A numerical value reflecting | A positive or negative number

whether the target is positive,| with up to two decimal places,
negative, or indeterminate or0

Positive: A value of +1 or above
Negative: A value of -1 or below
Uncertain: A value between +1 and -1

@ The score does not indicate the confidence level of the
call. For example, a score of 1.1 is no more or less positive
than a score of 4.1.

If this is a multicolor experiment, repeat the procedure to analyze the results for
another channel.
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5.2 Using Controls in a Qualitative Detection Analysis

A more complex Qualitative Detection experiment uses one or more controls. The
control reactions provide information about the quality of the template DNA, reagents,
and reaction conditions. Controls are expected to behave in a certain way, depending on
their type and other user-specified information. If they fail to behave as expected, the
unknown sample reactions are considered unreliable.

You can use the following types of controls in a Qualitative
Detection analysis:

Positive control Contains the DNA target for which the unknown samples are being
analyzed. A positive control is located in a separate capillary from the
unknown samples, and its results apply to all the unknowns in the
experiment that use the same channel. You can specify a crossing point
range for the positive control. If amplification does not occur, or if the
crossing point is not within the expected range, then the control fails.
In this case, the reaction did not proceed correctly or the sample may
be contaminated.

Negative control Does not contain the DNA target for which the unknown samples are
being analyzed. A negative control is located in a separate capillary
from the unknown samples. A negative control applies to all the
unknowns in the experiment that use the same channel. If
amplification occurs, then the control fails. In this case, the sample is
contaminated, and other unknown samples may also be contaminated.

Internal control Is a special type of positive control, located in the same capillary as the
unknown to which it applies. The internal control is a separate DNA
sequence that can be expected to amplify predictably. You can specify a
crossing point range for an internal control. If the crossing point is not
within the expected range for negative samples, then the control fails.

To provide an internal control, you can add a known DNA target to the sample mix, one
for which you have a robust assay. An internal control requires multicolor chemistry.

The presence of an internal control in the same capillary as an unknown indicates
whether the reaction in the capillary proceeded correctly. If the unknown fails to amplify,
and the internal control is not positive or the control’s CP is not within the designated
range, then the reaction may have failed and the results are unreliable. However, if the
unknown fails to amplify, but the internal control amplifies as predicted, then the
reaction proceeded correctly.
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Circumstances that cause a control to fail

The success or failure of a control affects whether a sample result is valid. A control fails
when it does not behave as expected, therefore a control fails in the following
circumstances:

® A Negative Control shows amplification and is consequently called positive or
uncertain. In this case, samples may be contaminated.

® A Positive Control does not show amplification and is consequently called uncertain
or negative or the Positive Control’s CP is not within the range designated in the
Sample Editor. In this case, the reaction may not have worked correctly or the samples
may be contaminated.

® The Unknown is Negative and the Internal Control’s CP is not within the range
designated in the Sample Editor. The failure of the control indicates that the reaction
in the capillary did not work correctly. (If the Unknown is Positive, the control is
assumed to succeed.)

How results are displayed

When controls are used, the Qualitative Detection module displays three results for each
sample: Combined, Target, and Control, as shown below:

Calls
Combined | Target | Contral
MNegative MNegative
MNegative MNegative

Combined result The Combined value is a “Metacall” based on the Target value and the
Control value.

Target result The Target result is the call for the sample based on the sample’s
amplification profile.

Control result ~ The Control result displays the Success or Failure for the combination
of controls that apply to the particular sample. All the controls that
apply to a particular example are treated together. If any of the controls
that apply to the sample fail, the Control column displays “Failure”.
Controls apply not just to Unknown samples, but to other controls.
For example, if an experiment contains two Positive controls, each
control applies to the other. A failure of one control causes a failure for
the other control.

The amplification curves of the controls that influence the validity of the selected target
samples are displayed separately in the work pane.
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Possible results for a Control sample

For Control samples (Positive Control, Negative Control or Internal Control), the
following results values are possible in each of the result columns:

Combined result is...

When...

Target result is...

Success Control behaves as expected and Control Column shows
Success or is empty.
Failure Control does not behave as expected and Control Column

shows Failure.

When...

Control result is...

Success

Positive Control sample shows amplification.
Negative Control sample does not show amplification.
Uncertain The control sample’s amplification cannot be determined,

perhaps because the amplification curve is inconsistent.

When...

All other controls that apply to this control succeed.

Failure

One or more controls fail.

no value (empty)

No controls apply to this control.
For example, this is an internal control and there are no other
controls in the experiment.

AR
(%)

Combined and Control consider replicates.
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Possible results for an Unknown sample

For Unknown samples, the following results values are possible in each of the result

columns:
Combined resultis... @ When...
Positive Target value is Positive and
Control column is Success (or no value).
Negative Target value is Negative and
Control column is Success (or no value).
Uncertain Target value is Uncertain and
Control column is Success.
Invalid Target value is Positive, Negative, or Uncertain and

Control column is Failure.

Target result is...

Positive Sample shows amplification.
Negative Sample does not show amplification.
Uncertain The sample’s amplification cannot be determined, perhaps

because the amplification curve is inconsistent.

Control result is... When...

Success All controls that apply to this sample succeed.
Failure One or more controls fail.
no value (empty) No controls apply to this sample.

For example, there are no controls in the experiment or there
are internal controls, but not in the same capillary as this
sample.
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Summary of possible Combined result values for an Unknown sample

For an Unknown sample, the Combined metacall is Positive, Negative, or Uncertain in
the following cases; in all other cases, the call is Invalid:

Combined call is... When Target value is... And Control value is....
Positive Positive Success (for all controls)
Negative Negative Success (for all controls)
Uncertain Uncertain Success (for all controls)

Software

To determine whether an internal control fails while other controls succeed, you will need
to look at the result for the internal control’s channel. For more information see Example
of Qualitative Detection results using an internal control that fails, below.

If all controls succeed, the combined call for an unknown sample is the same as the target
value (positive, negative, uncertain). If one control (that applies to the sample) fails, the
sample is invalid.

Performing a Qualitative Detection analysis using controls

Follow the steps below to perform an analysis using any or all of the controls described
above:

Open the experiment you want to analyze.

Click Analysis on the main toolbar.

Select Qualitative Detection, then click OK.

In the Sample Editor, enter sample information in the Capillary View tab.

If this is a multicolor experiment, in the Sample Editor toolbar, select the channels
used in the experiment.

In the Qual Detect tab of the Sample Editor, select Enable Controls.
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o Enter sample information for each channel in each row, as follows:
Column Name Description Valid Values

Target Name Name of the DNA target for this Any name
channel for this sample.

Sample Type The type of sample. Unknown
Positive Control
Negative Control
Internal Control

Cp Low The lowest crossing point value A positive number, with
expected from this sample, up to two decimal places
expressed in cycles.

If you specify a value for Cp Low, but
no value for Cp High, the control
must have a crossing point equal to
or greater than the Cp Low

value to succeed.

Cp High The highest crossing point value A positive number, with
expected from this sample, up to two decimal places
expressed in cycles.

If you specify a value for Cp High
value, but no value for

Cp Low, the control must have a
crossing point equal to or less than
the Cp High value

to succeed.

Select Qualitative Detection in the module bar to open the analysis module.

If this is a multicolor experiment:

From the Channel menu, select the channel you want to analyze.

To apply color compensation, click Color Compensation, then select Select Color
Compensation. Find and select the color compensation object for the instrument you
are using.

o ©000

From the Program menu, select a quantification program for the experiment
(if there is only one quantification program, it is selected by default).
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View the calls for each sample in the Combined, Target, and Control columns of the
Calls section, as follows.

Column Name Description Possible Values

Software
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@ (Optional) Click Advanced to display a Results section that includes the following:

Column Name Description Possible Values

@ If this is a multicolor experiment, select another channel to analyze.
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5.2.1 Example of Qualitative Detection Results when Positive Controls
behave as Expected

In this example, a single-channel experiment contains controls in sample positions 1-3.
All other sample positions contain unknowns. The controls all behave as expected, that is,
they show no amplification for the negatives (sample 1-2) and amplification within the
designated range for the positive (sample 3).

The following figure illustrates the results from a Qualitative Detection analysis of the
experiment. The Target column and the Control column together determine the metacall
value in the Combined column. The results are explained in detail in the following
sections.

Qualitative Detection [CC Object from Color Compensation Set [Cat

J Channel [E40/Back 530) =~ Caolor Compengation [On] =~ Frogram (2]« J Advancet
Samples Calls
Include | Colar| Pos | Mame Combined | Targst | Contral
] 1 notemplate contral Megative
2 Megative Control Megative
B 2 Posiive Contral
B ¢ Sampled
B 5 Sample2
[ | B Sample 3 Megative Megative
B 7 Sampled
1 8 Sample5

Results for samples 1-3

Samples 1-3 are designated as negative and positive controls in the Sample Editor. The
results for these samples are as follows:

® The Combined column displays “Success” because these samples behaved as expected
as indicated by the Target column.

® The Target column shows “Negative“ for the negative controls, because sample 1-2
showed no amplification, and “Positive” for the positive control, because sample 3
showed amplification.

® The Control column shows “Success” because all the controls for these samples
behaved as expected. In this case, samples 1-3 are the controls, but because negative
and positive controls apply to all samples using the same channel, each control applies
to the other control samples, as well.
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Results for samples 4-5 and 7-8

Samples 4-5 and 7-8 were designated as unknowns in the Sample Editor. The results for
these samples are as follows:

® The Combined column is the metacall for these unknown samples. The metacall is
“Positive,” because the samples showed amplification (as indicated in the Target
column) and the controls succeeded (as indicated in the Control column).

® The Target column shows “Positive” because these unknown samples showed
amplification.

® The Control column shows “Success” because all the controls for these samples
succeeded.

Results for samples 6

Sample 6 was designated as unknown in the Sample Editor. The result for this sample is
as follows:

® The Combined column shows the metacall for this unknown sample. The metacall is
“Negative” because the sample did not show amplification (as indicated by the
“Negative” call in the Target column), and the controls succeeded (as indicated in the
Control column).

® The Target column shows “Negative” because this unknown sample did not show
amplification.

® The Control column shows “Success” because all the controls (Samples 1-3) succeeded.
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5.2.2 Example of Qualitative Detection Results when a Positive Control
Fails

In this example, the same positive control sample (sample 3), negative controls and
unknowns are defined as in the previous example. However, the crossing point for the
positive control (sample 3) does not fall within the CP range designated on the Sample
Editor. Therefore, all three, the two negative controls and the positive control fail. The
effect of the failed controls on the calls for the samples is described below.

Qualitative Detection [CC Object from Color Compensation Set (Cat

J Chatinel [E40/Back 530] = Colar Compensation [On] « Program (2] = |J Advance
Samples Calls
Include | Colar| Pas | Mame Combined | Target | Control
[ ] 1 notemplate control Megative
2 Megative Control Megative
B 2 Postive Contral
W 4 Sampled Invalid
0 5 Sample2 Invalid
B f Sample3 Invalid Megative
WM 7 Sampled Invalid
[ B Sampleh Invalid

Results for samples 1-3

The positive control sample apply to all other samples, including the other control
samples. The results for the control samples are as follows:

©® The Combined column shows the metacall for these samples. The metacall is “Failure,”
because the controls for these samples (as indicated in the Control column) failed.

©® The Target column shows ,Negative“ for the negative controls, because sample 1-2
showed no amplification, and “Positive” for the positive control, because sample 3
showed amplification.

® The Control column shows “Failure” because at least one applicable control failed for
these samples. In this case, sample 3 is the control, that failed, because its CP did not
fall within the CP range designated on the Sample Editor.

Results for samples 4-5 and 7-8

Samples 4-5 and 7-8 are designated as unknowns in the Sample Editor. The results for
these samples are as follows:

©® The Combined column shows the metacall for these unknown samples. The metacall is
“Invalid” because the controls for these samples failed (as indicated by the Control
column).

® The Target column shows “Positive” because these unknown samples showed
amplification.

® The Control column shows “Failure” because at least one of the applicable controls
failed.

Results for sample 6

Sample 6 is designated as unknown in the Sample Editor. The result for this sample is as
follows:

® The Combined column shows the metacall for this unknown sample. The metacall is
“Invalid” because the controls for these samples failed (as indicated by the Control
column).

® The Target column shows “Negative” because this unknown sample did not show
amplification.

® The Control column shows “Failure” because at least one of the applicable controls
failed.
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5.2.3 Example of Qualitative Detection Results Using an Internal Control
that Fails.

An internal control is located in the same capillary as an unknown, and its results apply
only to the unknown in that capillary. Because the internal control is in the same
capillary as an unknown, a multicolor reaction is required.

In this example, internal controls are located in samples 1-3 and are measured in channel
705. The unknown samples are located in all the capillaries and are measured in channel
640. There are no Positive Control or Negative Control samples in the experiment.

In this experiment, the internal controls fail because their crossing points are not within
the range designated on the Sample Editor, which is expected for an unknown sample
showing no amplification.

Viewing results for the controls (channel 705)

In the example below, channel 705 (the control channel) is selected in the channel menu
of the analysis module, so the results displayed in the window are those for the internal
controls.

Qualitative Detection [Color Compensation for Multicolor Demo Set |

J Channel [705)] = Color Compenzation [On) = Program (2] “ Advanced
Samples Callz

Include | Colar| Pos |Name Combined | Target | Control

B 1 Samplel Megative

2 Sample 2 Megative

B 3 Sample3 Megative

[ ] 4 Sample 4 Megative Megative

[ ] 5 Sampleh Megative Megative

[ ] E Sample B Megative Megative

[ ] 7 Sample 7 Megative Megative

[ ] 8 Sample 8 Megative Megative

Results for samples 1-3

® The Combined column displays the metacall for the three control samples. The
metacall is “Failure” for each sample because the control did not behave as expected.
The control sample showed no amplification as indicated by Negative in the Target
column.

® The Target column shows “Negative” because the samples did not show amplification
in this channel.

® There is no value in the Control column because there were no controls that applied to
these control samples. Each of these controls was an Internal Control and therefore did
not apply to the other samples in the experiment. Each control applied only to the
unknown in the same capillary, which was measured in a different channel.
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Results for samples 4-8

There were no controls for samples 4-8 and there was no target DNA detected in this
channel (705). Therefore, the Control column displays no data, the Target column dis-
plays Negative (because no amplification is visible), and the Combined call is Negative.

Viewing results for unknowns (channel 640)

The illustration below shows the results for the Unknown samples measured in channel
640. Note that 640 is selected in the Channel menu. In this channel, all sample positions
contain Unknown samples. Samples 1-3 contain internal controls, measured in channel
705.

Qualitative Detection [Color Compensation for Multicolor Demo Set |

J Channel [640] + Color Compensation [On] ~ FProgiam (2] |J Advanced
Samples Callz
Include | Color| Pos | Mame Combined | Target | Contol
B 1 Sampled Invalid Megative
2 Sample 2 Invalid Megative
B 3 Samplel Invalid Megative
B 4 Sampled
B 5 Samples
B & Samplef
B 7 Sample?
[0 8 Sample8

Results for samples 1-3

©® The Combined column shows the metacall for these unknown samples. The metacall is
“Invalid” because the internal control for each sample failed. To see the control calls,
you must select channel 705, as described above.

® The Target column shows “Negative” because the unknown samples in this channel
did not show amplification.

® The Control column shows Failure because each internal control failed.

Results for samples 4-8

® The Combined column shows the metacall for these unknown samples. The metacall is
“Positive” because the samples showed amplification (as indicated in the Target
column), and there are no controls that apply to samples 4-8. The only controls in the
experiment are internal controls, which apply only to samples 1-3.

® The Target column shows “Positive” because the samples in this channel showed
amplification.

® The Control column is empty because there are no controls that apply to these
samples.
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6. Performing Melting Curve Analyses

This chapter explains how to use melting temperature profiles to identify DNA products
and to genotype samples.

6.1 Using Melting Curve Profiles to Identify DNA Products
and Genotypes

The temperature at which a DNA strand separates or melts when heated can vary over a
wide range, depending on the sequence, the length of the strand, and the GC content of
the strand. For example, melting temperatures can vary for products of the same length
but different GC/AT ratio, or for products with the same length and GC content, but with
a different GC distribution. Even single-base differences in heterozygous DNA can result
in melting temperature shifts.

Because melting temperatures vary according to these differences, melting temperature
profiles can be used to identify and genotype DNA products.

To analyze sample melting temperature profiles, the fluorescence of the samples must be
monitored while the LightCycler” temperature is steadily increased. As the temperature
increases, sample fluorescence decreases. In the case of SYBR Green I dye, this is due to
the separation of double DNA strands and consequently the release of SYBR Green I
molecules. For HybProbe probes, this is due to the separation of target-probe hybrids
resulting in the spatial separation of the dye molecules and a consequent drop in
fluorescence.

6.1.1 Defining a Melting Program

A melting temperature analysis can be performed on any experiment that includes a melt
program. A melt program is usually performed after amplification of the target DNA. A
typical melt program includes three segments:

©® A segment that rapidly heats the samples to a temperature high enough to denature all
the DNA

® A segment that cools the samples to below the annealing temperature of the target
DNA

©® A segment that slowly heats the samples while measuring sample fluorescence as the
target DNA melts
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6.1.2 Content of a Melting Temperature Analysis

A melting temperature analysis uses the fluorescence measurements of the melt program
to determine the melting temperature of each sample. The melting temperature (or Tm)
of a sample is defined as the point at which half the probes (or dye) have melted off the
DNA.

The analysis displays a melting curve chart of sample fluorescence versus temperature.
The chart shows the downward curve in fluorescence for the samples as they melt. The
analysis also displays a chart that plots the first negative derivative of the sample fluores-
cent curves. In this chart, the melting temperature of each sample appears as a peak.
Displaying the melting temperatures as peaks makes it easier to distinguish each sample’s
characteristic melting profile and to discern differences between samples.

The following figure illustrates a melting curve chart and a melting peak chart from a
melting temperature analysis.

Melting Curves

Temperature (°C)
Lo a]

Melting Peaks

45 50 55 60 65 70
Temperaturs (°C)

In the melting peak chart, notice that some sample curves include two peaks. These
curves indicate heterozygous samples. After DNA amplification, a heterozygous sample
contains two DNA sequences, which each melt at a different temperature, producing a
two-peak curve for the sample.

6.1.3 Types of Melting Temperature Analysis

LightCycler” Software 4.05 includes two types of melting temperature analysis:

Genotyping analysis Groups samples with similar melting profiles together and
identifies each group as a genotype. If desired, you can import
melting curves for known genotypes and apply them to the
samples, or you can include melting standards in the experiment.
Use the Genotyping analysis for genotyping and for mutation
detection. For more information see Performing a Genotyping
analysis, below.

Tm Calling analysis  For each sample, calculates the melting temperature, the melting
peak, height, width and the area under each peak. Use the Tm
calling analysis to identify characteristic melting profiles of DNA
products. For more information see Performing a Tm Calling
analysis, below.
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6.2 Performing a Genotyping Analysis

You can perform a Genotyping analysis on an experiment that contains a melt program.
The Genotyping analysis module determines the genotypes of unknown samples by
analyzing the shapes of the melting curves of all the samples and then grouping curves
with similar shapes together. The median curve of each group is defined as the genotype
standard for that group. The software compares the melting curves of individual samples
to the standard genotype curves.

You can also include standards with known genotypes in the experiment, or import an
object containing standards. In these cases the software compares the melting curves of
the individual samples to the designated standards.

The presence of a mutation introduces a mismatch that lowers the temperature at which
the probe melts off the sequence. The melting temperature shift (AT,,) between a normal
allele-probe match and a mutated allele-probe mismatch causes different fluorescence
profiles, which indicate the presence of the mutation. The difference in melting tempera-
ture depends on the type of mismatch, the mismatch position within the probe sequence,
and the base pairs immediately adjacent to the mismatch.
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6.2.1 Methods Used to Compare Sample to Standard

As the software compares melting curves of individual samples and genotype standards,
the software reports two numerical values. These values describe how closely an individ-
ual sample curve resembles the genotype standard curves.

® The Score measures the similarity between the sample and the standard that is closest
to the sample. A Score of 1 indicates a sample whose melting curve is identical to the
melting curve of at least one standard. A score of "nearly 0" indicates a sample whose
melting curve is unlike the melting curve of any of the standards.

® The Resolution measures the dissimilarity between the sample and the second closest
standard to the sample. If the Resolution of a sample is nearly equal to the Score of that
sample, that sample's melting curve is similar to the melting curve of only one
standard. Alternatively, if the Resolution of a sample is nearly 0, that sample's melting
curve is similar to the melting curves of two standards.

There are three possible and one impossible combinations of Score and Resolution:

® If the Score and Resolution values are both nearly equal to 1, then the software has
found an ideal match. However, the software can still declare a good match (i.e., group
the sample with a specific genotype) if the Score is nearly equal to 1 and the Resolution
is as low as 0.1.

® If the Score is nearly equal to 1, but the Resolution is less than 0.1, the software has
found a good match between the sample and a standard, but the sample is also a good
match with another standard. In this case, it is difficult to distinguish between the two
genotypes, and the software will classify the sample as an unknown genotype.

® Ifboth Score and Resolution are near 0, then the software cannot classify the sample.

© It is mathematically not possible for Score to be near 0, and Resolution to be near 1.

Meaning of Score and Resolution values for "Negatives" and "Unknowns":

® Negatives: Sample curves are compared to an artificial negative standard (a quadratic
polynomial). In this case, both the score and the resolution describe the similarity of
the sample to this negative standard. Thus, the Score and Resolution are identical.

©® Unknowns: You can specify stringency thresholds for Score and Resolution. If either
value is below the threshold you set, the sample is classified as “Unknown.”

It is difficult for the software to determine genotypes if all the melting curves are very
similar, or if, collectively, melting curves do not have distinct differences between

groups. These situations arise when the melting peaks are small relative to the
background, when there are too many genotypes present, or when the probes are old.
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6.2.2 Performing the Analysis Using Automatic Grouping

If you do not specify any standard samples in the Sample Editor, the module will use
automatic grouping. In automatic grouping, the software analyzes the shapes of all
sample melting curves and then groups curves with similar shapes, defining each group
as a genotype. Then, the software compares the melting curves of individual samples to
the median curve of each group. You can refine grouping parameters as necessary.

To perform automatic grouping:

Create and run a mutation detection experiment or open an existing experiment.

Click Analysis on the main toolbar.

Select Genotyping, then click OK.

In the Sample Editor enter general sample information in the Capillary View tab.

In the Genotyping tab of the Sample Editor, enter sample types (Unknown, Positive
Control, or Negative Control). Do not designate any samples as Melting Standards.

Select Genotyping in the module bar to open the analysis module. The Samples list is
displayed on the left; by default all samples are selected. Melting curve and melting
peak graphs for the samples are displayed on the right.
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The software automatically generates genotype groups and assigns genotypes to the
unknown samples. The genotype groups are listed in the Group Information box below
the sample list. In the sample list, the Group Name indicates the genotype group each
sample is assigned to. The Score and Res values indicate how well each sample’s curve can
be matched to the genotype curve.

o If you are not satisfied with the accuracy of the default automatic grouping
and want to separate the melting peaks more precisely, click on Settings and
select High Sensitivity.

| Channel (840) + Color Compensation + Program (3] + |J Standards (Int] = Settings +

[ Samples [ Resuls |
Incl.. | C...|Pas_|N

Melting Curves

a 50 E3 60 65 0
Temperature (°C)

Melting Peaks

4l IR0}
[Ermrr ] n
Group Infarmation [
Group Hame | HofSamples |
Negative 1
wildype 5
mutant 5
heterozygous 5
Contral Panel S =
Edit Group Name [Negative: i T- [i5 = E = = o p -
Score thieshold=05 Resoldion (teshobi=D 1y 7- [F35 2 Temperature (°C)
T = = =
| Arnalysis Hotes

e To view the melting curves and peaks for a particular genotype group, select the
group name in the Group Information box. Then, the melting curves and peaks in the
group are displayed in the graphs portion of the work pane. The samples included in
the group are highlighted in the sample list.

e To rename a group, select a group in the Group Information box, then type a new
name in the Edit Group Name box.

@ To remove a sample from its genotype group, double-click the check box next to the
sample name in the sample list.

Software
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To refine the automatic grouping:

Groups are recalculated as soon as you change any of the parameters described below.
In the Control Panel at the bottom of the window, set the following parameters as needed:

Score threshold: Slide the bar to set the minimum score a sample must have to be
identified as a genotype. The default value of 0.5 is recom-
mended for initial analysis.

Resolution threshold:  Slide the bar to set the minimum resolution a sample must have
to be identified as one genotype rather than another. The default
value for the Resolution threshold is 0.1.

Set the temperature range for genotype calls by dragging the blue and green vertical lines
in the Melting Curve graph. The temperatures are displayed in the Minimum T and
Maximum T boxes.

@ Genotype calls are made only for melting peaks located within the minimum and
maximum temperature range. Make sure the temperature range is wide enough to
include all melting peaks in the raw data.

Melting Curves

14,136

13,436 .
PR e ==
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£ aom
3 5%
7 836
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Temperature (°C}

Minimum T The temperature at which the melt analysis should begin. This
value should be 5° to 10°C lower than the first melt peak.

Maximum T The temperature at which the melt analysis should end. This
value should be 5° to 10°C higher than the last melt peak.

154

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Performing Melting Curve Analyses

Software

6.2.3

Performing a Genotyping Analysis

Performing the Analysis Using Standards Included in the Experiment

If standards are included in the experiment, the software compares the melting curves of
the unknown samples to the curves of the standard samples to make the genotype calls.

To perform the analysis using standards in the experiment:

Create and run a mutation detection experiment or open an existing experiment that
includes standard samples.

Click Analysis on the main toolbar.

Select Genotyping, then click OK.

In the Sample Editor, enter general sample information in the Capillary View tab.

In the Genotyping tab, select Melting Standard in the Sample Type column for each
standard sample.

Enter a genotype name in the Genotype column for each standard sample.

@ You must enter a genotype name in the Genotype column for each melting
standard. Enter different names for different melting standards.

o © 0000

Select Genotyping in the module bar to open the analysis module. The software
automatically assigns genotypes to the unknown samples, based on similarity to the
melting curves of the standard samples. The genotype groups are listed in the Group
Information box below the sample list. In the sample list, the Group Name indicates
the genotype group each sample is assigned to. The Score and Res values indicate
how well each sample’s curve can be matched to the genotype curve.

@

To view the melting curves and peaks in a particular group, select the group name in
the Group Information box. Then, the melting curves and peaks are displayed in the
graphs portion of the work pane. The samples included in the group are highlighted
in the sample list.

o

To rename a group, select a group in the Group Information pane, then type a new
name in the Edit Group Name box.

To remove a sample from its genotype group, clear the check box next to its name in
the sample list. To re-add a sample to its genotype group, select the check box next to
its name.




156

Performing Melting Curve Analyses

Performing a Genotyping Analysis

6.2.4  Exporting Genotype Standards

You can export genotypes to be used as standards in other experiments.

To export a genotype:

Perform a Genotyping analysis, using either of the procedures above.

In the Group Information box, select the standard you want to export.

Click Standards and select Save Standard As External.

Navigate to the location where you want to save the object. (The typical location is
\Special Data\Melt Std\ located under your user folder.) Enter a file name, then click
OK. The standard information is exported and saved.

6.2.5 Performing the Analysis Using Imported Standards

You can import genotype standards into an experiment and use them to determine the
genotypes of the unknowns.

To perform an analysis using imported standards:

Analyze the experiment using automatic grouping.

Click Standards and select Use External Standard.

Find and select the object containing the standards to import, then click Open.
The imported standards are listed in the Group Information box. The results are
recalculated using the imported standards.

To recalculate the genotypes using the melt curves from the experiment
(that is, without the imported standards), click AutoGroup.
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6.3 Performing Tm Calling Analysis

You can perform a Tm Calling analysis on any experiment that includes a melt program.
During a melt program, the fluorescence of the samples is monitored while the
temperature is steadily increased to melt probes off the target strands.

If SYBR Green I or HybProbe probes are used, the dye separates from the DNA during a
melt, resulting in decreased fluorescence as the temperature increases. In the case of the
SYBR Green I dye, this is due to the separation of double strands and consequently the
release of SYBR Green I molecules. For HybProbe probes, the separation of target-probe
hybrids results in the spatial separation of the fluorescence resonance energy transfer
(FRET) partners and in a drop of fluorescence at a certain temperature. The melting tem-
perature, or Tm, is defined as the point at which half the probes have melted off the DNA.

The purpose of Melting Curve Analysis is to determine the characteristic melting temper-
ature of the target DNA and to identify products based on their melting temperature.

The analysis displays a chart of the samples’ melting curves which shows the drop in
fluorescence. The software also charts the first negative derivative of the melting curves,
which displays the melting temperatures of the samples as peaks. When sample melting
temperatures are displayed as peaks, it is easier to discern small differences in the melting
profiles of the samples.

The analysis result data includes each sample’s melting temperature and also the size of
the area under each sample’s melting peak.

The Melting Temperature analysis uses automated algorithms to find the peak areas and
melting temperatures. The analysis module includes a Seftings menu you can use to refine
the analysis. Additionally you can edit the automatically calculated Tm results manually.
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To perform the analysis:

Using LightCycIer® Software 4.05, create and run an experiment or open an existing
experiment that contains a melt program.

Click Analysis on the main toolbar.

Select Tm Calling, then click OK.

In the Sample Editor, enter general sample information in the Capillary View tab.

000

(Optional) On the Tm Calling tab select one sample as a Tm Calibrator, if desired, and
specify its characteristic melting temperature. A Tm Calibrator is a sample with a
known melting temperature. If you include a Tm Calibrator, the analysis results will be
adjusted so that the melting temperature of the Tm calibrator sample matches its
expected melting temperature. This will adjust the results for the other samples, as
well. You might want to use a Tm Calibrator to adjust for minor differences between
instruments.

In very rare cases where peaks contain distinct shoulders, the software may use
the shoulder as a calibrator, when the real peak does not match its expected
melting temperature. In this case, check the plausibility of the calculated
melting temperatures of all samples.

In the module bar, select Tm Calling to open the analysis module.

00

If this is a multiplexed experiment, from the Channel menu, select the channel you
want to analyze.

Click on Display and choose which results you want to view by selecting or
deselecting the offered parameters. (For a description of the result parameters
refer to the table below.)

. Dizplay I -

v Show Shoulders

- T
v Peak Area
v Peak Height
v Peak Width

View the results in the work pane, as described below. To view all the columns,
drag the divider between the sample list and the charts to the right.
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Result Description

Tm1 The melting temperature for the first peak for the sample

Areal The area under the first peak.

Width1 The width of the first peak

Height1 The height of the first peak

Tm2 The melting temperature for the second peak for the sample, if any.

Area2 The area under the second peak.

Width2 The width of the second peak

Height2 The height of the second peak

If there are additional peaks and the appropriate setting is chosen, the results display
them as Tm3, Area 3, and so on. The figure below shows results for a typical melting
curve analysis.

& LightCycler Software 4.05 - [Demo Tm Calling]

7 File Edit View Tocks MWindow Help
17 13 hew Z3Run. {3 Analysis

| Aopen & save @bt | Template.. % RunMacio

| Channel (530) = Color Compensation = Program (3] ~ |J Seltings ~ Display =

Samples [ Melling Peaks
Tml | &real | widthl | Heightl | Tm2 | Areaz | Width2 | Heightz Melting Curves
13,371
;
= 11371
8
% 8371
g 7,371
i sam
5 aan
4 w
1371
v
] 65 0 75 a0 a5 a0
- Temperature (°C}
i
o Melting Peaks
5
8 2273
®
2 1773
[
E 12734
S o773
=
= 02734
B
= T T . T ; T
5 65 70 3 a0 85 an
Temperature (°C)
O Tmi
LI T2
Heset
= =
( 1+ ‘Ana\ys\sNDtEs
|Tupe | Date | Time |Message x|
&% Fiont scieen /& Demo Tm Calling
[Logged on to LocalExar3 as System Admin Research




Performing Melting Curve Analyses
Performing Tm Calling Analysis

To refine the analysis:

You can use the Settings and the Display menu to modify the specificity of the analysis.

Settingslv Displap =

High Sensikivity

® Z Peaks or Less
6 Peaks or Less

To set an upper limit to the number of peaks found in the sample data, from the Settings
menu, select 2 Peaks or Less or 6 Peaks or Less.

Sometimes there is a shoulder visible on the side of a peak. If you want to see these
shoulders in the result data, from the Display menu, select Show Shoulders. To hide them,
deselect Show Shoulders.

The calculation must be complete before Show Shoulders becomes active.

Sometimes there are very small peaks in the data. To calculate values for these minor
peaks, from the Settings menu, select High Sensitivity. When you select High Sensitivity,
the Tm and Peak Area values for the major peaks in the data might be smaller than if you
do not use High Sensitivity. This is because the values for the major peaks will not include
the data from the minor peaks. If you deselect High Sensitivity, then the data from the
minor peaks might be incorporated into the results for the major peaks, making the Tm
and Peak Area values larger for the major peaks.
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To edit Tm calling results:

o Perform the Tm calling analysis as described above.

e Select a sample from the sample list to edit its calculated melting peaks.

Tm Calling
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5 Standad4 8522 G
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10 Sample 3 85.05 0,708
11 Sample 4 8511
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~(didT)
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Use the manual Tm sliders in the Melting Peaks chart to edit the Tm values or enter a
value for the Tm in the corresponding Tm box. The respective Tm's, areas, heights and
widths are recalculated and displayed in the sample list for this sample.

The changed results can be saved and then displayed on the report.

To remove a calculated Tm from the sample list, click the corresponding Tm check-
box in the Melting Peaks chart to clear it.

© 600 O

To restore the original (automatically calculated) Tm values click Reset.

() Tmediting is only possible for single samples.

o

Software




Performing Other Analyses
Performing Nucleic Acid Quantification Analysis

7. Performing Other Analyses

This chapter explains how to determine nucleic acid concentration based on sample
fluorescence, and how to compensate for bleedover between fluorescence channels in a
multicolor experiment.

7.1 Performing Nucleic Acid Quantification Analysis

A Nucleic Acid Quantification analysis compares the fluorescence of unknown samples to
the fluorescence of known samples without using an amplification reaction.

The analysis is performed on an experiment that measures sample fluorescence at a
constant temperature for a specified hold time. The experiment can include multiple
cycles, but each cycle uses the same temperature and hold time.

The experiment must include standard samples with known concentrations. The analysis
uses the standard samples to generate a standard curve of concentration versus
fluorescence. The analysis calculates the concentrations of the unknown samples based
upon the location of their fluorescence values on the standard curve. The results are
displayed in the sample list.

Prerequisite

You must include two or more standard samples of known concentration in the
experiment. The samples are used to generate a standard curve of fluorescence versus
concentration.

To perform the analysis:

Using LightCycIer® Software 4.05, create and run the quantification experiment or
open an existing experiment.

Click Analysis on the main toolbar.

Select Nucleic Acid Quantification, then click OK.

In the Sample Editor, enter general sample information in the Capillary View tab.

000

In the NA Quant tab of the Sample Editor, specify standards and unknowns as shown
in the table below.

Column Name Valid Values Description

Target Name Any name Name of the target for this channel.

Sample Type Unknown The type of sample in this capillary.
Standard

Conc. Any concentration | Concentration of a standard sample.

Select Nucleic Acid Quantification in the module bar to open the analysis module.

00

Select the check boxes for the standards you want to use to generate the standard
curve and for the samples you want to analyze. (Double-click a check box to select
or clear it.)
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To view analysis results, click and drag the left border of the chart section to the right
to display all the result data.
Results include the following:

Result Description
Fluorescence The fluorescence value.
Concentration The calculated concentration of the sample (in the units

specified in the NA Quant Sample Editor).

Standard The specified concentration if this is a standard sample; this
value is from the NA Quant Sample Editor.

e Under the sample list view the following statistics for groups of replicate samples:

Samples The samples in the replicate group.

Mean Fluor The mean fluorescence for the samples in the group.

Std Fluor The standard deviation for the fluorescence in the group.
Mean Conc. The mean concentration for the samples in the group.

Std Conc. The standard deviation for the concentration in the group.

The Nucleic Acid Quantification window is shown below.

A LightCycler Software 4.05 - [Demo Nucleic Acid Quantification]
47 Fle Edt Visw Took Window Help

1 23 New £ Flun. {RAralysis.. | £30pen & oo Repot | i Template... £ Run Macio

Samples Flesults

Inel. | Calor | Pas | Mame Flurescence | Conc|j

<] <] < <] <] <]

<] <] <]

<]

| Vi
1234567 881011121314 151617 1618 2021 22 23
Samples

Standard Curve
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Shatistics L
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7.2 Using Color Compensation

In a multicolor reaction, the wavelengths of light emitted by the dyes overlap, causing one
channel to pick up signals from a dye measured by another channel. This bleed-over of
fluorescence signal can result in uninformative data.

To correct the bleed-over, you can apply a color compensation object when you run the
experiment or when you analyze the data. When you apply a color compensation object,
LightCycler” algorithms use the data from the file to compensate for the fluorescence
bleed-over. You then see only the specific signals in each channel.

Color compensation is used when you run an experiment that uses two or more different
dyes. Typically for dual color applications LightCycler” Red 640 and LightCycler”
Red 705 dyes are used.

@ Color compensation is only necessary when data is extracted from multiple
fluorescence channels for analysis. Color compensation is not required when the
experiment uses a single channel.

To use color compensation, you must perform the following steps

> Run a color compensation experiment on the instrument where you are going to
perform the multiplexed experiments. The color compensation experiment gathers
the data needed to compensate for the fluorescence bleed-over. From the color
compensation experiment create a color compensation object. For more information,
see Performing a Color Compensation Experiment, below.

> Apply the color compensation information when you perform the experiment or
when you analyze the experiment. For more information, see Applying Color
Compensation, below.

7.2.1 Performing a Color Compensation Experiment

A color compensation object always applies to a specific instrument. Therefore, you must
run the color compensation experiment on the instrument you are going to use to run
the multicolor experiments. To run the experiment, you can use a color compensation kit
from Roche (for dual color applications with LightCycler” Red 640 and LightCycler”
Red 705), or you can create and run your own color compensation experiment, as
described below.

A color compensation object can also be created for a specific assay or chemistry lot
number.
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To run your own color compensation experiment:

If you are using a Roche kit, please refer to the pack insert of the kit for more details. To
create the color compensation object, use the macro for automatic execution of the
calibration, which is included in the Roche folder under Templates and Macros/Experi-
ment Macros/Demo Macros/Color Compensation Set Macro (Cat No 02158850). Follow
the instructions provided by the Experiment Kit Wizard.

To generate your own color compensation object, follow the general recommendations
below.

Prepare up to seven capillaries, a blank and the fluorescence dyes you want to use in
your experiments. (The number depends on the number of channels you need to
compensate). We recommend using the same fluorescence probes that you are going
to use in your multicolor experiments.

Open LightCycIer® Software 4.05 and, using the same program settings you plan to

use for your multicolor experiment, create a color compensation experiment

that has one melting program with the following segments:

Segment 1 95°C for 0 sec. at 20°C/sec.

Segment 2 40°C for 30 sec. at 20°C/sec.

Segment 3 95°C for 0 sec. at 0.1°C/sec., continuous.

Select Color Compensation in the program’s Analysis Mode field.

() Asan Expert User you can copy the Color Compensation Set Macro to your own
o user folder and edit the sample information in the Color Comp tab of the

Sample Editor. Most importantly, you must define the dominant channels.

In the Sample Editor, enter the following information in the Capillary View tab, if needed:

Assay Cat No. The assay catalog number.

Assay Lot No. The assay lot number.

Color Comp ID A string that identifies the color compensation object to an
experiment kit wizard. For more information about experiment kits
see Creating and using experiment Kits.

° In the Color Comp tab of the Sample Editor, enter sample information as follows:

Column Name Valid Values  Description

Dominant Channel | Water The channel used for the dye in this
530 capillary.
560 Select “Water” for the first capillary (which
610 should contain only buffer and water).
640 Select the appropriate channel for each
670 additional capillary.
705

Always place the capillary containing buffer or water (the blank) in the first position

of the carousel.

@ The Mg buffer in the "blank" should be the same as the one used in the assay to
which the color compensation data will be applied.

Place the capillaries containing the dyes into the carousel in such an order, that the
first one in position 2 has the lowest and the last one in position 4-7 the highest
wavelength. An example is shown below.

Capillary 1 A reagent blank (buffer, water)

Capillary 2 Fluorescein

Capillary 3 LightCycler® Red 640

Capillary 4 LightCycIer® Red 705

Software
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When the experiment is finished, select Color Compensation from the Analysis menu.

Select Color Compensation Analysis in the module bar to open the analysis window.

000

Click Save CC Object on the analysis window toolbar, then navigate to a location to
save the color compensation object (typically \Special Data\CCC under your user
name in the Navigator). Enter a name, then click OK.

You can now apply the color compensation data to another experiment. For more
information, see the following section.

7.2.2 Applying Color Compensation

You can apply color compensation before you run the multicolor experiment or when
you analyze the experiment.

To apply color compensation:

o To apply color compensation during an experiment run, click Color Compensation
in the Run module, then select Select Color Compensation... . To apply color
compensation to an analysis, add the analysis module, click Color Compensation
in the analysis window, then select Select Color Compensation... .

A Select Object dialog box displays color compensation objects that match the
current instrument’s ID.

0 Select the color compensation object you want to apply, then click OK.

@ After you select an object for an analysis, the object name is added to the Color
Compensation menu for all analysis modules added to this experiment.

e A small dialog opens so you can select the channels to compensate. The number
of channels displayed depends on the number of channels used in the color
compensation experiment. By default all channels are selected. Channels that are
not checked cannot be compensated.

:; Color Compensation Channels [_[Of =]
Select channels to compensate.

v 520
I 560
¥ B0
¥ B40
v E70
v 705

LCancel

o Deselect any channels you do not want to compensate, then click OK.

The experiment or the analysis charts are redrawn using the compensated data.
Note that the Color-Compensation menu label now says “(On)”
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8. Using Reports, Charts, Queries and
Instrument Tools

In addition to the run and analysis software, LightCycler” Software 4.05 includes the
following tools and commands:

® A report generator used to generate reports that include experiment information and
analysis results; for more information see Generating a Report below.

® A tool to export and print charts to various graphic formats and copy and paste chart
images and data; for more information see Working with Charts below.

® A query tool used to find objects in the database; for more information see Using
Queries to Find Information below.

©® A fluorimeter used to measure the fluorescence of a sample without cycling; for more
information see Measuring Fluorescence without Cycling below.

® Instrument and application diagnostic tools, including an instrument self test, error
and operation logs. For more information see Using Diagnostic Tools below.

8.1 Generating a Report

After you analyze an experiment, you can generate an analysis report containing general
experiment information and analysis results. You can customize the report to include any
of the following:

©® Experiment summary information (such as name and date)
©® Experiment protocol

©® Sample information

©® Instrument information

® Analysis results and other analysis items (the analysis items you can include vary by
analysis type)

You can arrange the order of items in the report and print the report.
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To generate and print a report:

o Open an experiment that includes one or more analysis modules.

e Click | &Repat , or select Report from the File menu. The report window opens in the
work pane. The left side contains a list of available report items, with some items
selected by default. The order of items in the list indicates the order of items in the
report.

Demma s Quant with Internal Control]] alalx

oftwene 4.05
View  Took ‘Window

e
(b ey | (3 gy e e | Ve i |
Select and Dde Fopent Snctions & BEE AT b M SeSen DelodSetm
7 [F Demesde Quant s Inteseal Conbal
F Exposment
& Protoeal
7 Samples
I Instrasert i Cveler Software Version 4.05
L LightCycler Software Vv I @mm
I Sergie Enon Report
B A Gt Tl harerd 6401 e
Uoe o Moded
& Fiewks Deme Abs Quant with Internal Contral
T Statiics Tuparenor
= ""“""““v;': [ Creuton Dalu | 25.01.2005 105240 Last Mudifed Dl 10.02.2005 143002
[ [ il Gt Intmeral Corsiod [Chasd 7 i o] Syt Ml
7 Seings | Start Teme | 30.07.2003 173310 End Teng| 0,07 2003 182848
G Fensr Run State | Completed Softwars Version | LC54 45191 |
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™ Angicsion Crvss Tumptatss
- Sterclest Cove Fun Notus | Dusectan Fomat Hypazation Probes (Dual Colon
Anabysr Hites Diotecton of Tarped spocific Signal with LighiCyelor HED 840
Detecton of Infumal Conrol (C) specfic signal with LightCyeler RED 108
gt i reguired. o
o Indemal Control s bs 9 T 3% 30 & had with ‘eles, thus
S40arg 44 an InhibMan contral, The slandards do ret contain IC,
Programs
Frogram Nama | Pre-incusaton
Cycles |1 Analysis Mode  None
4 | ] - = ot =]
Twpe | Dae | Trme Menage T
& Fioed sczven &0 | Pepast D
Pt o il ; =

Click items in the list to include or exclude them.

To change the location of an item in the report, click and drag the item to a new
location in the list.
You cannot drag an item into a category where it does not belong. For example,

you cannot drag results from a melting temperature analysis into an absolute
quantification analysis.

To save the changed settings for this object click Save Settings.

00

If you saved changed settings and want to restore the default settings click Default
Settings, close the Report window and reopen it. The settings will then be the default
settings again.

0 To see additional pages of the report, use the page forward and backward controls:

I4 4 |Pagelof3 L |

0 To change the scale of the report within the window, click one of the following
buttons:

B EE

The first button displays the report at its printed size.
The second button fits the entire report page into the window.
The third button fits the width of the report page into the window.

e To print the report, click Print at the top of the report window.
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8.2 Working with Charts

LightCycler” Software 4.05 generates many kinds of charts during and after an experi-
ment run and as part of an experiment analysis. You can print charts, export charts to
various graphic formats, and copy and paste chart images and chart data. The charts
include a zoom and a pan function, so you can enlarge details of a chart and move the
chart left or right.

8.2.1 Printing, Exporting, and Copying Charts

You can print any chart displayed in LightCycler” Software 4.05. You can also export the
chart image and the chart data separately, or copy and paste the image and the data
separately into other programs.

To print a chart:

o Display the chart you want to print.

Right-click within the chart boundaries, then select Print. A setup window is

displayed.
:_,T-' Print chart M=
|**HP Desklet@3 x| Setup |
Orientation:———————
: © Bl
" " Landscape

Cancel |

e To change the graph margins, and therefore the size of the graph, click and drag the
gray margin lines that surround the graph image.
( {L/,\ You can resize the dialog box to make it easier to adjust the graph margins.

o

If necessary, select a printer. (Your default Windows printer is selected by default).

To change printer configuration options, click Setup. A standard Windows printer
setup dialog box is displayed. Enter the necessary information, then click OK.

0 Select the paper orientation (Portrait or Landscape) and click Print.
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To export a chart image:

o Display the chart you want to export.

e Right-click within the chart boundaries, then select Export. An Export dialog box
opens.

& Export chart [ [=] 3

Picture | Data |

Ecrmat

Options | s |

Colrs: [Defautt x|

€ a5 Metafils I™ Monochiome

& as Bitmap

€ ssGIF

€ s JPEG
€ s PCX
€ sPNG

€ 2 WMLIHTM]

Flename: [ &1

On the Picture tab, under Format, select the graphic format in which you want to
export the chart.

If an Options tab is displayed (on the right), select conversion options as needed.
(The tab is not displayed for all graphic formats. If the tab is displayed, the options
vary, depending on the format you selected.)

To change the size of the exported image, select the Size tab, then enter the new
width and height values. Select Keep aspect ratio if you want to maintain the
proportions of the chart.

Click ' (to the right of the Filename box), to open a Select output file dialog box.

Browse to the location where you want to save the exported chart image, enter a
name for the image, then click Save.

Click Export to export the chart.

© 00 O 06 0
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Display the chart containing the data you want to export.

Right-click within the chart boundaries, then select Export. An Export dialog box
opens.

Select the Data tab.

# Export chart H[=] &3
Pictue  Data |
Include:
Series: [(al] = [¥ | Point Index
Format: ¥ Puirt Labels
 Tent ¥ Headsr
 ®ML
 HTML Table Delimiter:
O Euel Tab 2
Fiename |
cont |

In the Series box, select the data item you want to export. The items vary, depending
on the type of chart.

In the Include box, select the text labels to export with the data.

In the Format box, select a format for the exported data.

If you selected 7ext as the format, select a delimiter in the Delimiter box.

Click [&3] (to the right of the Filename box), to open a Select output file dialog box.

Browse to the location where you want to save the exported data, enter a name for
the data file, then click Save.

6 00000 ©

Click Export to export the data.

To copy a chart image or chart data:

Display the chart you want to copy.

Right-click within the chart boundaries, then select Copy to clipboard. The chart is
saved as a bitmap and the data is saved as text.

To paste the chart image, open a graphics application such as Paint, then press Ctr/-V.

To paste the chart data, open a text editor such as Notepad, then press Ctr/-V.

Software
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8.2.2 Zooming and Panning to View Chart Details

You can enlarge a portion of a chart as many times as necessary to view important details.
If you use a 3-button mouse, you can shift the chart in any direction to view details that
are outside the window. Follow the procedures below to enlarge chart details (zoom) or
to move a chart (pan).

To zoom:

Place the cursor above and to the left of the chart area you want to enlarge.

Click and drag the mouse pointer down and to the right. (The pointer changes to a
rectangle.) Release the mouse button when the rectangle covers the area you want to
enlarge. The area within the rectangle is enlarged to fill the work pane.

Repeat step 2 as often as necessary until the chart details are as large as you want.

To restore the chart to its original size, click and drag the mouse pointer up and to the
left. (You need to do this only once to restore the chart to its original size.)

To pan:

If portions of the chart disappear off the window, use the middle mouse button to click
the chart, then drag the chart until the portion you want to see is in view.

() You may be able to configure a 2-button mouse so that clicking both buttons at the
& same time equals the functionality of a middle button. See your system administrator
or refer to the device driver instructions that came with your mouse.
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8.3 Using Queries to Find Information

LightCycler” Software 4.05 includes a query tool you can use to retrieve experiments and
other objects stored in the LightCycler” Software 4.05 database.

To create and execute a query:

o Click New, select the Query & icon, then click OK. A query window opens in the
LightCycIer® Software 4.05 work pane.
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In the Object Type box, select the type of object to look for, such as Experiment.

(Optional) Enter the name of the item to search for or the owner of the item, if known.

Select Modified Date or Creation Date to specify which date you want to use in the
query.

Select a date range. You can specify the number of months or days before the current
date to search, or you can select a beginning and ending date in the past.

(Optional) To refine the search, click Advanced, then enter additional search criteria.
The available options in the Search Options tab depend on the type of object your are
looking for. You can also select a certain folder in the Search Folders tab. Check the
Scan Sub-folders box to include subdirectories of the directory.

Click Search. Results are displayed to the right of the search criteria. The results

include the following:

> Object name

> Object type

b Date the object was created

P Date the object was last modified

P Path where the object is stored (displayed when object is highlighted in the result

list)

If an error message is displayed stating that the query engine needs to be
updated, you must update the database. If you have Local Administrator privile-
ges see “Updating the database” below for instructions. Otherwise, see your
system administrator.

To open an object, double-click the object name.

To save the query, click Save. A small navigator opens. Select a location, enter a query
name, then click OK.

00

@ To close the search window, click Close from the File menu or click the X in the upper
right corner of this window.
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To execute a saved query:

o Find the query you want in the Navigator. The default location for saved queries is in
the Query folder under the Special Data folder for your user account.

o Double-click the query name to open the query in the Query window.

e In the Query window, click Search to execute the query.

8.3.1 Updating the Database

Occasionally, the LightCycler” Software 4.05 database may need to be updated, for exam-
ple if a LightCycler Software 4.05 release includes new query search parameters. When
this happens, the software displays an error message stating that the query engine needs
to be updated.

If your user account is assigned the Local Administrator role, follow the steps below to
update the database. Otherwise, see your system administrator.

Prerequisites:

® You must have Local Administrator privileges to update the database.
® There must be no other users using the database.

To update the database:

From the Tools menu, select Database Status.

Check the list of users in the Logged In Users tab. If other users are logged in, you
cannot update the database. (The button on the Query Engine tab is inactive.)

If no other users are logged in, select the Query Engine tab.

Click Update. You are reminded that the update will take several minutes.

Click Yes to clear the message and continue. After the database is updated,
a message states that the update is complete.

Click OKto clear the message. The Query Engine tab states that the query engine is
now up to date. A Reindex button is displayed.

Click Reindex. You are reminded that the reindex will take several minutes.

Click Yes to clear the message and continue. After the database is reindexed,
a message states that the reindex is complete.

Click OKto clear the message.

Close the Database Status dialog box.

00 00 0 000
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8.4 Measuring Fluorescence without Cycling

The Real Time Fluorimeter monitors the fluorescence of a sample without running a
cycling program. You can use the Real Time Fluorimeter to test the fluorescence of
different dyes or to develop novel uses of the instrument, such as measuring the
fluorescence of chemicals. Temperature and fluorescence data are displayed in a chart on
the Real Time Fluorimeter window.

To use the Real Time Fluorimeter:

In the Navigator, double-click the instrument name to open the /nstrument window.
The Real Time Fluorimeter tab is active.

| Instrument Mame | (e Instrument (| 170 Part ~|| Comnect SelTest |~ Move Carousel

‘ | Iretrument IdH | Instrument TWEH | Last Connested Cumputer” |

Fiezl Time Fluotimeter | Instument Logs |

Temperature 530 560 B10 640 670 705
Target Temp. °C | ‘ | | | ‘ ‘
E|
Seek Sample Real Time Fluorescence
1 s
Sample Size g - :gg
200 &
s F —®10
Gair | 2 =t}
o= ¥ — 670
= =
S| 7 = Tamw
610[q =
640 [q = o
6701 = g
706[q = g
- a
E
¥ Caltrated
Start RTF
10 20 30 40 50 B0 70 80 S0 100 110 120 130 140 130 160 170 180 130 200
Time (Seconds}

Place one or more capillary containing the chemistry you want to monitor in the
LightCycIer® carousel.

In the Target Temp field, type the temperature at which you want to monitor the
fluorescence.

In the Seek Sample field, enter the carousel position for the sample you want to
monitor.

Select a sample size.

©06 6 0 O

Click Start RTF. The Real Time Fluorimeter begins warming the instrument, finds the
sample, then starts reading the raw fluorescence output from the fluorimeter for each
channel. It plots the temperature and the fluorescence values on the RTF chart.

For sample fluorescence, the Y axis of the RTF chart represents the percentage of
maximum fluorescence. For temperature, the Y axis represents degrees Celsius. The
X axis represents time in seconds.

A key to the right of the chart indicates the colors assigned to each channel and to
the temperature (temperature is always red).

() Select or deselect items in the key to add or delete them in the chart.

o
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o When the temperature of the sample reaches the target temperature, as indicated by
the temperature line on the chart, note the fluorescence values for the channel of
interest. The current temperature and the fluorescence for each channel are also
displayed in fields above the chart.

LC 2.0 1406170
| Instrument Name|[L.C 2.0 1406170 | 140 Part [COK1 =] ] Conneet | SefTest |

“ Instrument Id| |Lc,m 70 | Instrument Type | ‘5 ] | Last Connected Computer| ‘LE 201406170 2t 127.0.01 ‘

Real Time Fluorimeter | Instrument Lags |

e Temperatwe 530 550 BI0 B40  EW 705
roslEey EE I ER G
|
Sample: 3 found Real Time Fluorescence
3 2] Geek
S ample Size —_—
204 [~ a0
Gain 7
50 =
501 =
1 P .
[ =
= q %3
00 P H
705 [1 = g g
L=l 5
H g
= &
Stop RTF =
¢ 2
3
1D 20 30 40 S0 60 70 80 0 100 110 120 130 140 150 160 170 180 180 200

Time (Seconds)

o (Optional) In the Gains box on the left, adjust the display for each channel to increase
or decrease the raw fluorescence signal.
If measuring a dye, be sure to adjust the gains for the appropriate channel.
For example, if the dye in the reaction mix is TagMan, adjust gains in channel 1;
if the dye is LightCyc/er® Red 640, adjust gains in channel 2.

e To measure fluorescence for a different sample in the instrument, enter the sample
position in the Seek Sample field, then click Seek.

@ (3-channel LightCycIer® Instrument only) Select the Calibrated option if you want to
set the instrument LED power to the factory-calibrated setting or deselect the Cali-
brated option to display a slider control; use the slider control to set the instrument
LED power as a percentage of maximum LED power.

Q When finished, click Stop RTF.
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8.5 Using Diagnostic Tools

LightCycler” Software 4.05 includes the following diagnostic tools used to monitor the
LightCycler” Instrument’s performance:

® A button used to perform an instrument self test

©® Instrument logs

8.5.1 Performing an Instrument Self Test

The instrument self test checks all instrument functionality, such as heating to the correct
temperature and rotating the carousel.

To perform an instrument self test:

o In the Instruments folder of the Navigator, double-click the instrument name to open
the Instrument window.

e Click Self Test on the instrument toolbar.
The software is locked while the self test is performed.

If an error occurs, the self test displays an error message and logs the error to the
instrument’s error log. See the next section for information about the error log.

If there are no errors, the software displays “Self test passed” when the self test is finished.

Do not start other software applications when performing an instrument self test.

It is recommended to perform an instrument self test once a day before starting the
LightCycler® runs. Always insert an empty carousel when performing an instrument
self-test.
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8.5.2 Viewing the Instrument Logs

LightCycler” Software 4.05 generates an Error Log and an Operation Log, which are both
located on the Instrument Logs tab of the Instrument window. You do not need to use
these logs in normal instrument operation. In case of an instrument problem you can
export a System Query Data object and forward it to your support representative. The
System Query Data object contains Error Log and Operation Log information as well as
the experimental data of the source experiment.

To view instrument logs:

° In the Instruments folder of the Navigator, double-click the instrument name to open
the /Instrument window.

e Select the Instrument Logs tab.

e The Total Runs and Total Measurements fields at the top of the tab indicate the total
runs completed and the total number of individual fluorescence measurements taken
since the instrument came from the factory. The fields are illustrated below.

Rieal Time Flucrimeter Instument Logs |
Tots Runs  Total Measurements
B O

Enor Log  Dperation Log |

Name [ User |Date | #f Samples | Aun Count | Measurements | Camm Log

e Select the Operation Log tab or the Error Log tab to view the related log. The logs
contain the following information:

> The Operation Log displays a list of the last 10 runs on the instrument. The log
includes basic information about each run, such as the run name and date. It also
lists the total number of runs and the total number of fluorescence measurements
on the instrument as of the end of the run. A Comm Log button is displayed at the
end of each row. Click Comm Log to display a list of all the commands executed in
this run.

P The Error Log lists all errors that have occurred on the instrument since the
instrument came from the factory. Each error includes an error number, the date,
and a remark (the error message). The error log information may be requested by a
support representative, if there is an instrument problem.
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8.5.3  Exporting a System Query Data Object

To export a System Query Data object:

0 In LightCycIer® Software 4.05 open the experiment you want to export.

o From the File menu, select Export.

e Navigate to a location to save the exported file, select System Query Data as the file
type, enter a file name, then click Save. The file is saved with an .ixo extension.
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2

Cinated ore 872970004 11 ey
Cieated by Cheistin Kist Dot U e E i o
8430,

E: 0
Madbed by 5 Savei [0 -] - -
Larmediegir Sren A [Som Bt e

Aurr Startedd ab 9/20/30
Inuttrorses Hame: G157
Ireimumeet Type: B Ch.
Instnurmect |0 LE_G157
(pesater Chiisting Kraus
Soltwale verson: LCG4 4.0

i

Fie rame: [ounses 56 Text
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[Obfect v B ()

typr
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8.5.4 Viewing Application Errors

Error messages generated by LightCycler® Software 4.05 are displayed in a message pane
at the bottom of the LightCycler” Software 4.05 window. You can choose to display or

hide the messages pane.

To display or hide the messages pane:

> From the View menu select or deselect Messages.

| | |

Type | Date | Time |Message
® Information 12.10.2004 13:01:30 The supplied password does not match user adminl
&Walniﬂg 1210.2004 13:03:09 User cancelled the save operation

i Front screen

Each error entry includes the date and time of the error, and the error message.
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9. Working with Preferences

LightCycler” Software 4.05 provides the following preferences you can use to customize
charts and samples and to set various default options:

Chart preferences  determines the default appearance and content of your charts.

Sample preferences determines the default sample names in the Sample Editor and the
default colors and line styles of samples in charts.

User preferences  determines default import and export directories and other settings.

A set of preferences can be copied (as a separate item) from the Roche folder to one or
more user folders in the LightCycler” Software 4.05 Navigator. When you open a prefer-
ences item in any folder, a window opens in the work pane to allow you to set the prefer-
ence options.

You can have multiple chart and sample items, each with different settings. You can then
choose the one you want to specify as the default.

Form preferences contains information about the last screen settings and cannot be
edited.

If all the preference items of a particular type, such as chart, are deleted, LightCycler®
Software 4.05 creates a new default preferences item when you log in.

This chapter explains how to

® Use each type of preference

® Create multiple instances of preference items and specify an instance as the default for
that preference type
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9.1 Using Chart Preferences

If copied from Roche folder, your user account includes an item called Chart preferences
that determines the default appearance and content of your charts. You can change the
default chart settings as needed.

You can also save a modified version of a chart preferences item with a new name and
then apply the preferences in place of the defaults. You can have as many different chart
preferences items as you want, each one defining a different look and feel for your charts.
For more information see Creating a Separate Preferences Item and Making it the Default.

You can override the current chart preferences for individual charts, analyses, or
experiments. See Overriding Default Chart Preferences.

To open the chart preferences item:

In your user folder in the LightCycler® Software 4.05 Navigator, open the Preferences
subfolder.

Double-click Chart preferences. The Chart preferences window opens in the work pane.

M LightCycler Software 4.05 - [Chart preferences] -1 x|
o Fle Edt View Took Window Help

=181 x|
Y fNew. @R, Eonabsi. | £30pen.  &3ae  @Fepor | fTempae. SEFunMaco
Mavigator [x] BT hfake defaut || Restore defaubt values |
A g & [ Tite Flusrescerce | Temperature | Standaid Cuve | Relative Guantfication |
s ¥ Visble
[E3) Gt Fluorescence Histar
L] Administration A - | &l
Dl - Hasls [Time =
£ Rocte se= [0 =] [
j Elv:n:z ?m:f ™ Bod T ltslic Cunent Fluorescenc
L [Contered 5| ’VEhar\ne\s EREnED ‘
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] Preferences s il
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Using the Chart preferences window, you can customize the following chart settings:
® Chart heading and label styles (using the three sections on the left).

® The content and appearance of specific types of charts (using the tabs on the right).
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9.1.1 Specifying Chart Heading and Label Styles

Use the following three boxes on the window to modify headings and labels:
Title Specifies the appearance of chart titles.

Axis title Specifies the appearance of the text below the X axis and to the left
of the Y axis on the charts.

Axis label Specifies the appearance of the measurement values on an axis, such
as the times on the X axis of a Fluorescence chart.

Each of the three sections has the same format options, except that the Title section
includes an option for title position.

To specify heading and label styles:

In the appropriate section, select or deselect the Visible check box to include or
exclude this type of text on charts.

Title
[+ izible
| &rial Black =l
[~ Bold [ Italic
IEentered j

e Specify the text appearance as follows:

b Select the typeface from the pull-down list in the first box.

b Select the type size from the pull-down list in the Size box or enter a value.

> To change the text color, click the colored bar to right of the Size box to display a
color palette. Select the color you want, then click OK.

> To make the text bold or italic, select the Bold or /talic check box (or both).

b (Title only) To position the chart title, select a position from the pull-down list in the
last box.

e Click Save in the global toolbar to save your settings.

Software
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9.1.2  Specifying the Content of Fluorescence Charts

The Fluorescence tab of the Chart preferences window controls the default appearance of
the fluorescence data displayed in these two fluorescence charts:

® The default axis value for the Fluorescence History chart that graphs fluorescence vs.
time, cycles, or temperature

® The default channels for the Current Fluorescence bar chart that displays the level of
fluorescence for each sample and each channel at a particular acquisition point

Both charts are displayed on the Online Data Display tab of the Run module and on the
Raw Data tab of the Summary module.

To specify fluorescence chart information:

° Select the Fluorescence tab (if not already selected).

Fluorescence | Temperaturel Standard Eurvel Relative Quanlificationl

Fluorescence History

# awist I Timne j

r—Current Fluorescence

Channels: IT I? I? IT I? I?

Fluorescence History

Fluorescence (560)

04z a2 19109 3128 4341
Time (h:mm:ss)

Current Fluorescence

Fluorescence
=

Samples

In the Fluorescence History box, select a value for the X axis from the pull-down list.

In the Current Fluorescence box, click each channel you want to include in the Current
Fluorescence bar chart.

o Click Save in the global toolbar to save your settings.
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9.1.3  Specifying the Content and Appearance of the Temperature Chart

The Temperature tab of the Chart preferences window controls the appearance of the
Temperature History chart, which displays temperature readings and fluorescence acquisi-
tion points. The chart is displayed on the Programs tab (where it is labeled “Overview”),
in the Online Data Display tab, and on the Raw Data tab of the Summary module.

To specify content and appearance of the temperature chart:

o Select the Temperature tab.

Flucrescence T emperature | Standard Eurvel Relative Quantification

Temperature History

M [soid R
¥ Show acquisitions
. IEircIe j

Temperature History

100

a0

g /

Temperature (°C)

o0 63 1758 3052
Time (h:mm:ss)

o To include or exclude temperature readings, select or deselect the Show temperature
box.

e To specify the appearance of the temperature lines on the chart:
> To specify line color, click the colored box under Show temperature to display a
color palette, select the color you want, then click OK.
> To specify line style, select a style from the pull-down list.
> To specify the line width, enter or select a value.

o > To include or exclude fluorescence acquisition points, select or clear the Show
acquisitions box.

e To specify the appearance of the acquisition points:
> To specify point color, click the colored box under Show acquisitions to display a
color palette, select the color you want, then click OK.
»To specify a point style, select a style from the pull-down list.

e Click Save in the global toolbar to save your settings.

Software
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9.1.4  Specifying the Appearance of Standard Curve Charts

The Standard Curve tab of the Chart preferences window controls the appearance of the
standard curve charts in quantification analyses. You can specify the appearance of the
curve and the sample points from which the curve is derived.

To specify the appearance of the standard curve and sample points:

° Select the Standard Curve tab.

Fluorescencel Temperature  Standard Curve | Relative Quantificationl

Standard Curve

Curve

Samples

. I Circle j

Standard Curve

36
349
329

304

Log Concentration

o To specify the appearance of the curve:
> To specify line color, click the colored box under Curve to display a color palette,
select the color you want, then click OK.
> To specify line style, select a style from the pull-down list.
> To specify line width, enter or select a value.

e To specify the appearance of the sample points:
> To specify point color, click the colored box under Samples to display a color
palette, select the color you want, then click OK
> To specify point style, select a style from the pull-down list.

o Click Save in the global toolbar to save your settings.
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9.1.5 Specifying the Appearance of Relative Quantification Charts

The Relative Quantification tab of the Chart preferences window controls the appearance
of Relative Quantification pairing charts and multicolor Relative Quantification charts.

The Pairing chart displays amplification curves for target and reference unknowns and
for target and reference calibrators. The curves for the unknowns have a different
appearance than the curves for the calibrators. You can customize these settings.

The charts in a multicolor Relative Quantification analysis display amplification curves
for target and reference samples that are in the same capillary. These samples have the
same sample name and sample color and therefore must be distinguished by different
line styles. You can customize these settings. For more information about Relative
Quantification analyses see Performing Relative Quantification analysis.

To specify the appearance of the Relative Quantification charts:

o Select the Relative Quantification tab.

Fluorescence | Temperature | Standard Curve  Felative Quantiication |

~Relative Quantification paiting

Calibrator

Samples

W [s0id =3
Relative Quantification multicolor

Target

IDash j

Reference

IDol j

Calibrator/Sample example

2526

)
=}
5]
&

1,526

1,026

Fluorescence (Hone)

0,526

0,026

{1 2 3 4 5 6 7 & 9 10111213 14 1516 17 15 19 20 21 22 23 24 25 26 27 25 20 30 31 32 33 34 35 36 37 38 39
Cycles

Multi-Color Rel Quant example

2526
2,026
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0,526

Fluorescence {Hone, Hone}

0,026
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Cycles

e To specify the appearance of the Calibrators in the Pairing chart:
> To specify line color, click the colored box under Calibrator to display a color palette,
select the color you want, then click OK.
> To specify line style, select a style from the pull-down list.
P To specify the line width, enter or select a value.
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9 To specify the appearance of the Samples (the unknowns) in the Pairing chart:
> To specify line color, click the colored box under Samples to display a color palette,
select the color you want, then click OK.
> To specify line style, select a style from the pull-down list.
> To specify the line width, enter or select a value.

@ Make the appearance of calibrators and samples different enough so that you
can easily distinguish them. Refer to the sample chart to view your choices.

o Specify the line styles of references and targets in the multicolor charts as follows:
P Under Target, select a line style for targets from the pull-down list.
> Under Reference, select a line style for references that is different from the Target
style.
> Refer to the sample chart to view your choices.

e Click Save in the global toolbar to save your settings.
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9.1.6  Overriding Default Chart Preferences

In some cases, you may want an individual chart, analysis, or experiment to use different
chart settings from the defaults you specified in the Chart preferences item. You can
override the default settings at the following levels:

® An individual chart
® All charts within an analysis
©® All charts within an experiment

When you specify custom settings at any of these three levels, the new settings take
precedence over the default values for the charts at that level.

To override chart preferences:

o Open the experiment and right-click the chart you want to modify.
To override preferences for all charts within an analysis or within an experiment,
right-click any chart in the analysis or experiment.

9 Select Chart Preferences.
A Chart preferences dialog box opens that contains options for the chart type similar
to those in the Chart preferences window, described above. However, the dialog box
includes an additional option for setting the chart X and Y axis scale.

& Chart preferences i B
Til s il s |abet
IV Visible IV Wisible IV Visible
il Black. =] | Jana =] | Jana =
[ Bod [ lalic IV Bod [ ltalic [ Bold [ Ialic
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e Before you make any changes, you must select the level at which to apply the changes.

In the Preference level area, select one of the following:

> Select the experiment name to apply the settings to all charts in the current
experiment.

b Select the analysis name to apply the settings to all charts in the current analysis.
(You must have opened the menu from an analysis chart for this option to be
available.)

b Select Chart to apply the settings only to the current chart.

@ The settings can be saved for only one level at a time. That is, if you make
changes at the chart level, then select the analysis level and make more
changes, then click Save, only the changes for the analysis level are saved.
The settings for a higher level do not override settings saved at a lower level.
For example, if you change the title color to blue at the chart level for a standard
curve and save the setting, then change the title color to green at the
experiment level and save the setting, the standard curve title remains blue;
it does not change to green.

e Change text settings in the Title, Axis title, and Axis label boxes, as needed.
For more information see Specifying Chart Heading and Label Styles, above.

Change the chart-specific settings (if any) in the box below the Title section.
The options displayed depend on the type of chart that was active when you opened
the dialog box. For some chart types, there are no chart-specific settings.

o

0 In the Axis scaling area, set the range of units for the X axis and Y axis and the
increment size.
If you select 0 as the increment size, the increment size is determined automatically.
If you set an increment size so small that the labels overlap, the setting is ignored and
the increment size is determined automatically.

o If you need to undo your changes and restore the previous values for the selected
level, click Restore current level values.

e When finished, click Save.
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9.2 Using Sample Preferences

You can modify the appearance of sample lines and points on LightCycler® Software 4.05
charts in two ways:

©® By modifying the sample preferences that apply to all experiments. You can modify the
default sample preferences item or create multiple versions of the default item and
apply the version you want.

® By overriding the sample preferences for the current experiment. You can override
preferences for multiple samples in the experiment or for an individual sample on a
chart.

You cannot change sample names for an existing experiment.

9.2.1 Modifying the Sample Preferences for all Experiments

If copied from Roche folder, your user account includes an item called Sample preferences

that determines the default sample names and the appearance of sample lines and points

on all LightCycler” Software 4.05 charts. You can change the settings in the sample

preferences item as needed. You can also save multiple versions of the sample preferences

item and then apply the preferences you want.

To modify default sample preferences:

() Asyou follow steps 3-8 below, remember that you can change settings for a contiguous
& group of samples at one time. To change settings for a group:

> Select the item you want to change for the first sample in the group.

> Hold down the Shift key, then select the same item for the last sample in the group.

b Press F2.

> Change the value for the last sample and press the Return key.

The changes are applied to all the selected samples.

o In your user folder in the Lightcyc/er® Software 4.05 Navigator, open the Preferences
subfolder, then double-click Sample preferences.
The Sample Preferences window opens in the work pane.
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e To include or exclude a sample in charts, select or deselect the sample’s checkbox.
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To change a sample’s default color, click the colored square next to the sample name
in the sample list to open a color palette.

Basic colors:

LCustom colors:
EEEEEEEEN
EEEEEEEEN

Define Custom Colars »> |

Cancel

° Select the color you want, then click OK.
The sample color appears next to the sample name in LightCycler® Software 4.05
analysis results and is used for sample lines and points in the charts.

e To change the default sample name, click the sample name, then type a new name.
The default sample name is applied to new experiments; existing experiments are not
affected.

e To change the line style used for the sample, click in the Line Style column, then
select a new style from the pull-down list.
For example, you can select a dashed line instead of a solid line.

Shaw|Color] Pas | Nams Line Style [ 'width [ Paint styls |
W 1 Samplel i i} Mathing

Sample 2 Mothing
Sample 3 Dash Mothing
Sample 4 BE“ HDat Mothing
Sample 5 asniel Mathing
Sample 6 DashDatDot Mothing
Sample 7 Solid 1 Mothing
Sample 8 Solid 1 Mothing

o m e W

To change the line width, click in the Width column, then enter a new width.

If you prefer to see a sample line as a string of measurement points, click in the Point
Style column, then select a style from the pull-down list. (If you prefer solid lines,
leave the Point Style set to “Nothing™)

e Click Save in the global toolbar to save your settings.

192 LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Working with Preferences

Using Sample Preferences

To create a separate preferences item and make it the default:

o In your user folder in the LightCycler® Software 4.05 Navigator, open the Preferences
subfolder, then double-click Sample preferences.

Modify the preferences, as needed.
For more information see 7o modify default sample preferences, above.

From the File menu, select Save As.

Navigate to a location to save the item, enter a name for the new preference item,
then click Save.

To make this sample preferences item the default, click Make Default in the

preferences title bar.

You can also specify the default sample preferences item using an option in the
User Preferences. For more information see Specifying User Preferences, below.

® 00 O

9.2.2 Overriding Default Sample Preferences

At times you may want to change the appearance of samples in just one experiment or
chart, without changing the defaults applied to all experiments. Or you may want to
change settings for a chart and then save the settings as a sample preferences item that can
be applied to other experiments.

At the experiment level, you can:

® Use a sample preference editor to change the appearance of multiple samples in the
experiment.

©® Apply an existing sample preferences item to the experiment.
©® Changing the appearance of an individual sample line.

® Save experiment settings as a sample preferences item.

® Clear any changes and reapply the default sample preferences.

You cannot change the sample names or positions in an existing experiment.

To use the preference editor to change multiple samples:

Open the experiment for which you want to modify the samples.

Right-click an experiment chart that contains sample information.

Select Sample Preferences.

Modify the settings, then click Save.

Modify the settings as you would if you were modifying the default sample prefe-
rences item. For more information see To modify default sample preferences, above.

o Click Save in the global toolbar to save the experiment with the new settings.

Your settings are applied to all the charts in the current experiment, but do not affect
other experiments or the default sample preferences settings. The settings are saved with
the experiment.

Software
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To apply a sample preference item to an experiment:

The sample preferences in a sample preferences item can be applied to individual
experiments.

Open the experiment for which you want to modify the samples.

Right-click any of the experiment charts that contains sample information.

Select Load Sample Preferences.

Select the sample preferences item from the navigator, then click Open.
The settings are applied to all charts in the experiment.

o 0000

Click Save on the global toolbar to save the experiment with the new settings.

To modify an individual sample line:

o Open the experiment for which you want to modify the sample line.
Make sure a chart is displayed that contains the line you want to change. In an
analysis module, select the sample in the sample list to display its line in an analysis
chart

e Move the mouse pointer over the line until the pointer changes to a hand, then right
click the line. A small dialog box opens containing settings for the line.

Sample preferences

Repl. of Standard 1

B [soid -2 3
INothing j

Save I Cancel |

e To change the line color:
> Click the colored box to open a color palette.
> Select a new color, then click OK

To madify the line style, width, and measurement symbol, select the values from the
pull-down lists. Click Save. The line is changed in all charts in the current experiment.

e Click Save in the global toolbar to save the changes with the experiment.
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To save experiment settings as a sample preferences item:

Open the experiment that has the settings you want to save as a sample preferences
item.

Right-click an experiment chart that contains sample information.

Select Save Sample Preferences.

Navigate to a location to save the sample preferences item, type a name for the item,
then click Save.

To reapply default sample preferences:

Open the experiment for which you want to reapply the default sample preferences.

Right-click any of the experiment charts that contains sample information.

Select Clear Sample Preferences.
The samples in the experiment charts are reset to the current default sample
preferences.

Click Save in the global toolbar to save the experiment with the settings.
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9.3 Creating a Separate Preferences Item and Making
it the Default

You can create multiple chart or sample preference items and then specify which item is
to be used as the default. You can change the default designation whenever you need to.

If you delete all instances of a preference item, such as all chart preference items, the soft-
ware creates a new default item the next time you log in. The settings are the application
defaults.

To create a separate preference item and specify it as the default:

° In your user folder in the Navigator, open the Preferences subfolder,
then double-click the default item for the preference type you want
(Sample preferences or Chart preferences).

Modify the preferences, as described in the previous procedures.

From the File menu, select Save As.

Navigate to a location to save the new preference item, type a name for the item,
then click Save.

To make this item the default, click Make Default in the preferences title bar.

The new default settings are applied immediately and will be applied as the default

preferences the next time you log in.

You can also specify the default preference items using options in User
Preferences. For more information see Specifying User Preferences, below.
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Specifying User Preferences

User preferences specify the following:

® Default directories to import files from and to export LightCycler” Software 4.05 files

to

® The default database folders in which to save LightCycler” Software 4.05 items, such as
experiments, macros, and queries

©® Which chart and sample preference item to apply as the default, when there are
multiple instances of a preferences item.

To specify user preferences:

Open the User preferences item.

To specify import/export directories, select the Directories tab
(if not currently selected).

User preferences

Dicioies | Folders | Preferences |

Import from: [C:\Program FilestRioche\LC54 08\Data

L]
|

Exportto:  |C\Program Files'Roche\ C54.05\Data

In each box, type a directory path on your local computer or click
then navigate to a location on your local computer or the network, then click OK.

To specify default folders, select the Folders tab.

User preferences

Direstaiies [FORES | Preferences |

Experiments: [System Adni

Special Data [System adminSpecial Datar

Color compensatior: [System Admin/Special DatadCCC/

Standard Cure:  [System Admin/Special DatarStd Curve/
Mekstandards: ~ [System Adrin/Specil DatarMel Std/

Queries: [5ystem admin/Special DatarQuen

Templates & Macros: [System Admin/Templates and Macias/

| Templates and Macios/

0 Eg o o g

In each box, type the path for the folder location in the Navigator or click 7]
to display a Navigator. Select the folder you want, then click OK.

To specify a preference item as the default, select the Preferences tab.

User preferences

Diectaries | Folders {Piefeiences’|

Chatts: Chart preferences

Samples: Sample preferences

Ll el L]

Foms: Form preferences

In each box, select the preference item you want to specify as the default for the
preference type.

The software prompts you to confirm the modifications when closing the
User preferences window. Click Yes to save your changes.
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10. Using Templates and Macros

Templates and experiment kits provide convenient ways to speed up the process of
creating an experiment.

A template is based on an individual item, such as a protocol or a sample list, that has the
information you want to use.

An experiment kit macro is a collection of templates, one for each portion of an experi-
ment, along with a program (called a macro) that automatically applies the templates and
runs the experiment.

Your user account must have the Expert User or Local Administrator role for you to
create templates or experiment kits. If your user account has the Standard User role, you
can execute an existing kit macro to run an experiment. You can also assign macros to
buttons on the Front window of the LightCycler” Software 4.05, for easy access. Clicking
a button executes the kit macro.

This chapter explains how to create templates and macros, how to apply templates and
run macros, and how to add macro buttons to the Front window.

10.1 Creating and Using Templates

Templates enable you to quickly reproduce frequently used items such as experiment
protocols, reports, and sample lists.

A template is based on an individual item, such as a protocol or a sample list, that has the
information you want to use. You apply the template to a blank item to quickly duplicate
the information. For example, you cannot rerun an experiment protocol, but you can
save the protocol from an existing experiment as a template. To reproduce the
experiment, you simply create a new experiment, then apply the template. You can
modify the new experiment created from the template, if needed.

10.1.1 Creating Experiment Module Templates

You can create a template for a single module of an experiment, such as a protocol, a
sample list, or an analysis module.

To create an experiment module template:

0 Create the module to be used as the template; be sure the module has all the settings
and other information you want to include in the template. Make the module active in
the work pane.

e From the 7ools menu, select Create Macro/Kit/Template.
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Select the option for the individual module type, then click OK
In the example below, a Genotyping analysis module is selected for the template.

Create Experiment Template E

= Experiment Kit bacro

Create a kit of macros and templates.

= Suto select colon compensatian,
= Current color compensation choizes,

om the Genotyping

settings.

oK I Cancel

Navigate to the location where you want to save the template (typically under the
Templates and Macros folder under your user name in the Navigator), enter a template
name (or accept the default name), then click OK.

10.1.2 Creating Report Templates

You can create templates also for reports.

To create the template:

o Open the report, then select and arrange the order of items you want in the report.

e From the 7ools menu, select Create Macro/Kit/Template.

e Navigate to the location where you want to save the template (typically under the
Templates and Macros folder under your user name in the Navigator), enter a template
name, then click OK.

10.1.3 Applying a Template

Templates created for experiment modules or reports are executed the same way. Follow
the instructions below.

@ The components of a complete experiment template are stored as individual

templates in the location you chose for the complete experiment. You can select and
apply these individual templates as you would any other experiment module
template.

To apply an individual template:

Open the experiment module or other item you want to apply the template to.

Click Template, or from the Tools menu, select Apply Template. ..

Find and select the individual template you want to apply, then click OK.
After applying the template, modify the item, if needed.

Click Save.

Software
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10.2 Creating and Using Experiment Kit Macro

An experiment kit macro is based on an existing experiment with its run protocol,
sample list, and analysis modules and reports. A kit macro includes templates for all the
components of the experiment and a program called a wizard used to run the kit macro.
When you run the kit macro, the wizard steps you through the process of choosing an
instrument, and then applies the experiment protocol and sample templates, starts the
experiment run, and after the run is finished, adds the analysis modules to the
experiment. The wizard gives you the opportunity to modify the protocol, sample list,
and so on, if needed.

A kit macro is stored as a single item in the database. You can export it as a file and then
import it into other LightCycler” Software 4.05 databases. For example, you might want
to create a kit for a commonly used protocol and then share it with other LightCycler”
Software 4.05 users.

To execute a kit macro you can use the Run Macro command on the toolbar or the Tools
menu. You can also link the kit macro with a macro button on the LightCycler” Software
4.05 Front window. Clicking the button executes the kit macro.
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10.2.1 Creating an Experiment Kit Macro

To create an experiment kit macro, your user account must have the Expert User or Local
Administrator role.

To create an experiment kit macro:

Open the existing experiment you want to use for the kit macro.

Be sure to include all the components you want in the kit: the experiment programs,
a sample list, color compensation (if needed), analysis modules, and reports.

With the experiment active in the work pane, from the 7ools menu,
select Create Macro/Kit/Template.

A dialog box similar to the following is displayed. (The second option depends
on which experiment module is currently displayed in the work pane.)

Create Experiment Template E

Create a kit of macroz and templates.

{* Auto select color compensation.
" Current color compenszation choices.

= Absolute Quantification Template

Create a template from the Absolute
Quantifization settings.

()3 I Cancel |

Select Experiment Kit macro (if not already selected), then click OK.

00

If the current experiment uses color compensation, select one of the following

options:

P Auto select color compensation The current color compensation data will not be
included in the kit macro. When the kit macro is executed, the software will search
for the last color compensation data set that matches the current instrument 1D
and the color compensation ID, entered on the Capillary View tab of the Sample
Editor (if any).

P Current color compensation choices The color compensation data for the current
experiment will be included in the kit macro.

o Navigate to the location where you want to save experiment kit macro (typically
under the Templates and Macros folder under your user name in the Navigator).

o Enter a template name (or accept the default name), then click OK.
An item for the kit macro is saved at the designated location.

Software
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10.2.2

Executing an Experiment Kit Macro

When you execute an experiment kit macro, LightCycler® Software 4.05 automatically
launches a wizard to guide you through the process of using the kit macro to run the
experiment. As you run the kit macro, you can modify sample information, run
parameters, and analysis parameters if needed.

To execute an experiment kit macro:

Click Run Macro or from the Tools menu, select Run Macro/Kit.

Find and select the kit macro name, then click Open.

A wizard Welcome window opens.

Welcome to the Experiment Kit Wizard.

The Experiment Kit ‘izard helps vou run a new experiment using
the provided kit The first step is to create the new experiment.

To start the wizard and create a new experiment, click Mext.
If you don't want ta create a new experiment at this time, click
Cancel.

< Back Mest > Cancel

Click Next, then follow the wizard prompts to select an instrument, load samples, and

run the experiment.

The wizard provides opportunities for you to modify the experiment protocol and
the sample information as e.g., the number of samples before proceeding with
the experiment. While you enter your modifications in the work pane the
Experiment Kit Wizard window will be open in front of the work pane. You can
move it to any area of the screen, if you need to see the whole work pane.

When the experiment is finished, the wizard generates the analyses and reports, if
these are included in the kit. If a report is displayed, you can modify report selections
to change the content of the report. You must close the report to view the experiment
analyses.
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10.2.3 Modifying a Kit Macro

If you need to modify a kit macro, you must create a new experiment that has the
modifications you want, then create a kit macro from the experiment. Save the new kit
macro using the name of the old kit macro to replace the old kit macro.

10.2.4 Sharing a Kit Macro with Other LightCycIer® Software 4.05 Systems

An experiment kit macro is a convenient way to share an experiment template with
others, because you can export the kit macro as a single file. The file has an .ixo extension.
The file can then be imported into another LightCycler” Software 4.05 system where it
can be executed as a macro or linked to a button on the LightCycler” Software 4.05 Front
window. Follow the procedures below to export and import an experiment kit macro.

To export an experiment kit macro:

o In the Navigator, double-click the kit macro name.

9 From the File menu, select Export.

e Navigate to a location to export the file, then click Save.

To import an experiment kit macro:

From the File menu, select /mport.

Select Object .ixo files.

Find and select the 1XO file for the kit macro you want, then click Open.

From the File menu, select Save.

Navigate to a location to save the kit, then click OK.
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10.3

Adding and Deleting Macro Buttons on the Front Window

If you create experiment kit macros, you can link each kit macro to a macro button on the
LightCycler” Software 4.05 Front window. Clicking the button runs the kit wizard.

Follow the instructions below to assign a kit macro to a button on the Front window. You
can add and delete macro buttons no matter what role is associated with your user
account.

To add a macro button:

If the LightCycIer® Software 4.05 Front window is not currently displayed, click Front
screen in the taskbar or select it from the View menu to display the window.

Click Add. If Add is not visible on the window, click the arrow next to Macro to display
Add / Delete.

The Select Macro/Kit dialog box opens, as shown below.

258 gl U b Sl wwamrs 4,135 - [Frasisk sirmen] =l =
of Fin E® Vew Tk Wedow Heb =lelx
J O tew. L A &l | Siem & e L )

M_E i‘@ e\;

5y Preferencer New Experiment

- __} Templates and Macros Analysis

% | Expesiment Macior Roche Macro
Cokor Compentaion S Macrov

) P Terrpdes
i S Lish Tornpabns
B | Floche Serven ) Terrplates ard Macos
[ ) Sharabond Usen | At Tovrgiales
=2 | Exprtwoet Macios
= B | Do Mascans

[Cokn Cormpennaton Sl Macas [Col Ho (115354
Muhcoier Ciemo St O Macin [Cat No (35248
Mudticolos Cama St Macro [t Na (3628554

) Preport Temglares
__1 Fun Templales
| Sampl List Templatey
3| Moche Sendce
| Standd Uset
- _] System Advin
4 |3
T JE
| |
|drrnnn|-=—|
Lpped on b LocaEion s System Adn [esesech

Find and select the experiment kit macro you want, then click Open.

(5]

A button labeled with the kit macro name is added to the window below Add / Delete.

o

To execute the kit macro, click the button.

To delete a macro button:

If Delete is not visible below Macro on the LightCycIer® Software 4.05 Front window,
click the arrow next to Macro and click Delete.
A list of all macro buttons is displayed.

Select the button to delete, then click OK.

The button is deleted from the window.
Only the macro button is deleted from the window, not the macro itself.
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11. Managing User Access

To use LightCycler” Software 4.05, you must have a user account in the LightCycler”
Software 4.05 database. User accounts have different levels of access to the software,
depending on the role assigned to the account and the groups to which the account
belongs.

This chapter explains the function of user accounts, roles, and groups, and explains how
to manage them using the LightCycler” Software 4.05 User Management tool. The
chapter also explains how to change a user password.

Read this chapter if you are responsible for creating or modifying user accounts or if you
want to understand the privileges associated with your account. Read the section on
passwords if you need to change your password.

Your own user account must have the Local Administrator role for you to use the User
Management tool.

11.1 Understanding User Accounts

A user account provides access to the LightCycler” Software 4.05. The user account
specifies the user’s login name and password and defines the user’s level of access to the
software.

When you create a user account, you must assign it a role. The role determines the tasks
the user can perform using the software. For more information see Understanding Roles
below. You can also add a user account to one or more groups. Users in the same group
have access to each other’s objects. For more information see Understanding Groups
below.

Each user account has a default folder in the LightCycler” Software 4.05 Navigator, with
several default subfolders. The user’s default folder and subfolders cannot be deleted,
renamed, or moved. However, each user can create additional folders underneath the
default folders.

A user called System Admin is created automatically when LightCycler” Software 4.05 is
installed. The System Admin user has the Local Administrator role and is used to create
other user accounts. The System Admin account cannot be edited or disabled, but the
default password can be changed.

A user account once created can be made inactive. An inactive user account cannot have a
role and cannot be assigned to a group.
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11.2 Understanding Groups

A group is a collection of user accounts. The members of a group have access to each
other’s objects; for example, they can open each other’s experiments.

If users belong to more than one group, they need only one group in common to have
access to each other’s objects. For example, if user Bob belongs to Groups A and B, while
user Susan belongs to Groups B and C, both Bob and Susan have access to each other’s
objects because both are members of Group B.

The level of access a user has to another user’s objects is determined by the user’s own
role. For example, if Bob has the Standard User role, he can open and execute Susan’s
experiments. If Susan has the Expert User’s role, she can open, execute, modify, copy,
move, or delete Bob’s experiments. See the next section for more information about roles.

11.3 Understanding Roles

Each user account is assigned one and only one role. The role determines the user’s
privileges. There are four roles:

® Standard User
® Expert User
® Local Administrator

® Roche User

Roles cannot be created or deleted, but certain access privileges can be enabled or
disabled for each role. For more information see Working with Roles below.
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11.3.1 Privileges of the Standard User Role

A Standard User has limited access to the LightCycler® Software 4.05. A Standard User
can do the following:

> Use macros to execute and analyze experiments (if the analyses are included in the
macros).

» Modify, move, copy, and open or execute the user’s own objects. For experiments, this
includes modifying sample names, target names, sample notes, analysis notes, and the
sample count (before the run begins). The standard user can include or exclude
samples from the experiment’s analysis only if enabled by the Local Administrator.

» Open or copy objects, and execute macros owned by a Local Administrator or the
Roche User.

» Open or copy objects, and execute macros in other Standard Users” and Expert Users’
folders, if the other users are members of the same group as the Standard User.

A Standard User cannot do the following:

> Use the Run programming window to create experiment programs from scratch or to
refine experiment programs.

> Add analyses to experiments.

» Use the analysis toolbar to modify analysis settings, such as program or color
compensation.

> Create macros or templates.
» Modify or move objects belonging to other users.

> View folders or objects belonging to users who are not in the same group as the
Standard User.

> Delete, move, copy, or rename default folders (including the user’s own default
folders).

> Delete any object (including the user’s own objects).
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11.3.2 Privileges of the Expert User Role

An Expert User can do the following:
P Use the Run programming module to create and execute experiments.
> Create and use templates and macros to execute experiments and analyze results

P Create all other objects and open, copy, execute, modify, and move any of the user’s
own objects. For experiments, this includes modifying sample information, the
sample count (before the run begins), adding an analysis to the experiment, including
and excluding samples from the analysis, and using the analysis toolbar to change any
of the analysis settings.

P Delete the user’s own objects and nondefault folders, if enabled by the Local
Administrator.

> Open, copy, and execute objects owned by the Local Administrator or the Roche User.

> Open, copy, and execute objects owned by other Expert Users, if the other users are in
the same group as this user.

b Create, open, copy, execute, modify, delete, and move items in a Standard User’s folder,
if the Standard User is in the same group as the Expert User.

An Expert User cannot do the following:

P Create, delete, move, modify, or rename objects belonging to the Local Administrator,
the Roche User, or to Expert Users.

> See the folders or objects belonging to Standard and Expert Users who are not in the
same group as the user.

> Delete, move, copy, or rename default folders (including the user’s own folders).
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11.3.3 Privileges of the Local Administrator Role

A Local Administrator can do the following:
P Use the Run programming module to create and execute experiments.

> Create and use existing templates and macros to execute experiments and analyze
results.

> Create all other objects and open, copy, execute, modify, delete, and move any of the
user’s own objects. (Modify rights include modifying sample information, adding an
analysis to the experiment, and using the analysis toolbar to change any of the analysis
settings.)

> Open and execute items belonging to other Local Administrators and copy items from
Local Administrators.

> Open, execute, and delete items in the Roche folder.

> Create, open, copy, execute, modify, delete, and move objects in folders belonging to
Standard and Expert Users.

> Use the User Management tool to manage users and groups; for more information see
Managing Users, Groups, and Roles below.

The Local Administrator cannot do the following:
> Modify or move objects in the Roche folder.

> Move, delete, or modify objects owned by other Local Administrators; for example
one administrator cannot copy objects into another administrator’s folder.

> Delete, move, copy, or rename default folders (including the user’s own folders).

11.3.4 Privileges of the Roche User and Roche Role

The Roche User is a special, predefined user account that is assigned the Roche role.
Neither the Roche User nor the Roche role is visible in the User Management tool. Only
representatives from Roche have the user name and password needed to log in as the
Roche User.

The Roche User has access to the Roche folder, which contains objects, such as
experiment protocols and standard curves, supplied by Roche.
The Roche Role allows the Roche User to do the following:

> Create, modify, move, execute, copy, and delete items and subfolders in the Roche
folder.

> Create, modify, move, execute, copy, and delete subfolders and items belonging to
other users, only if enabled by a Local Administrator.

The Roche User cannot do the following:

> Delete, move, copy, or rename the Roche folder or user folders.
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11.4 Managing Users, Groups, and Roles
The User Management tool allows you to
©® Create, modify, enable, or disable user accounts.

©® Assign roles to user accounts and change role assignments (you cannot create, modify,
or delete roles).

® Create or delete user groups and assign users to groups.

You must have the Local Administrator role to use the User Management tool.

To open the User Management tool:

> From the Tools menu, select Manage Users.
The main window of the User Management tool is shown below. Work with Users is
selected by default.

§ Admin ger
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11.4.1 Working with Users

To create a new user account:

o In the User Management Tool, click Work with Users (if not already selected).
o Click New User.

e Enter the user’s full name, login name, and password and select a role for the user.

° Check each group you want to add the user to. If no groups have been created, you
can add the user when you create the group.

e Click Done.

A default folder for the new user is added to the Navigator, and the user name is added to
the list of users in the \Administration\Users folder in the Navigator.

Navigator X

& - -

5] Root
=1 5] Admiristiation
]3] Groups
H ﬁ Lah1
ﬁ Labz
(] Roles
Bl ] Uzers
© e & Admin User
% Army Claytan
& Richard Davis
ﬁ; Systern Admin
<@ Datshaze version infarmation
2 fg.‘} Security Palicy
(] Instruments
[ | Admin User
B~ | Amy Clayton
| Roche
B
B

#]-__| Richard Davis
7| System Admin

In the example above, four user accounts and two groups are listed in the Navigator. The
user accounts are

Admin User
Amy Clayton
Richard Davis
System Admin

Note that each user account has its own user folder.

The groups are
Labl
Lab2
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To edit, enable, or disable a user account:

In the User Management Tool, click Work with Users (if not already selected).

Select the user's name in the right pane, then click Edit User.

Change any of the user fields as needed. If you selected System Admin, the only
information you can change is the password.

To disable the user account, select the Access Disabled check box; to reactivate a
disabled account, clear the Access Disabled check box. You cannot disable the
System Admin account.

® © 000

When finished, click Done.

To delete a user account:

0 Disable the user account you want to delete as described above.

e Right-click the disabled user in the Navigator and select delete to empty the folder,
if the folder contains objects.

e Select the user's name in the User Management Tool and click Delete User.
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11.4.2 Working with Groups

To create a new group:

In the User Management Tool, click Work with Groups.

Click New Group.

Type a name for the group in the Group Name box.

To add users to the group, check the names of the users you want to add.
(You can create a group without adding users.)

o Click Done.

If you did not add users to the group, a message asks you to confirm saving the
group without users. Click OK.

The group is added to the Groups folder in the Navigator.

Software
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To edit a group:

o In the User Management Tool, click Work with Groups.

e Select the group name in the right pane.

e Click Edit Group.

o Change the group name or select and deselect members of the group. You can also
assign a group to a user when you edit the user account. See Working with Users
above.

e Click Done.

To delete a group:

In the User Management Tool, click Work with Groups.

Select the group name in the right pane.

Click Delete Group. You are prompted to confirm the deletion.

Click Yes to delete the group.
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11.4.3 Working with Roles

You cannot create or delete roles, but you can change a user’s role assignment. You can
also modify certain of the access rights associated with the Standard User, Expert User,
and Roche User roles. You cannot modify access rights of the Local Administrator role.
You can also determine the time when a user is automatically logged off and determine
the maximum login attempts before access is disabled on entering an invalid password.

To change a role assignment:

o In the User Management Tool, click Work with Roles. Roles are displayed in the work
pane.

e Click the + next to a role to display a list of users assigned to the role.

e To change a user’s role, select the user’'s name, then drag the user name to a new
role.

o Click Done.

You can also change a user’s role assignment when you edit the user account. See Working
with Users above.




216

Managing User Access
Managing Users, Groups, and Roles

To modify a role’s access rights:

o In the User Management Tool, click Edit Access. The access window displays the
available options. Initially, all options are selected.

& LightLycler software 1.05 - [Manage Users]

i Mo Edk Vow Tools Window Hep
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o In the Logout on Inactivity area, enter a value in the Minutes of Inactivity before
Auto-Logout box or keep the default. Deselect the Enabled box to disable the
Auto-Logout function.

e In the Disable Access on Invalid Password area, enter a value for the Maximum Login
Attempts or keep the default. Deselect the "Enabled" box to disable this function.

@ Exceeding the maximum login attempts blocks the access to your account.
Contact your system administrator.

o Enter a value in the Password expiration days box or leave the default.
e Select or deselect access rights for each role.

To unblock a user account:

o In the User Management Tool, click Work with Users (if not already selected).

e Select the disabled user's name in the right pane, and then click Edit User.

e Clear the Access Disabled check box, and then click Done.

You need local administrator rights to unblock a user account.
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11.5 Changing your Password

When you are assigned an account on the LightCycler” Software 4.05 system, you receive
an initial password you can use to log on to LightCycler” Software 4.05 the first time. You
should change this initial password as soon as possible.

To change your password:

> From the Tools menu, select Change Password. The Password dialog box is displayed.

& Password O] x|

FPazzward: I

Mew Pazzword: I

Confirn Paszword: I

ak I Cahicel

> Enter your current password in the Password box.

> Enter the new password in the New Password box and again in the Confirm Password
box. Click OK.

The password must contain at least six characters and contain one number and one
upper case character.

Passwords are case-sensitive.

Remember the password or keep it in a secure place. Do not share your password with
others.

Software
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12. Installation of LightCycIer® Software 4.05

The complete LightCycler® software version 4.05 includes the LightCycler® Software 4.05
application, a database, and an object server. If you have received a license to install the
LightCycler® Software 4.05 also on a second or several other local computers e.g., for data
analysis, follow the installation instructions below.

This chapter explains how to install LightCycler® Software 4.05. It includes the following
topics:

® Overview of software installation

©® Hardware and software requirements

® Installing LightCycler® Software 4.05

® Saving an existing database and installing additional databases
® Removing LightCycler® Software 4.05

® Changing the default administrator password and creating user accounts

12.1 Overview of Software Installation

LightCycler® Software 4.05 controls the LightCycler® 2.0 Instrument using information
you provide in an experiment protocol. The LightCycler® Software 4.05 includes the
LightCycler® Software 4.05 application, a database, and the database object server (called
“Exor 3”), which communicates with the database. The software needs to be installed in a
local configuration.

In this configuration all the software components are installed on the LightCycler®
computer connected to the LightCycler® 2.0 Instrument. Each instrument and computer
function together as an independent system with its own database and its own set of user
accounts. Computers not connected to an instrument, which can be used for the
LightCycler® Software 4.05 application tools but not for running an experiment, are
independent systems as well.

The LightCycler® 2.0 Instrument must not be connected to a network, although
network hardware is present. Being connected to networks inherently carries a risk
that the connected instrument may be infected by viruses and worms as well as
targeted for attacks by malicious attackers. Roche is not responsible for any damages
caused by connection of the LightCycler® 2.0 Instrument to a network by the
customer.

12.2 Hardware and Software Requirements

For hard- and software requirements of the computer used to connect to the
LightCycler® 2.0 Instrument or to launch the LightCycler® Software 4.05 for data
analysis, please refer to chapter B System Description.
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12.3 Installing LightCycIer® Software 4.05

o Insert the LightCycIer® Software 4.05 CD. Double-click
LightCycler_Software_405_Setup.exe, if installation doesn’t start automatically.
The installation process transfers files, extracts the files, and then prepares the
installation wizard. The InstallShield Wizard Welcome window opens. Click Next.

Installshield Wizard ] |

Welcome to the InstallShield Wizard for LCS4.05

The InstallShield® wizard will inztall LC54.05 on your
computer. To continue, click Mest.

< Back

Cancel |

e Your are prompted to agree to the license conditions. Click Yes.

Installshield Wizard '

Software License Information

Fresz the PAGE DOWHM key to zee the rest of the agreement.

IS OFT'/ARE LICEMSE AGREEMENT i’

Fead the following terms and conditions of this Software License Agreement

["&agree-ment''] carefully befare installing the LightCucler Software 4.05, hereinafter referred

to az ["SOFT'WWARE"). Procesding with the installation of the SOFTWARE will constitute
accep-tance of the terms and conditions of thiz Agreement. By accepting the terms and
condi-tioks of this Agreement, the end-user ['Licensee"] azzumesz all rezponsibility and

liability far the zelection of this SOFTWARE to achieve the intended rezultz, and for itz
installation and subsequent uze. If Licensee iz not wiling to be bound by the terms and
conditionz of thiz Agreement, the SOFTWARE package must be promptly returned to LI

Do vou accept all the terms of the preceding Licenze Aareement? IF you chooze Mo, the
zetup will close. Toinstall LCS4.05, you must accept this agreement.

IrstallShield

< Back e Ha

Software
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Select the default settings to install the database engine or browse to select a
location. Click Next.

Installshield Wizard

Choose Destination Location

Select folder where Setup will inztall files.

Flease select the location for the database engine.

C:\Program FileshFoche\E=ord Bink Browse. .. |

ImstallS hield

" Drestination Folder

< Back

Cancel |

Select the default settings to install the database file or browse to select a location.
Click Next.

InstallShield Wizard

Choose Destination Location

Select folder where Setup will install files.

Please select the location for the databaze file.

C:\Program FileshRochehExor3sData Browse., . |

InztallShield

" [ estination Folder

< Back Cancel
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In the Setup Type window select Exor DB without an audit trail (for research). Click
Next.

InstallShield Wizard [

Setup Type
Chooze the setup type that best suits pour needs.

Fleaze select a desired database.

" Exor DE with an audit trail

' Exor DB without an audit trail [for research);

|nztallShield

< Back | Mext » I Cancel

The software prompts you to name the new database. Enter a database name or
leave the default, then click Next.

InstallShield Wizard b

Enter Text
Please enter information in the field below.

Please name thiz D atabaze,

|mtallShield

< Back | Meut » I Cancel
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If a database with the same name already exists, you are prompted to use the existing
database or create a new database with the same name. Click Next.

Installshield Wizard

Setup Type

Choose the setup tupe that best suits your needs.

A Database by that name already exizts, pleaze zelect a option.

¥ ze the existing database file

" Cieate a new database named <DMS_R.IB.

InztallShield

< Back | Mext > I Cancel

() When you select Create a new database with the same name, the software
o automatically stores your old database with a time stamp in the database

directory.

Select the default settings to install the LightCycIer® Software 4.05 or browse to
select a location. Click Next.

Installshield Wizard

Choose Destination Location

Select folder where Setup will install files,

Please select the location for the LES4.05 Software,

Destination Folder
’7E:\Prngram Filez\Roche\LC54.05 Browse. .. |
InztallShield
¢ Back Cancel |
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Select the location for program icons. These are locations to start the LightCycIer®
Software 4.05 from. Deselect the icon locations you do not want, and then click Next.

InstallShield Wizard

Setup Type
Chooze the setup type that best suits vour needs.

Flease select desired icons.

[V Database compaction kool

v Ewxor3 Pragram Menu loon
W Exor3 Startup Menu lcon

¥ LC54.05 Desktop loon

v LC54.08 Program Menu lcon

|mztallShield

¢ Back | Mest » I Cancel

@ Installation of InterBase starts. In the Welcome screen click Next to continue. Accept
the license conditions by clicking / Agree. When the Installation Completed window
appears, click Finish to finish the InterBase installation.

% InterBase 6 Open Edition - 6.0.1.6 Installation m

Welcome!

T hiz inztallation program will ingtall InterB aze 6 Open E dition -
£.0.1.5.

Press the Mest buttan to start the installation. *'ou can press
the Cancel button now if you do not want to inztall InterB aze B
Open Edition - 6.0.1.5 at thiz time.

LCancel |

Software
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@ When the InstallShield Wizard Complete window appears, the installation is complete.
Click Finish. After a reboot of the computer you can launch the software by pressing
the LightCycIer® Software 4.05 icon.

InstallShield Wizard

InstallShield Wizard Complete

Thiz wystem needs to be reboated in order to establish
connechion to database

ez, | want to restart my computer o,

% Mo, | will restart my computer later

Femave any dizks from their drives, and then click Finish ta
complete setup.

¢ Back | Finizh I Cancel

The installation process installs the following icons on the desktop:

o
LightCycler® Software 4.05 icon 9 , Exor 3 icon E-I-

;
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12.3.1 Saving an existing database and installing additional databases

For backup purposes save a copy of your database routinely. Before saving the database,
make sure the size of the database is equal to (or less than) 700 MB, the capacity of one
CD. To check the size of your database, proceed as follows:

To check the database size:

o In the Windows Explorer select C:\Program Files\Roche\Exor3\Data (the path corre-
sponds to the default setting during installation; it may vary depending on what you
entered during installation of the database file. See also /nstalling LightC)/cler®
Software 4.05, step 4).

o Right-click on the database (*.IB) you want to check. From the menu select
Properties; read the size from the corresponding menu item.

When you need to compress the database file (e.g., if the database has exceeded the size of
700 MB), you can use the CompactIB tool.

To compress a database file:

o Shutdown all running database engines by right-clicking the Exor3 icon in the system
tray and selecting Shutdown.

e In the Windows Explorer select C:\Program Files\Roche\Exor3\Data (the path
corresponds to the default setting during installation; it may vary depending on
what you entered during installation of the database file. See also /nstalling
LightCycler® Software 4.05, step 4).

Right-click on the database you want to compress. From the menu select Properties
and then select the Security tab. Check the Allow box for Full Control and Modify.
Click OK.

In the Start menu select Programs/Roche/Compact!B.

The Compact Interbase Database File window opens. In the Database File to Compact
box enter the directory of the database or click ..i| then navigate to a location, then
click Open.

Click on Compact to start the process.

© 00 o

To save a database file:

o Shutdown the Exor3 by right-clicking the Exor3 icon in the system tray and selecting
Shutdown.

o Save the database (*.IB) on a CD by following the procedure described in Using the
CD-RW drive.

Software
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To install additional databases:

If the LightCycler® Software 4.05 is already installed on your computer, you can use the
LightCycler® Software 4.05 installation utility to install additional databases:

o Shutdown all running database engines by right-clicking the Exor3 icon in the system
tray and selecting Shutdown.

e Insert the LightCycIer® Software 4.05 CD. Double-click
LightCycler_Software_405_Setup.exe, if installation doesn’t start automatically.

e The Setup Type window is displayed. Leave the default setting /nstall a database file,
and then click Next.

Installshield Wizard

Setup Type
Choosze the setup twpe that best suits your needs.

Pleaze select a optian,

& in .
" Uninstall LightCyclerSoftwared. 05

InztallShield

< Back | Hext > I Cancel
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Select the default settings to install the database engine or browse to select a
location. Click Next.

InstallShield Wizard b

Choose Destination Location

Select folder where Setup will inztall files.

Fleaze select the location for the databaze engine.

C:\Program FileshFochesERord\Bink Browse. .. |

|mtallShield

" Diestination Folder

< Back

Cancel |

Select the default settings to install the database file or browse to select a location.
Click Next.

Installshield Wizard [

Choose Destination Location

Select folder where Setup will inztall files.

Fleaze select the location for the database file.

C:\Program Files'RochehEsor3tData Browse. . |

|nstallShield

" Destination Folder

< Back

Cancel |
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In the Setup Type window select Exor DB without an audit trail (for research). Click
Next.

InstallShield Wizard [

Setup Type
Choose the setup tupe that best suits your needs.

Please select a desired databasze.

™ Exor DB with an audit traik

% Exor DB without an audit trail [for research)

InztallShield

< Back | Mext > I Cancel

The software prompts you to name the new database. Enter a database name or
leave the default, then click Next.

Installshield Wizard I
Enter Text
Please enter information in the field below.

Pleaze name this Databaze.

HDMS_F_2

InstalShield

< Back | Hext > I Cancel
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If a database with the same name already exists, you are prompted to use the existing
database or create a new database with the same name. Click Next.

InstallShield Wizard

Setup Type

Chooze the setup type that best suits your needs.

& Database by that name already exists, please zelect a option.

% {lse the existing databage file

" Create a new database named XDMS_R.IE.

|mztallShield

< Back | MNest > I Cancel

(\ When you select Create a new database with the same name, the software

. . . . .

' automatically stores your old database with a time stamp in the database
directory.

The software prompts you to enter a port number for the database. Leave the default
value or enter a unique port number, then click Next.

InstallShield Wizard

Enter Text

Fleasze enter information in the figld below.

The next avaliable port number iz 20283, Pleaze enter in desired port number or select Mext to
uze thiz walue. & unique port number is required to run multiple instances of the database
engine simultaniouzly,

[2ozs3

|nstallShield

< Back | Mext » I Cancel
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Select the location for program icons. Deselect the icon locations you do not want,
and then click Next.

Installshield Wizard I

Setup Type
Choose the setup tupe that best suits your needs.

Please select the desired icons:

¥ Program Menu [ con

¥ Start Menu lcon

InztallShield

< Back | Mext > I Cancel

m A message states that the maintenance is complete. Click Finish.

Installshield Wizard I

Maintenance Complete

InztallShield Wizard haz finished performing maintenance
operations on LC54.05,

<Back [ Finsh Cancel
. . . . y
The installation process installs another Exor3 icon on your desktop: IEF"
Exor3 For
¥DM3_Re_2

@ You must start the newly-installed Exor3 either by double-clicking on the icon on your
desktop or by rebooting the system, before you can log on to the new database.
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12.3.2 Logging on to different databases

You can log on to an additionally installed database by selecting the database in the Log on
to pull down menu.

To include an additionally installed database:

Double-click the LightCycIer® Software 4.05 icon to launch the LightCycIer®
Software 4.05.

e A login dialog box opens. Click on Options to display the list of known object servers.

x

Uzer name:

Iadmin

Pazsword:

Log on bo:

I LocalE xor3 j

Lizt of known Object Servers:

Mame | Location | dd
LocalE=or3  localhost

Bemaove. .

Edit...

Add |
[ v
B

o Login | x Cahcel |

Click on Add. An Objekt Server Properties window opens.

Enter a name for the database and its location. The location is always composed of
the word “localhost” and the port number of the database to be integrated, divided by
a colon. Click OK.

Object Server Properkies il

MName IHesealch [atabaze

Loeation {localhost 20283

Ok I Cancel

(:\ To figure out the port number for a database, point at the Exor3 icon in the
w/ system tray, and then read the object server’s properties from the display.

Exor 3 - ¥ML Object Server
Path = C:\Program Files\Roche\Exor3iDatal xDMs_R_2.1B
Pork = 20283

Software
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The database is included in the List of known Object Servers and can be selected in
the Log on to box.

opn

Uzer name:

Iadmin

Pazzword:

Log on bo:
I Research Database j

Lizt of known Object Servers:

Mame | Location | Add.

LocalExor3 lozalhost
Reszearch Databaze localhost: 20283 Bemove...

ui

Edit..

Q/I__Dgin I x Cancel | << Options |

Select a database in the List of known Object Servers and click on Remove to remove
it, or click on Edit to change the name or location of the database.
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Replacing an existing database file by a database file of the same name

You can replace an existing database file by a database file of the same name e.g., after
reinstalling LightCycler” Software 4.05 (no additional Exor3 service necessary).

To replace an existing database file through a database file of the same
name:

o Exit the LightCycIer® Software 4.05.

e Shutdown database engine corresponding to the database to be replaced by right-
clicking the Exor3 icon in the system tray and selecting Shutdown.

e In the Windows Explorer select C:\Program Files\Roche\Exor3\Data (the path
corresponds to the default setting during installation; it may vary depending on what
you entered during installation of the database file. See also Installing Lightcyc/er®
Software 4.05, step 4).

e Right-click on the database you want to replace. From the menu select Properties and
then select the Security tab. Check the Allow box for Full Control and Modify. You can
now delete this database or store it under a different name.

¥DMS_R.IB Properties 2 x|

General  Security | Summal_l,.ll

Group or user names:

ﬂE Adriniztrators (R 2k%W 01 2357 Adminiztratars]

Add... | Bemove |
Permizzions for Administrators Al Deny
Full Cantral O
Madify O
Fiead & Execute O
Fead a
"Write a
Special Permissions O a

For special permissions of for advanced settings, |1
click Advanced. :

oK Cancel Apply

e Copy the database file to be restored e.g., from a CD, into the database directory.
@ The name of the database must be identical with the name of the deleted
database. Rename the database if necessary.

o Disable the access rights for the database regarding Full Control and Modify. If you
restored the database from a CD, right click on the database file and clear the Read-
only box in the Properties menu on the General tab.

Start the Exor3 Service by double-clicking the icon on your desktop.

Start the LightCycler® Software 4.05.
@ To log in on the restored database you must enter the User name and Password
for this database.
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Integrate a restored database file as an additional database in LightCycIer®
Software 4.05

You can integrate an additional database e.g., a restored database from a CD, in the
LightCycler” Software 4.05 (additional Exor3 service necessary).

To integrate an additional restored database file in LightCycler Software 4.05

° Copy the database file e.g., from a CD, in the database directory. Assure that
database names are unique.

Check if the access rights for the database regarding Full Contro/ and Modify are
disabled, and clear the Read-only box in the Properties menu on the General tab, as
described above.

Shutdown all running database engines by right-clicking the Exor3 icon in the system
tray and selecting Shutdown.

Insert the LightCycIer® Software 4.05 CD. Double-click
LightCycler_Software_405_Setup.exe, if installation doesn’t start automatically.

® 6 0 O

In the Setup Type window select /nstall a database file. Click Next.

Installshield Wizard

Setup Type
Chooze the zetup twpe that best suits vour needs.

Fleaze zelect a option.

& in
£ Uninstall LightCyclers aftwared. 05

InztallShield

< Back I Hext > I Cancel
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Select the default settings to install the database engine or browse to select a
location. Click Next.

InstallShield Wizard b

Choose Destination Location

Select folder where Setup will inztall files.

Fleaze select the location for the databaze engine.

C:\Program FileshFochesERord\Bink Browse. .. |

|mtallShield

" Diestination Folder

< Back

Cancel |

Select the default settings to install the database file or browse to select a location.
Click Next.

Installshield Wizard [

Choose Destination Location

Select folder where Setup will inztall files.

Fleaze select the location for the database file.

C:\Program Files'RochehEsor3tData Browse. . |

|nstallShield

" Destination Folder

< Back

Cancel |
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e Select Exor DB without an audit trail (for research).

InstallShield Wizard ] x|

Setup Type

Chooze the setup type that best suits vour needs.

Flease select a desired database.

" Ewor DE with an audit trail

% Euor DE without an audit trail [for reseanchE

|matallShield

¢ Back | Mewt » I Cancel

The software prompts you to name the database. Enter the name of the database you
want to restore, and then click Next.

Installshield Wizard |l

Enter Text
Fleasze enter information in the figld below.

Fleaze name thiz Databaze.

“DMS_F_old

|mztallShield

< Back | Mext » I Cancel
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Select Use the existing database file. Click Next.

InstallShield Wizard

Setup Type
Chooze the setup type that best suits pour needs.

& Database by that name already exists, pleaze zelect a option,

i {lse the existing database file

" Create a new database named <0M5_F_ol:

|mztallShield

< Back | Mext » I Cancel

Note the new port number, and then click Next.

InstallShield Wizard

Enter Text
Fleasze enter information in the fizld below,

The next avaliable port number iz 20285, Pleaze enter in desired port number or select Mest to
uze thiz walue. & unigue port number is required to run multiple instances of the database
engine simulkaniouzly,

2023

|nstallShield

¢ Back | Mewxt » I Cancel
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Select the location for program icons. Deselect the icon locations you do not want,
and then click Next.

Installshield Wizard !

Setup Type
Choose the setup tupe that best suits your needs.

Please select the desired icons:

¥ Program Menu [ con

¥ Start Menu lcon

InztallShield

< Back | Mext > I Cancel

@ A message states that the maintenance is complete. Click Finish.

Installshield Wizard

Maintenance Complete

InztallShield Wizard haz finished performing maintenance
operations on LC54.05,

¢ Back Cancel

Start the newly installed Exor3 service by double-clicking the icon on your desktop,
and then start the LightCycIer® Software 4.05.

@ Integrate the restored database as described in Logging on to different databases.

@ To log in on the restored database you must enter the User name and Password
for this database.
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12.4. Removing LightCycIer® Software 4.05
To uninstall LightCycIer® Software 4.05:

o Shutdown all running database engines by right-clicking the Exor3 icon in the system
tray and selecting Shutdown.

e Insert the LightCycIer® Software 4.05 CD.
Double-click LightCycler_Software_405_Setup.exe, if installation doesn’t start
automatically. The Setup Type window is displayed. Select Uninstall LCS4.05 Software,
and then click Next.

InstallShield Wizard

Setup Type

Chooze the setup type that best suits pour needs.

Fleaze zelect a option,

" Inztall a database file.

& Hninstall LightCyclerS oftvared 0%

|nstallShield

< Back | Mext » I Cancel

e You are prompted to confirm the deletion. Click OK.

Confirm File Deletion |

Do you wank to completely remove the selected application and all of its components?

Cancel |

Software
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After the software has been removed, a message states that the maintenance is
complete. Click Finish.

InstallShield Wizard ]

Maintenance Complete

InstallShield *Wizard haz finished performing maintenance
operations on LCS4.06.

Caticel

< Back
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12.5 Logging on to the Database as System Admin
and Creating User Accounts

The LightCycler® Software 4.05 installation process creates a default user account with
system administrator privileges. The user name is "admin” and the initial password is
LightCycler01. You will be prompted to change your initial password upon your first
login.

The default setting for the maximum login attempts on entering an invalid password
is 3. To modify this setting or to disable this function see Determine conditions for
access and modify a role's access rights.

After installing the software you will also need to create user accounts, so others can use
the software. Each system (that is, each local computer) has its own set of user accounts.
For each system you can create the following:

® Local Administrator accounts that have the same privileges as the System Admin
account. Each person with a Local Administrator account can create other user
accounts.

® Expert User and Standard User accounts, which have fewer privileges than Local
Administrator accounts. For information about user accounts and their associated
privileges see chapter Managing User Access.

Before you begin determine the following:

® The new password for each System Admin account you want to change.

® The user names, login names, and passwords for the initial set of user accounts for the
local computers.
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To log on to a local computer:

Ona LightCycIer® computer double-click the LightCycler® Software 4.05 icon
to launch the LightCycIer® Software 4.05.

A login dialog box opens. Leave the default values for the user name admin and log
on to location LocalExor3. Enter the password LightCycler01, and then click Login.

oon

Uszer name:

Iadmin

Pazzword:

Ixxxxxxxxxxxxx

Lag an to:
ILnu:aIE:-:nr3 j

J Login I x Cancel | Optians »»

Upon your first login, you are prompted to change your password. Click OK.
A Password dialog box is displayed.

Prassuord ———RTeTEY

Pazzward: I

Mew Password: I

Confirm Password; I

ak I Cancel

Enter the default password (LightCycler01) for the System Admin in the Password
box. Enter the new password in the New Password box and again in the
Confirm Password box. Click OK.

You are logged on to an Exor DB without an audit trail (research use). If you are log-
ged on to the Exor DB without an audit trail, the word "Research" is displayed in the
Statusbar.

&7 Front screen

Logaed on to LocalExor3 as System Admin esearch
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To create user accounts:

To create new user accounts, from the Tools menu select Manage Users. The User
Management tool opens. The Work with Users option is selected by default. To create a
new user account, click New User. The View/Edit User dialog box opens.

In the first box, type the user’s full name.

In the second box, type the user’s “user name” he wants to use as the login name.
In the third box, type a password for the user.

In the fourth box, retype the password.

In the last box, select the user’s role. The available roles are:

Local Administrator: Creates an administrator account that gives the user complete
access to the software. A Local Administrator can create and edit
other user accounts.

Expert User: Creates a general user account that gives the user extensive access
to the software. The Expert User cannot create and edit user
accounts.

Standard User: Creates a general user account that gives the user limited access to

the software.

For detailed information about the privileges associated with each role see chapter
Managing User Access.

When finished click Done and repeat the procedure to create other user accounts, as
needed.

When finished, click Close to close the Manage Users window or Exit from the File menu
to close the LightCycler® Software 4.05 application.
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12.6 Connecting an Instrument

Before a LightCycler” Instrument can be used to run an experiment, the instrument
information must be added to the database. Adding the instrument to the database also
adds the instrument name to the list of available instruments in the Run module. This is
typically done by Roche, but it might be useful to understand the procedure.

A new instrument will be automatically detected and added to the database during an
experiment run, if no other instruments are connected to the local computer. Automatic
instrument detection does not require Expert User or Local Administrator user
privileges.

A user with Expert User or Local Administrator privileges can add an instrument to the
database manually or by having the software search for instruments.

ﬁ One PC must not be used with 2 LightCycler” Instruments simultaneously.

12.6.1 Adding a New Instrument Automatically

® You can add a new instrument to the database and to the list of available instruments
by letting the software search for all instruments currently connected to the computer.
This approach is useful when you do not know the instrument’s COM port.

® The software will also detect a new instrument automatically when you start an
experiment run, if no other instruments are currently in the list of available
instruments. This is the easiest way, if you don’t connect more than one LightCycler”
Instrument to the computer.

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Installation of LightCycler® Software 4.05

Adding a new instrument automatically by letting the software search

Prerequisites:
You must have Expert User or Local Administrator privileges. (For more information
about user privileges, see chapter Managing User Access.)

To let the software detect a new instrument:

This procedure detects all instruments currently connected to the computer, including
those that are already in the database.

Connecting an Instrument

Make sure the instrument is physically connected to the computer and is powered
on.

Turn on the computer, start the LightCycIer® Software 4.05, then log in.
Be sure the instrument is powered on before you start the software.

Click Run in the toolbar or New Experiment on the Front window to open the Run
module.

Click Options, then select Search for Instrument. The Options button is located in the
upper right corner of the Run window next to the instrument box.
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The Discover Instruments dialog box opens.

00

If you know the instrument's COM port, select Find on selected com port, then select
the port from the pull-down list. If you do not know the port, select Auto - Detect and
click Next.

When the software detects a new instrument that has no entry in the current Light-
Cycler® Software 4.05 database, it prompts you to provide a name for the instrument.
Enter a name, then click OK.

If no instruments are found, the software displays “Unable to find any instruments”.
Make sure the instruments are connected and powered on, then click Back to restart
the search.

o

After instruments are found, the dialog box displays a list of all the instruments con-
nected to the computer.

o

Select the new instrument you want to add to the database, then click Finish.

The new instrument is added to the LightCycler” Software 4.05 database, and its name is
added to the Instruments folder in the Navigator. The instrument name is now available
from the instrument list in the Run module, so the instrument can be selected for
experiments.

Software
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To add a new instrument during an experiment run:

Create a protocol and start the experiment run, as described in chapter Creating and
running an experiment. (If your user account has the Standard User role, you must
execute a macro to run an experiment. For more information see chapter Using
Templates and Macros.)

The software automatically detects the new instrument when you start the run.
The following window is displayed.
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Enter a name for the instrument in the Name box, then click OK. The instrument is

added to the LightCycIer® Software 4.05 database, and its name is added to the

Instruments folder in the Navigator. The instrument name is added to the list of

available instruments.

If the new instrument replaced an instrument that is no longer connected to the
computer, you should remove the previous instrument from the instrument list.
For more information see section Removing an instrument.

Continue the experiment using the detected instrument.

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0 Manual B: for general laboratory use




Installation of LightCycler® Software 4.05

Software

Connecting an Instrument

12.6.2 Adding a New Instrument Manually

Prerequisites:

You must have Expert User or Local Administrator privileges. (For more information
about user privileges see chapter Managing User Access.)

You must know which COM port the instrument is attached to.

To add a new instrument manually:

o Make sure the instrument is physically connected to the computer and is powered
on.

e Turn on the computer, start the LightCycIer® Software 4.05, then log in.
Be sure the instrument is powered on before you start the software.

Click New or select New from the File menu.

Select LightCyc/er® Instrument, then click OK.

The New Instrument window opens. The instrument fields are at the top of the work

pane.
Hew Instrument
e IWEETZ | VOPW - Gea sTes CMowoess

0 In the Instrument Name box, type a name of your choice for the instrument.

0 In the //0 Port box, select the COM port the instrument is attached to and click
Connect.

The software finds the instrument connected to the designated COM port and then
automatically fills in the Instrument Id, Instrument Version, and Last Connected
Computer boxes.

The instrument is added to the current LightCycler” Software 4.05 database, and its name
appears in the Instruments folder in the Navigator. The instrument name will now be
available from the instrument pull-down list in the Run module, so the instrument can
be selected for experiments.
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12.6.3 Removing an Instrument

If an instrument is no longer connected to the local computer, its name should be
removed from the list of instruments in the Run module. If the instrument is no longer
available for use at all, it should also be removed from the LightCycler® Software 4.05
database.

Prerequisites:

You must have Local Administrator privileges to remove an instrument. (For more
information about user privileges see chapter Managing User Access.)

To remove an instrument from the instrument list:

To remove the instrument from the instrument list, select Manage Known Instruments
from the Tools menu. The list of instruments is displayed.

e Select the instrument you want to delete, then click Delete.

To remove an instrument from the database:

o To remove the instrument from the current database, right-click the instrument name
in the Navigator.

e Click Delete.

e You are prompted to confirm the deletion. Click Yes.

;
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Maintenance

1. General Maintenance

The LightCycler® 2.0 Instrument is maintenance-free.

2. Cleaning Instructions

Never clean the LightCycler® 2.0 Instrument without turning the instrument
Y f \ power switch off and disconnecting the power cable.

f Do not poor fluids into the thermal chamber.

As with all potentially biohazardous specimens, universal safety precautions shall

& be taken when handling and processing samples. Spills shall be immediately disin-
fected with an appropriate disinfectant solution to avoid spreading contamination
to laboratory personnel or equipment.

Handling and disposal of infectious material shall be performed according to local safety
guidelines.

2.1 General Cleaning

Clean the housing of the LightCycler® 2.0 Instrument with a mild commercial detergent.
If necessary use 70% Ethanol for disinfecting the instrument housing.

To clean the LightCycler® Centrifuge Adapters, remove them from the cooling block
before wiping them clean with a lab tissue soaked with decontamination solution. Use
commercialized reagents such as License to kill (Biodelta) or DNA Zap (Ambion). Do not
autoclave the cooling block.

If capillary breakage occurs, perform the following steps, as appropriate:

» Clean the LightCycler® 2.0 Sample Carousel, by removing capillary fragments using
the brushes provided with the LightCycler® 2.0 Instrument.

> Refer to Removable Fan for details on cleaning the thermal chamber.

f Contact your local Roche representative if capillary breakage occured.

The LightCycler® Sample Carousel can be autoclaved. In case the LightCycler® Sample
Carousel is autoclaved regularly it is recommended to change the O-Ring after 50
autoclaving cycles.

Maintenance
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Preventive Maintenance

2.2 Preventive Maintenance

The area around the instrument shall be checked regularly, to ensure that the air flow
around the LightCycler® 2.0 Instrument is unrestricted and that books, papers, or other
supplies are not interfering with the air flow.

2.3 Removable Fan

The fan is fixed in the thermal chamber with a knurled screw and can be released
manually as indicated in the pictures. This allows easy cleaning of the thermal chamber.

f Switch off and unplug the LightCycler® 2.0 Instrument before removing the fan.

o To release the fan turn the knurled screw to the left.
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e Take out the fan.

@
To clean the thermal chamber proceed as follows:

o Clean the chamber with a soft lint-free cloth. For cleaning purposes use 70% Mikrozid ’ ,
(Schiilke & Mayr GmbH, Norderstedt, Germany) or 1:3 Clorox Regular (The Clorox I
Company, Oakland, USA) or 3% Kohrsolin (Bode Chemie GmbH, Hamburg, Germany)
or 70% Ethanol according to manufacturers’ instructions. ,

Clean the optical window with an optical polishing cloth.

Make sure that no liquid is left in the chamber before you put in the fan.

000

Insert the fan and fix it by following the steps, described to release it, in reverse order.

Only screw the fan into place, manually. Do not use any tools to screw the fan e.g,,
an Allen key.

f Do not poor fluids into the thermal chamber.

Make sure you don't touch or bend the thermal sensor in the chamber when
cleaning it. In case the temperature sensor was bent by accident, this may cause
faulty temperature measurements or even cause the capillaries to crash during a
run. In case of doubt call your Roche representative.

Maintenance
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Removal of the O-Ring

3. Change of O-Ring

3.1 Removal of the O-Ring

To remove the O-Ring, use a suitable tool (e.g,, a blunt pair of tweezers or a small
screwdriver as indicated in the picture), place it carefully under the O-Ring and raise
it. The preferred position for doing this is one of the capillary cavities.

e Remove the O-Ring completely from the carousel.
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Insertion of the O-Ring

3.2 Insertion of the O-Ring

o Put the new O-Ring on the carousel and press it down with your thumbs into the
“furrow”. Always press opposite points.

e Turn the carousel and proceed as described in step 1.

Proceed as described in steps 1 and 2 until the O-Ring fits in the “furrow".

00

Finally smooth out the O-Ring over the whole carousel with your fingers.
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Consumables

4. Consumables and Spare Parts

The consumables and spare parts that are needed to operate the LightCycler® 2.0
Instrument are listed below. These materials may be obtained by contacting your Roche
Diagnostics representative.

4.1 Consumables
LightCycler® Capillaries (20 ul), Cat.No.: 11 909 339 001

LightCycler® Capillaries (100 pl), Cat.No.: 03 337 090 001

4.2 Spare Parts

LightCycler® 2.0 Sample Carousel (20 pl), Cat.No.: 03 603 962 001
LightCycler® 2.0 Sample Carousel (100 ul), Cat.No.: 03 603 954 001
LightCycler® Centrifuge Adapters, Cat.No.: 11 909 312 001
LightCycler® Capillary Releaser, Cat.No.: 03 603 920 001
LightCycler® Capping Tool, Cat.No.: 03 357 317 001

LightCycler® Sample Carousel O-Ring, Cat.No.: 03 603 989 001

( \? A printer and a barcode reader are provided locally upon request.

o

5. Disposal of Consumables and Reagents

b Discard the capillaries into a solid waste box after use.
b Discard reagents and waste material according to local safety guidelines.

> Contact your local Roche Diagnostics representative for disposal of the instrument or
instrument parts.

6. Color Compensation

In a multicolor reaction, the wavelengths of light emitted by the dyes overlap, causing one
channel to pick up signals from a dye measured by another channel. This bleed-over of
fluorescence signal can result in uninformative data.To correct the bleed-over you can
apply a color compensation object when you run the experiment or when you analyze the
data. It is recommended to perform a color-compensation experiment once a year. Refer
to chapter D Software for more details on performing a color-compensation experiment
and applying it. Guide values are specified in the pack insert of the LightCycler® Color
Compensation Kit.
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Troubleshooting
Instrument Errors

The monitoring of an experiment and the error history records are used to support the
servicing of the LightCycler” 2.0 Instrument. The LightCycler” Software Version 4.05
offers the tools to collect all parameters related to the runs performed. Refer to Chapter D
Software for more details on generating error log files.

System messages which may potentially occur are listed below. For each message the

probable cause and corrective action typically required for solving the problem are
shown. Call your Roche representative for troubleshooting assistance.

Data derived from a run where a system message appeared should be reviewed
carefully. If the validity of the results is doubtful, repeat the run.

1. Instrument Errors

Temperature min error Hardware problem concerning  Reboot system, call Roche Service
temperature control if error persists

Temperature max error Hardware problem concerning  Reboot system, call Roche Service
temperature control if error persists

Temperature ADC timeout Hardware problem concerning  Call Roche Service
temperature control.

Cabinet fan will not switch off Hardware error Call Roche Service

Overheat from hardware sensor Hardware problem concerning  Call Roche Service
temperature control

Min fan error Hardware error Call Roche Service

Max fan error Hardware error Call Roche Service

Blue LED error Hardware error Call Roche Service

Fluorescence channel 1 min error ~ Hardware error Call Roche Service

Fluorescence channel 1 max error  Hardware error Call Roche Service

Fluorescence channel 2 min error  Hardware error Call Roche Service

Fluorescence channel 2 max error ~ Hardware error Call Roche Service

Fluorescence channel 3 min error ~ Hardware error Call Roche Service

Fluorescence channel 3 max error  Hardware error Call Roche Service

Rotor home position error Hardware error Call Roche Service

Photometer home position error Hardware error Call Roche Service

Photometer lost steps Hardware error Call Roche Service

Rotor lost steps Hardware error Reboot system, call Roche Service

if error persists

Gain adjust error Hardware error Call Roche Service

Carousel setting out of scope Hardware error Call Roche Service

Carousel calculation out of scope Hardware error Call Roche Service

Parameter version mismatch Hardware error Call Roche Service

Troubleshooting
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49
50

51

52

53

54

55

56

57

58

59
60

61

62

70

71

72

73

74

75

80

81

Checksum error
EEPROM write error

EEPROM read error

EEPROM busy error

EEPROM page error

Internal bitbus error

Transmit buffer LC -> PC overflow

Receive buffer LC <- PC overflow

Internal order buffer overflow

Protocol address <> 'S’
wrong processor address, software
or PIC error

Mathematics error for BASE-210

Protocol data or order from PC not
valid data exceed limits or unknown
order, software error

Protocol number of data not valid

Internal protocol order not valid
unknown order, firmware error

Timeout transmit data to
photometer

Timeout receive data from
photometer

Timeout photometer measurement
Checksum error in binary answer
Timeout UART busy

Error from photometer message
register

Photometer bit 00: watch dog reset

Photometer bit 01: brown out reset

Temperature module error

Hardware module error

Hardware module error

Hardware module error

Hardware module error

Hardware module error

Communication error

Communication error
Communication error

Communication error

Communication error

Communication error
Communication error
Communication error
Photometer communication

error

Photometer communication
error

Photometer error
Photometer error
Photometer error
Photometer error

Photometer error

Photometer error
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Call Roche Service

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Close all programs that were
running on the computer at the
same time as the LightCycIer®
software. If error still occurs,
call Roche Service

Reboot system, call Roche Service
if error persists

Call Roche Service

Call Roche Service

Call Roche Service

Call Roche Service

Call Roche Service

Call Roche Service

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Call Roche Service

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists
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84

85

86

87

88

89

90

91

92

93

100

101

102

103

104

105

106

107

108

109

110

Photometer bit 02: communication
error

Photometer bit 04: ADC hardware
error

Photometer bit 05: LED hardware
error

Photometer bit 06: checksum error
EEPROM

Photometer bit 07:
service mode enabled

Photometer bit 08:
write protection disabled

Photometer bit 09:
power supply error

Photometer bit 10:
self test active

Photometer bit 11:
not ready for commands

Photometer bit 12:
calculation error

Photometer bit 13:
checksum error Flash
Fluorescence [1..12]=0 Min error
Fluorescence 1 Max error
Fluorescence 2 Max error
Fluorescence 3 Max error
Fluorescence 4 Max error
Fluorescence 5 Max error
Fluorescence 6 Max error
Fluorescence 7 Max error
Fluorescence 8 Max error

Fluorescence 9 Max error

Fluorescence 10 Max error

Troubleshooting

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Photometer error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Fluorescence signal error

Troubleshooting
Instrument Errors

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists
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111

112

127
148

149

150

151

152

153

154

155

157
158

159
160

163

164

173

174

175

176

177

Fluorescence 11 Max error

Fluorescence 12 Max error

Error in temp processor

Temperature min error

Temperature max error

Temperature heat up error

Temperature cool down error

Temperature heat up timeout

Temperature cool down timeout

Overheat from hardware sensor

Temperature ADC timeout

Fan Brake error

Min fan error

Max fan error

Fan alarm from hardware sensor

Lid unlock error

Lid lock error

Parameter version mismatch
Checksum error on Main board
EEPROM

EEPQOT invalid

Serial number T-Module invalid

Checksum error on T-Module
EEPROM

Fluorescence signal error

Fluorescence signal error

Error from TEMP processor

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Hardware problem concerning
temperature control

Fan error

Hardware problem concerning
temperature control

Fan error

Fan error

Lid lock error

Lid lock error

Temperature module error

Temperature module error

Temperature module error
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Check dye concentration, call
Roche Service if error persists

Check dye concentration, call
Roche Service if error persists

Call Roche Service

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Call Roche Service

Call Roche Service

Call Roche Service

Reboot system, call Roche Service
if error persists

Call Roche Service

Reboot system, call Roche Service
if error persists

Call Roche Service

Call Roche Service

Call Roche Service

Check if the fan is inserted cor-
rectly. If error occurs with cor-
rectly installed fan, call Roche
Service

Lid can be opened manually in
urgent cases, refer to Chapter
Operation. Call Roche Service

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Call Roche Service
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179

180

181

182

183

184
185
186
187
188

189
190
255

EEPROM write error

EEPROM read error

EEPROM busy error

EEPROM page error

Internal Bit-Bus Error

Transmit buffer LC -> PC overflow

Receive buffer LC <- PC overflow
Internal order buffer overflow
Protocol address <> 'T'
Mathematics error for BASE-210

Protocol data or order from PC not
valid

Protocol number of data not valid
Internal protocol order not valid

Error in step processor

Troubleshooting

Hardware module error

Hardware module error

Hardware module error

Hardware module error

Hardware module error

Communication error

Communication error
Communication error
Communication error
Communication error

Communication error

Communication error
Communication error

Error from STEP processor

Troubleshooting
Instrument Errors

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Reboot system, call Roche Service
if error persists

Close all programs that were
running on the computer at the
same time as the LightCycIer®
software. If error still occurs,
call Roche Service

Call Roche Service
Call Roche Service
Call Roche Service
Call Roche Service

Call Roche Service

Call Roche Service
Call Roche Service

Call Roche Service
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2. Instrument-Related Errors

Instrument-related errors may occur during running an experiment, running the Real
Time Fluorimeter or during operating the instrument screen of the software. In this list
[...] is meant as a placeholder in certain error messages and may stand for an instrument
name, a serial number etc.

Are you sure the computer is
connected to a LightCycIer®
instrument?

Attempted to call the DetectOnPort
method on a connected instrument [...]
whose port [...] is different than the
port to be used in the detection [...]!

Attempted to connect object [...] to a
different instrument [...] on port [...].
Please choose the correct instrument
object in the software, connect to a
different instrument/port, or create a
new instrument object if this is a new
instrument (hasn't been connected
before)!

Can only disconnect the instrument
while it's not running!

Cannot close window while [...] is
running!

Can't apply templates to runs that
have been started.

Can't change the 1/0 port while the
instrument is connected!

Can't initialize the LightCycIer®
instrument. No /0 port has been
assigned!

Can't start the Run until the instrument
lid is closed!

Can't start the self-test until the
instrument lid is closed!

Communication Error: Unable to load
firmware!

Disconnecting the instrument will
terminate RTF. Are you sure you want
to disconnect the instrument?

Communication error

Wrong port used

Other instrument connected to
port than expected

User tried to disconnect an
instrument in the instrument
screen while it was running a
selftest, run, etc.

User tried to close the instru-
ment screen while the instru-
ment is running

Handling error

User tried to change the 1/0
port in the instrument screen
while connection was already
established

No 1/0 port chosen in the
instrument screen.
Handling error

Handling error

Communication error

Depress ‘Connect’ in instru-
ment screen while running RTF

LightCycler® 2.0 Instrument - Operator’s Manual Version 2.0

Restart instrument and software.

Check port connection.

Choose the correct instrument object
in the software and connect the
associated instrument. Create a new
instrument object if you want to
connect a new instrument that has not
been connected before.

Wiait until current process is finished.

Finish the run or abort it.

Finish or abort current run.
Apply new template to new run.

Press ‘Connect’ button again to
disconnect the instrument and to end
communication.

Check 1/0 port chosen in the
instrument screen.

Close the lid before starting a run.
Close the lid before starting to operate
the instrument.

Restart instrument and software.

Stop RTF first.
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Error reading firmware version.
Error code = [...], Data=[...]!

Information* Program 0,
Segment 0: 30 is an invalid
temperature target.

Instrument [...] already exists.

Instrument [...] was detected.
Do you want to start the run with this
instrument?

Instrument is already running!

Internal Error: [...]. Firmware
component was unable to return the
firmware datal

Internal Error: [...]. Firmware property
was unassigned!

LightCycIer® Error: [...]

Please close the instrument lid before
performing a self test.

Please close the instrument lid before
starting a run

Please close the instrument lid before
starting RTF.

Port [...] is currently unavailable
(possibly in use by another instrument
or process).

Details: [...]

Real time fluorimeter aborted with an
error

Real time fluorimeter communication
timed out! Please verify the instrument
is properly connected.

Received a protocol with an error while
performing a Step self test! Please
verify the instrument is properly
connected.

Received an error protocol while
seeking samples! Please verify the
instrument is properly connected.

Troubleshooting

Communication error

User imported a Nucleic Acid
experiment containing a
segment with 30°C as the temp
target.

User tried to create two
instrument objects for the
same instrument

User clicked “Start Run”
on Run window when no
instrument was connected
Handling error

Corrupted firmware in the
firmware component.

Developer Error: The firmware
component was not setup

properly.

Instrument error code
Handling error
Handling error

Handling error

Port already in use by another
instrument or software.

Instrument error

Communication error

Communication error

Communication error

Troubleshooting
Instrument-Related Errors

Restart instrument and software.

Correct the experiment settings.

Leave 2nd instrument object without
saving. Select already existing
instrument object for instrument.

Answer the question. If it is the wrong
instrument select an other instrument.

Finish or abort current run, start new
run thereafter.

Restart instrument and software.
Call Roche Service if error persists.

Restart instrument and software.
Call Roche Service if error persists.

Restart instrument and software.
Call Roche Service if error persists.

Close the instrument lid before
starting a run.

Close the instrument lid before
starting a run.

Close the lid before operating the
instrument.

Use other port.
Wiait until process is finalized.
Close other software.

Check error log

Check cable

Check cable

Check cable. Restart instrument
and software.
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Instrument-Related Errors

Received fatal error during run!

Run timed out after not receiving any
data from the instrument!

Step self test timed out! Please verify
the instrument is properly connected.

The firmware crc value is declared
incorrectly!

The following samples were not found
during the seek process. Do you want
to continue the run?

The instrument firmware failed to load.
Please verify that the instrument is
properly connected.

The instrument is already running
another experiment!

The instrument is currently busy run-
ning Real Time Fluorimeter.

The instrument timed out while
seeking samples! Please verify the
instrument is properly connected.

The instrument timed out while waiting
for sample search protocol! Please
verify the instrument is properly
connected.

The instrument’s lid was opened
during the run!

The instrument's lid has been opened
during the run. The run will now be
terminated.

The instruments lid was opened during
real time fluorimeter!

The run aborted with an error.

The instrument timed out while waiting
for sample search protocol!

Please verify the instrument is properly
connected.

The run aborted with an error. Invalid
checksum on returned protocol.

The seek process found the following
samples which were not supposed to
contain any data (their positions were
initially flagged as empty): [...]!

Instrument error

Communication error

Communication error

Hardware error

Missing samples or missing
fluorescent dye.

Communication error

Handling error

Handling error

Communication error

Communication error

Handling error

Handling error

Handling error

Communication error

Communication error

Mismatch between SAM file
and seek
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Check error log.
Check cable

Check cable
Call Roche Service

Check if all sample capillaries were
inserted correctly. Check if fluorescent
dye has been added. Confirm the
message to continue the run or abort
it by pressing “No”.

Check cable, restart instrument and
software.

Finish or abort current run before
starting a new run.

Finish current process and restart
action.

Check cable

Check cable. Restart instrument and
software.

Repeat experiment.

Repeat run.

Do not open the lid when operating
the instrument.

Check cable. Restart instrument and
software.

Check cable. Restart instrument and
software. Call Roche Service if error
persists.

Check loading; restart experiment.
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The selected instrument is of a
different type ([...] Channel) than

the instrument specified in the experi-
ment ([...] Channel). Continuing could
lead to a loss of data (e.g. loss of
channel information in the sample
editor). Do you want to continue?

The stored object reports the
instrument subclass to be of type [...],
but the instrument "says" the type is

[:]E

Timed out while waiting for instrument
to adjust temperature! Please verify the
instrument is properly connected.

Unable to backup run data!

Unable to communicate with the
instrument. Please verify the
instrument is properly connected.

Unable to find [...] on port [...].
Do you want to search for the
instrument on other ports?

Unable to start self test with
instrument [...].

Please make sure the instrument is
properly connected.

Troubleshooting

Instrument is of different type
(3 channel versus 6 channel)
than selected in experiment

Wrong instrument type con-
nected.

Communication error

Disk full; no access rights

Communication error

Instrument not connected to
the specified port.

Communication error

Troubleshooting
Instrument-Related Errors

Chose correct instrument type for
experiment or use other experiment.

Choose the correct instrument object
in the software and connect the
associated instrument. Create a new
instrument object if you want to
connect a new instrument that has
not been connected before.

Check cable

Assure that the disk used has enough
memory space and check the user
rights.

Check cable. Restart instrument and
software.

Choose the correct instrument object
in the software and connect the
adequate instrument. Create a new
instrument object if you want to
connect a new instrument that has
not been connected before.

Check cable
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3. Algorithm Errors and Messages

This list includes error messages that are possible within the module calculation sections
of the LightCycler” Software 4.05.

At least 11 cycles of data are required

Coefs not correctly specified

Cycle and Fluorescence data matrices
must be identically sized

Cycle and Fluorescence data matrices
must be identically sized

Data dimensions are inconsistent

Data in standards does not encompass
sample temperature range.

Different number of Channel and
Position labels.

Different number of SamplelD and
Position labels.

Different number of Target and Position
labels.

Different number of Type and Position
labels.

Errors ocurred during analysis
calculation. The report may display
incorrect results!

Fluorescence & Time matrices of
different size.

Gains not correctly specified
Invalid CCC data

Invalid format for number of Groups.

Invalid melt data

Maximum number of function
evaluations exceeded

Maximum number of iterations
exceeded'

Not enough data to compute
Cp because user specified too
few acquisitions.

.ccc file coefficients corrupted.

Unequally sized fluorescence
and cycle data. Data corrupted.

Unequally sized fluorescence

and cycle data. Data corrupted.

Inconsistent data, usually
arising from importing SW 3.5
data.

Unknowns and standards
incompatible, standards defined
for temperatures outside
sample temperature range.

Internal error - can'’t find all
data.

Internal error - can’t find all
data.

Internal error - can'’t find all
data.

Internal error - can’t find all
data.

User ran kit and aborted
experiment during run.

Data are inconsistent, SW 3.5
import problem or machine
error.

.ccc file gains corrupted.

CCC data do not match check
sum.

Too many standards for
low-sensitivity mode.

Data are constant, usually equal
to zero.

Data do not fit model, melt
curves do not fit standard
model.

Data do not fit model, melt
curves do not fit standard
model.
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Rerun experiment with at least
11 cycles of acquired data.

LCDA ABT file corrupted.
Run experiment in SW 3.5 again.

Rerun experiment.
Rerun experiment.

Corrupted LCDA file.
Reimport data.

Standards are incompatible with
samples. Remelt samples at
temperatures within the range
of standards.

Rerun experiment;
call Roche Service if error persists.

Rerun experiment;
call Roche Service if error persists.

Rerun experiment;
call Roche Service if error persists.

Rerun experiment;
call Roche Service if error persists.

Rerun experiment;
call Roche Service if error persists.

Corrupted LCDA file. Reimport data;
call Roche Service if error persists.

LCDA ABT file corrupted.
Run CC experiment in SW 3.5 again.

Corrupted CCC data. Reload LCDA
data if imported; redo CCC experiment.

Select different standards; use in-run
standards; run in high sensitivity mode.

Samples did not amplify. Redo
experiment; call Roche Service if error
persists

Use manual Tm finder tool.

Use manual Tm finder tool.
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More measurements needed

Negative Concentration not allowed
Negative CPRange limits not allowed
Negative Fluorescences not allowed
No fluorescence data

Not enough data to color compensate

Qualitative Detection: Exception
ECrossingPoint raised with message
“At least 11 cycles of data are required.”

Resolution cutoff must be nonnegative
and less than Score threshold

Standard curve could not be calculated

Temperature & Time matrices of
different size.

Too much missing data, cycle numbers
must be contiguous

Unable to compute standard curve

Upper limit of ConcRange greater than
lower limit

Upper limit of CPRange greater than
lower limit

[...] not a valid correction factor.

[...] not a valid multiplication factor

Troubleshooting

Not enough data gathered in
experiment.

User specified negative conc.
values.

User specified negative Cp
values.

Negative values of fluorescence
observed

Missing fluorescence
information in raw data.

CCC experiment doesn’t have
enough data to compute
compensation.

Program did not have the
necessary number of cycles
for the analysis. Program may
be inaccurate, or user may
have aborted run before
cycles complete.

Invalid user input of resolution.

Not enough standard data
points.

Data are inconsistent, SW 3.5
import problem or machine
€error.

Missing acquisitions in cycling.
Machine didn’t collect data.
Data corrupted.

Not enough standards for linear
regression, regression requires
3 or more standards.

User specifies incorrect conc.
limits.

User specifies incorrect Cp
limits.

Non-positive correction factor.

Non-positive multiplication
factor.

Troubleshooting
Algorithm Errors and Messages

Make sure run has acquisitions
specified; decrease temperature
ramp rate.

Reset Cp limits in sample editor.
Reset Cp limits in sample editor.

Rerun experiment; call Roche Service if
error persists.

Make sure run has acquisitions
specified.

Rerun CC experiment, and gather
enough data.

Rerun experiment with at least 11
cycles of acquired data.

Decrease Resolution threshold below
Score threshold.

Increase number or samples in
experiment.

Corrupted LCDA file. Reimport data;
call Roche Service if error persists.

Rerun experiment; call Roche Service if
error persists.

Increase the number of standards in
experiment.

Reset concentration limits in sample
editor.

Reset Cp limits in sample editor.

Reset correction factor on paring tab.

Reset multiplication factor on paring
tab.
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4. Miscellaneous messages

This section lists messages for modules and features not covered above.

An error occurred while importing file
[...].FLO. Please verify that all ATF files
exist and are valid.: ABT file not found.

Archive log entry was empty!!

Cannot stop Exor. There is <n> user
connected.

Please export modified objects before
logging out or closing LCS4.

The file does not have a checksum and
will not be imported. Checksum
failure!.
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User selected a -flo file to import that
did not have a corresponding .abit file.

User imported a file and saved it, then
highlighted file in the Navigator and
checked File > Revisions. Message
appears when there are no previous
revisions in the Revisions pane.

The user tried to shut down Exor while
one or more users were logged in.

There was a failure in communication
with Exor. The object cannot be saved
in the database, but the user can
export the object and reimport it
when communication is reestablished.

User tried to import an LightCycIer®
Software 4.0 .ixo file into LightCycIer®
Software 4.05

Check if the corresponding
experiment data files are
complete

Wait until all users are logged
out

Export the modified objects
and reimport them after restart
of the LightCycIer® Software
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